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Welcome! 
  

Welcome to Allplan Building Cost Management, Nemetschek's 
integrated program for tendering, awarding and invoicing. 

Thank you for choosing Allplan Building Costs and Allplan 
Construction Cost, which allow you to manage all building costs 
quickly, easily and reliably - from cost calculation and tendering 
through to awarding and billing. 

Allplan Building Costs assists you in any phase in the entire process 
encompassing file generation to price comparison list through to 
invoicing. Integrated interfaces ensure that you can easily import 
predefined data as well as exchange data with Nemetschek's CAD 
systems and other tender, contracting and costing products. The 
program offers you all the necessary tools to control and calculate 
costs and to structure costs in DIN 276-compliant cost groups. In 
addition, you can create room schedules and draw up accurate cost 
estimates based on DIN 276 or other methods. 

Allplan Construction Cost assists you in the process of monitoring 
projects, ranging from release for payment to adjustment of costs to 
unexpended warranties. 

  

We wish you fun and success with Allplan BCM! 

Your Allplan BCM Team 
Nemetschek Allplan Systems GmbH, Munich 
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General Information 
This chapter provides detailed information on: 

 The system requirements the computer must meet to 
ensure proper operation of Allplan BCM 

 The sources of information provided by the Allplan 
BCM user documentation and other media 

 The contents of this manual 

 The basic terminology, conventions and abbreviations 
used in the Allplan BCM user documentation 

 What to do if you need assistance 
  

 
 



 

2 General Information Allplan BCM   

Allplan Building Costs System Requirements 
The requirements for running Allplan Building Costs are basically 
the same as for any of the Microsoft Windows versions listed in the 
table below. 

If your computer is running smoothly under one of these Windows 
versions, you will have no problems installing and working with 
Allplan Building Costs. 

  

Allplan Building Costs requires the following minimum system 
configuration: 

System component ... recommended ... 

Processor Intel Core 2 (or compatible) 

RAM 2 GB 

Hard disk space 5 GB 

Screen resolution 1280 x 1024 

Network card (for networked 
workstations) 

100 MBit/s 

Software (standard) Windows 8 or 
Windows 7, SP 1 or 
Windows Vista, SP 2 

Software (terminal server) Windows Server 2012 or 
Windows Server 2008 R2, SP 1 

 
 

Basic rule: The higher the 
hardware performance, the 
more effectively you can use 
Allplan Building Costs! 
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The Allplan Building Costs Documentation 
The Allplan Building Costs documentation consists of the online 
documentation (manual in PDF format) and the online help. 

You can use either component to become familiar with Allplan 
Building Costs. Choose the one that suits you best. 

  

Online documentation 

The online documentation consists of a set of manuals in PDF 
format. In contrast to printed manuals, these "electronic manuals" 
offer the advantage that you can access the complete contents of the 
user documentation for Allplan Building Costs straight from your 
workstation anytime. 

You can open the online documentation in two ways: either by 
clicking Manuals on the program’s Help menu or straight from the 
Allplan DVD by selecting Documentation in the DVD Content 
column and clicking Allplan BCM). Whichever method you choose, 
you need Adobe Acrobat Reader to open the files. 

This manual is designed to give you a quick and practical 
introduction to Allplan Building Costs. Therefore, it conveys the 
essentials in a compact form. As the key focus of this manual is on 
the basics, the individual topics are outlined only briefly. Solutions 
for specific problems and descriptions of the settings and parameters 
can be found in the online help. 

  

Online help 

Allplan Building Costs provides an extensive online help system 
covering the entire range of modules and functions in the program. 
While you work with Allplan Building Costs, you can get help on the 
current function or situation by pressing the F1 KEY or activate 
Contents and index on the Help menu and point to the icon on 
which you require help. 

The Help window shows information on commands, detailed step-
by-step instructions for all the tools, information on basic concepts 
and terms and much more. 
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The index provides a convenient way of looking up topics on which 
you require help. In addition, you can use the integrated search tool 
to quickly find related Help topics. 

The quickest and easiest way to get started with Allplan Building 
Costs is Easy2Learn. This quick guide outlines the most important 
steps in each tendering and cost calculation phase on a separate help 
page. All you have to do is ... 
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Terminology 
  

The table below provides explanations for the main terms used in the 
documentation. As these terms describe important operations, it is 
essential that you are familiar with these expressions in order to 
work with the software. 

Expression Meaning 

ALT KEY The Alt key on the keyboard. For controlling 
special functions, this key is used in 
combination with other keys. 

Activate You activate/deactivate an option by clicking 
its check box. Activated options are 
indicated by check marks. 

Select You select a function by opening a menu 
and clicking a command. You can also open 
a menu or select a command/option by 
pressing the ALT key and the underlined 
letter of the menu/command. 

PAGE UP KEY You use the "Page " key on the keyboard 
to control the section displayed on screen. 

PAGE DOWN KEY You use the "Page " key on the keyboard 
to control the section displayed on screen. 

Data field Fields provided for entering data into the 
data sheets. 

Double-click Point to an icon, menu or command and 
quickly push the left mouse button twice. 

Insertion marker Vertical, blinking bar indicating the point 
where the program expects you to make an 
entry. 

ENTER The ENTER key on the keyboard. In some 
cases, you need to press this key in order to 
confirm your entries. 

DEL KEY The Del key on the keyboard. If no characters 
are selected, pressing this key deletes the 
character to the right of the insertion marker. 
If characters are selected, pressing this key 
deletes these characters. 
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Expression Meaning 

ESC KEY The Esc key on the keyboard is usually used 
to cancel a function or command without 
performing the relevant operation. 

Click Point to an icon, menu or command and 
quickly push the left mouse button. 

Mark Drag the cursor over several elements (e.g. a 
number of letters or words) or double-click 
an element. In the case of menus or list 
boxes, elements are marked by clicking. 

ARROW KEYS The arrow keys on the keyboard. Small 
arrows and the names of the keys (LEFT, 
RIGHT, UP, DOWN) indicate the direction of 
movement. 

Button A switch, button or icon (usually denoted by 
a symbol or text) displayed in a dialog box. 
Clicking a button executes a command. 

CTRL KEY The Ctrl key on the keyboard. For controlling 
special functions, this key is used in 
combination with other keys. 

TAB KEY You can use the "" key on the keyboard 
to position the insertion marker on a tab. For 
controlling special functions, this key is used 
in combination with other keys. 

SHIFT KEY The "" key on the keyboard is used to 
change the case (lowercase to uppercase and 
vice versa). In combination with other keys, 
this key is also used for controlling special 
functions. 

Point to Move the mouse/cursor to an element 
displayed on screen (e.g. a button or menu). 

Cursor or mouse You use the cursor/mouse to position the 
insertion marker or to select a command. 

Drag Point to an element (e.g. a border of a 
window), press and hold the left mouse 
button and then move the mouse (do not 
release the mouse button!). 
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Conventions 
  

The following conventions apply to the entire documentation. Please 
read these conventions as they make the documentation quick and 
easy to use: 

Character Meaning 

ATTENTION! Please carefully read and follow the advice 
provided in "ATTENTION!" sections in order 
to prevent data loss or other serious 
problems. 

ALT Key names are written in capital letters. 

ALT+D Key combinations are represented by a "+" 
character. These keys need to be pressed 
simultaneously. Here, press and hold the ALT 
key while pressing the D key. 

File Names of menus, commands, buttons, icons, 
titles, windows, text in dialog boxes etc. – in 
other words, all the elements in templates 
and windows – are shown in bold. 

C:\WIN Messages issued by the operating system and 
entries you need to make at the operating 
system level are shown in Courier font. 
You need to press the ENTER key to confirm 
these entries. 

"Dear customer" (Variable) entries you make in data sheets, 
data fields, lines etc. – in other words, all 
user entries – are enclosed in quotation 
marks. 

Memo Options in list boxes and non-variable 
entries in data sheets, data fields, lines etc. – 
in other words, all entries controlled by the 
program – are shown in bold. 

Note: These sections provide additional 
information on the current topic. 

Important! Please pay special attention to sections 
marked as "Important!" as they provide 
essential advice and information. 
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If you need assistance ... 
  

... you will find the necessary information in the online help and the 
online documentation (see "The Allplan Building Costs Documentation" 
on page 2). In addition, the status bar displays brief information 
about the individual tools on the menus. 

If you have further questions, our Technical Support will be glad to 
help you. You can benefit from the services provided by the 
Technical Support free of charge for the first three months after 
purchase of the first license. When you conclude a Serviceplus 
agreement, you do not have to pay for these services even after 
expiration of this period. 

Before contacting the Technical Support, please make a note of the 
precise wording of the error message including all numbers and 
abbreviations. To avoid unnecessary questions and delays, try to 
identify the problem as well as you can. 

The Technical Support sometimes requires detailed information on 
the hardware and configuration of your computer. You should 
therefore use the Technote program to generate support requests. 

You can reach the Technical Support at the Nemetschek Technology 
Center in Munich from Monday to Friday from 8 a.m. to 6 p.m. 

Phone:  0049 89 / 9 27 93 - 88 88 

Fax:      0049 89 / 9 27 93 - 88 09 
  

… and you have a Serviceplus agreement: 

For Serviceplus customers, any support provided by the Technical 
Support is free of charge! If you have any questions pertaining to the 
program, please send an email to our Technical Support team: 

support@nemetschek.de 

The Technical Support can also be contacted by phone or fax using 
the numbers above. 
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Furthermore, you can also refer to Nemetschek’s serviceportal 
Allplan Connect. In addition to a huge knowledge database, the 
serviceportal Allplan Connect provides you with the latest Line-
Letters and other helpful information. And you can communicate 
and exchange information with countless other users. 

To access Allplan Connect, all you need to do is register:  

connect.allplan.com 

  

… and you do not have a Serviceplus agreement: 

If you have not yet concluded a Serviceplus agreement after the free 
3-month support period, you can purchase Technical Support tickets 
for your support requests through our online shop. More information 
can be found on our website: 

www.nemetschek.de/services/support 

Even if you do not have a Serviceplus agreement, you have access to 
some areas of the serviceportal Allplan Connect. All you need to do 
is register: 

connect.allplan.com 
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The "Technote" program ... 
  

... is a useful aid not only for you, but also for the Technical Support 
to determine the basic configuration of your hardware and software 
environment. 

Technote generates a list of your computer's configuration and 
assists you in editing the AUTOEXEC.BAT, CONFIG.SYS, 
NEMMAN.INI and ALLRIGHT.INI system files. The printed report 
contains all the data required for solving hardware and software 
problems. 

  

To start the "Technote" program 

1 Click Start on the Windows task bar and point to Programs. 

2 Point to Nemetschek, select Allplan BCM and then click 
Technote. 

  

To print a Technote document 

1 Start the Technote program. 

2 Click Support request. 

3 Enter contact data.  

Important! 
Please fill in all the boxes; the Technote document cannot be 
printed otherwise. 

4 Do not activate the Include configuration files option unless the 
Technical Support asks you to.  

5 Enter your question or describe your problem in 3. Enter your 
support request. 

6 Click Output. 

7 Select the type of output/printout by clicking the relevant button 
in the Output dialog box. 
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Installing Allplan BCM 
This chapter shows how to install 

 Allplan BCM on a standalone workstation 

 Allplan BCM on a network and 

 the sample projects provided on the Allplan DVD. 
 

Information on Allplan BCM Setup 
All Allplan BCM program modules are installed using the Allplan 
BCM Setup program. Allplan BCM Setup automatically prompts you 
for the information it needs during the installation: 

• the drive on which you want to install the Allplan BCM program 
files (about 200 MB disk space) 

• the drive on which you want to install the Allplan BCM data 
management (at least 200 MB disk space; 25 MB additionally for 
demo data) 

• your license information (license disk, license file or license 
code). 

When you are installing the program for the first time, Allplan BCM 
Setup also automatically installs some of the sample projects that are 
provided on your Allplan DVD. If you would like to load additional 
sample projects, simply use the archive administration in Allplan 
Building Costs (see "Installing Demo Data"). 

Before starting the installation, please make sure that there is enough 
free disk space on the drives you want to use. Also check that at 
least 30 MB free disk space is available on the drive on which you 
have installed your Windows system programs (= system drive). 

Important! 
Allplan Building Costs Version 2014 supports installation on any of 
the operating systems listed in the "Allplan Building Costs System 
Requirements (on page 1)" chapter. Please ensure that the most recent 
service packs are installed. 
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Installing Allplan BCM on a Standalone 
Workstation 

The Allplan BCM Setup program offers you a quick and easy way to 
install the individual Allplan BCM program modules on your 
computer. 

To install Allplan BCM on a standalone workstation 

1 Close all running applications. 

2 Log on as system administrator. 

3 Insert the Allplan DVD into your DVD drive. 

The start menu of the Allplan 2014 DVD opens automatically. 

4 Click Programs in the DVD Content column on the left. 

5 The Programs column is displayed. Click Allplan BCM. 

6 In the first dialog box, select a language for the setup process and 
for the program's user interface. 

Note: You can change the user interface language of the installed 
program any time (Extras menu -> Settings). 

 

Select a language and click OK. 
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7 Read the information in the Welcome dialog box. 

 

8 Click Next. 

9 The Software License Agreement dialog box (not shown here) 
appears. Please read the license agreement carefully. 

Click Yes to accept the license terms. 

10 Activate the Standalone workstation radio button in the 
Installation type dialog box and click Next. 

 

11 Select the license you want to use in the Select License 
Information dialog box. 

Insert the license disk into the drive or click  and select the 
folder containing the license file. 
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12 Click Next. 

13 In the Select program folder dialog box, select a program group 
for Allplan BCM and click Next. 

 

14 Choose the Allplan BCM program modules you want to install. 

Activate the appropriate check boxes in the Components dialog 
box and click Next. 

 

15 The Select path dialog box appears. Specify the drives and 
directories where you want to install the individual Allplan BCM 
components. 

Tip: You can choose different 
drives and directories for 
programs and data. This is 
usually only necessary, 
however, when you install 
Allplan BCM on a network. 
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Important! 
If you have already installed a different Allplan BCM program 
module, leave the default path settings unchanged. This way you 
ensure that all files are copied to the correct directories. 

To change a default path, click the  icon next to it. 

 

16 Check the information given below each directory path to make 
sure that there is enough free disk space available. 

17 Click Next to continue with the installation. 

18 Please check all your entries carefully before starting the 
installation. 

 

19 Click Install when the displayed data is correct. 

This starts the installation process during which the files are 
copied to your computer's hard disk. 
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20 Please read the notes in the Information dialog box. 

 

Then click Next to continue. 

21 Allplan BCM Setup issues the following message when the 
installation has been successfully completed: 

 

Click Exit in the confirmation dialog box. 
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Installing Allplan BCM on a Network 
Allplan BCM is installed on a network in basically the same way as 
on a standalone workstation. The only differences are the installation 
type setting (standalone/network), which also determines the amount 
of files copied to the hard disk, and the settings for the path 
structure. 

Important! 
Installing Allplan BCM on a network requires an in-depth knowledge 
of the network software and the path structure on the network. 
Therefore, the installation should only be performed by the system 
administrator for the network. 

When running Allplan BCM on Windows, it is recommended to 
provide each workstation with its own local hard disk on which 
Windows is installed. This increases processing speed and saves 
network resources, particularly regarding swap files. 

If no local hard disks are available, proper network installation of 
Windows is indispensable. Besides the Windows directory of the 
basic installation, which contains the shared Windows files, you 
need to provide a separate Windows directory for each workstation. 
There you store the Windows files (e.g. INI files) that are specific to 
that workstation. The Windows network installation should also only 
be performed by the system administrator for the network. 

The following steps describe the most common network installation 
procedure (data on server, programs and local working directory on 
clients); other constellations are of course also possible provided the 
required network knowledge is available. 

To install Allplan BCM on a network 

1 First install the server. 

Proceed as described in steps 1 to 9 in the "Install Allplan BCM 
on a Standalone Workstation" section. 

2 In step 10, activate the Server installation radio button in the 
Installation type dialog box and click Next. 
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3 Select the license you want to use in the Select License 
Information dialog box. 

Insert the license disk into the drive or click  and select the 
folder containing the license file. 

4 Click Next. 

5 The Select path dialog box appears. Enter the network drive on 
the server as the data directory. 

6 Proceed from step 15 in the "Install Allplan BCM on a Standalone 
Workstation" section to complete the server installation. 

Important! 
In the above procedure, no Allplan BCM workstation is installed 
on the server computer. The workstations are only set up in the 
individual clients. If you want to use the server as an Allplan 
BCM workstation, run a client installation on the server after you 
have completed the server installation. 

7 Continue by installing the clients. 

Run the ClientSetup.exe file on the client. You will find the 
file in the 
..\Daten\Nemetschek\Allbase\Daten\Client 
directory on the server. Then proceed as described in steps 7 to 9 
and 11 to 14 in the "Install Allplan BCM on a Standalone 
Workstation (see "Installing Allplan BCM on a Standalone 
Workstation" on page 12)" section. 

8 Enter the program directory on the client in the Select path 
dialog box. 

9 Proceed from step 15 in the "Install Allplan BCM on a Standalone 
Workstation" section to complete the client installation. 

 

Tip: You can do this directly 
at each client without using 
the Allplan DVD. 
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Installing Demo Data 
On the Allplan DVD, you will find a selection of sample projects and 
other demo data (including standard text of various providers) for 
your convenience. Part of the demo data is installed automatically 
when you install Allplan BCM for the first time. Using Allplan BCM’s 
archive administration tool, you can quickly and easily import 
additional sample projects. 

When you update, the demo data is not installed automatically, 
ensuring that existing data is not overwritten. In this case, you can 
also simply use the archive administration to import the demo data. 

  

Note: Some sample projects use a predefined Allplan project. This 
project is also included in the Allplan DVD and can be found in the 
<dvd>\programs\Allplan BCM\Demodaten_Bau-
kosten\Allplandaten directory. Load this sample project by 
using Allplan’s archive administration (= Allmenu). 

 
 

Import Demo Data into Allplan BCM 

To import demo data 

1 Insert the Allplan DVD into the DVD drive. 

Note: After you have inserted the DVD, the Allplan start menu 
usually opens automatically. If this is the case, click the  

 Close button. 

2 Start Allplan Building Costs or Allplan Construction Cost. 

3 Click Archive on the Project Data menu (Building Costs) or on 
the Tools menu (Construction Cost). 

The Archive administration dialog box appears. 

4 Click Path. 

The Browse for folder dialog box opens. 

5 Select the DVD drive. 
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6 Set the path to a subfolder of the <dvd>\programs\Allplan 
BCM\Demodaten_Baukosten directory (Building Costs) or to 
<dvd>\programs\Allplan BCM\Demodaten_Baukonto 
(Construction Cost). Then click OK. 

7 Select the project(s) you want to import in the Archives (Building 
Costs) or Archived data (Construction Cost) list box on the right 
and click  Restore archive (Building Costs) or  Insert 
archived data (Construction Cost). 

8 Click Close in the Archive administration dialog box when the 
import is complete. 
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User Interface in Allplan 
Building Costs 

The application window of Allplan Building Costs basically consists 
of three areas: 

• the menu bar (see "Menu Bar in Allplan Building Costs" on page 
22) below the title bar of the window, 

• the toolbars (see "Toolbars in Allplan Building Costs" on page 22) 
below and 

• the space reserved for displaying data sheets. 
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Menu Bar in Allplan Building Costs 
The menu bar in Allplan Building Costs consists of the following 
menus: 

 

Note: A description of all the tools on the menus is provided in the 
reference section entitled "Menus and Tools" in the online help. 
 

Toolbars in Allplan Building Costs 
You can use the buttons provided in the toolbars to activate the 
main tools without having to select a menu first. All you need to do 
is click the relevant icon. 

  

The toolbars in Allplan Building Costs are divided into logical 
groups: The upper toolbar includes the most important, general tools 
that are not focused on any specific project. Consequently, this 
toolbar is named General features toolbar. The toolbar in the middle 
– Project functions – provides project-specific functions. In lower 
toolbar – Text libraries – you can access text catalogs of various 
providers. For this, you need to install these catalogs first. 

 

Note: The sections entitled Buttons in the General features toolbar, 
Buttons in the Project functions toolbar and Buttons in the Text 
libraries toolbar provide an overview of all the functions you can 
select directly without opening a menu first. 



 

Integrated solutions  User Interface in Allplan Building Costs 23 
 

You can display and hide as well as dock and float the toolbars 
separately to suit your requirements. In addition, you can customize 
the toolbars and create new ones. 

If required, you can also install special toolbars for various 
applications (e.g. CAD-XPAD-WERKZEUGE toolbar, CADOBJECT 
toolbar (see ""CADOBJECT" Toolbar" on page 179) or BUILDING 
PROCESS toolbar). 

  

 
 

Buttons in the "General Features" Toolbar 
  

 

  

The four buttons in the left block of the General features toolbar 
represent the following tools: 

Icon Function Use 

 Open project overview You can use this tool to execute the Project 
overview command on the File menu, which 
opens the Project overview data sheet (see 
""Project Overview" Data Sheet" on page 50). 

 Open address overview You can use this tool to execute the Address 
overview command on the File menu, which 
opens the Address overview data sheet (see 
""Address Overview" Data Sheet" on page 
51). 

 Open image overview You can use this tool to execute the Image 
overview command on the File menu, which 
opens the Image overview data sheet (see 
""Image Overview" Data Sheet" on page 52). 

 Open archive You can use this tool to execute the Archive 
command on the Project Data menu, which 
opens the Archive administration dialog 
box. 
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The five buttons in the next block of the General features toolbar 
represent the following tools on the Data Record menu: 

Icon Function Use 

 New data record You can use this tool to execute the New 
command on the Data Record menu. 

 Cut data record You can use this tool to execute the Cut 
command on the Data Record menu. 

 Copy data record You can use this tool to execute the Copy 
command on the Data Record menu. 

 Paste data record You can use this tool to execute the Paste 
command on the Data Record menu. 

 Delete data record You can use this tool to execute the Delete 
command on the Data Record menu. 

   

The four buttons in the next block of the General features toolbar 
help you select data records: 

Icon Function Use 

 Mark current line You can use this tool to execute the Mark 
line command on the Data Record menu. 

 Mark entire hierarchy You can use this tool to execute the Mark 
hierarchy command on the Data Record 
menu. 

 Cancel current line marker You can use this tool to execute the Cancel 
marking command on the Data Record 
menu. 

 Cancel hierarchy marker You can use this tool to execute the Cancel 
hierarchical marking command on the Data 
Record menu. 
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The six buttons in the adjacent block of the General features toolbar 
are provided for quickly moving the insertion marker in a vertical 
direction within a data sheet: 

Icon Function Use 

 Top of data sheet You can use this tool to move the insertion 
marker to the top (= first line) of the data 
sheet, which defines the section displayed 
(equivalent to the Go to project start tool on 
the Data Record menu).  

 Hierarchy step upwards You can use this tool to move the insertion 
marker up to the next data record on the 
same level in the hierarchy (equivalent to the 
Hierarchy step upwards tool on the Data 
Record menu). 

 Up You can use this tool to move the insertion 
marker up a line (equivalent to the Line step 
upwards tool on the Data Record menu). 

 Down You can use this tool to move the insertion 
marker down a line (equivalent to the Line 
step downwards tool on the Data Record 
menu). 

 Hierarchy step downwards You can use this tool to move the insertion 
marker down to the next data record on the 
same level in the hierarchy (equivalent to the 
Hierarchy step downwards tool on the Data 
Record menu). 

 Bottom of data sheet You can use this tool to move the insertion 
marker to the end (= last line) of the data 
sheet, which defines the section displayed 
(equivalent to the Go to project end tool on 
the Data Record menu).  

   

The seven buttons in the right block of the General features toolbar 
are a collection of frequently used tools: 

Icon Function Use 

 Call processing templates You can use this tool to execute the 
Processing templates command on the Data 
Record menu. 

 Set filter You can use this tool to execute the 
Organize and filter command on the Tools 
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Icon Function Use 

menu. 

 Release filter You can use this tool to deactivate a filter 
set. As a result, the ‘unfiltered’ status of the 
data sheet is restored. 

 Print You can use this tool to execute the Print 
command on the File menu. 

 Help You can use this tool to activate the context-
sensitive online help; i.e. help on the tool, 
data sheet etc. that is currently active is 
displayed. 

 Nemetschek Homepage You can use this tool to execute the 
Nemetschek Homepage command provided 
in the Nemetschek on the Web tool on the 
Help menu. 

 Arrangement with 3 
windows 

You can use this tool to open and display the 
memo and object windows in addition to a 
project-specific data sheet. 

   

 
 

Buttons in the "Project Functions" Toolbar 
  

 

  

The Project functions toolbar includes buttons for the most 
important tools that you need to edit projects. This way, access to 
the most frequently used tools is provided without requiring you to 
select a menu first. 

Icon Function Use 

 (left) Select scheme You can use this button to open the Select 
scheme list box, which lets you set the data 
sheets’ contents and appearance. 
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Icon Function Use 

 (right) Switch data sheet 
(= processing 
phase) 

You can use this button to open the Data 
sheet list box, where you can select a 
different data sheet and thus switch the 
processing phase of the project. 

 Open project You can use this tool to execute the Open 
command on the File menu. 

 Undo You can use this tool to execute the Undo 
command on the Data Record menu. 

 Repeat You can use this tool to execute the Repeat 
command on the Data Record menu. 

 Hide current hierarchy You can use this tool to execute the Hide 
current hierarchy command on the Data 
Record menu. 

 Filter current hierarchy You can use this tool to show only the data 
records of the current level in the hierarchy. 

 Display current hierarchy You can use this tool to execute the Display 
current hierarchy command on the Data 
Record menu. 

 Display all hierarchy levels You can use this tool to execute the Display 
all hierarchy levels command on the Data 
Record menu. 

 Display relations You can use this tool to execute the 
Display relations command on the Data 
Record menu. 

 Hide relations You can use this tool to execute the Hide 
relations command on the Data Record 
menu. 

 Set up file You can use this tool to execute the Set up 
file command on the Tools menu. 

 Calculate hierarchy You can use this tool to execute the 
Calculate hierarchy command on the 
Calculation menu. 

 Calculate everything You can use this tool to execute the 
Calculate everything new command on the 
Calculation menu. 

 Chart wizard You can use this tool to execute the Chart 
wizard command on the Tools menu. 

 REB formulas You can use this tool to execute the REB 
formulas command on the Tools menu. 
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Buttons in the "Text Libraries" Toolbar 
  

 
  

The Text libraries toolbar provides buttons you can use to access the 
most important text libraries associated with Allplan Building Costs. 
Requirement: the relevant library must be installed. 

Icon Function Use 

 Architekten-Service You can use this tool to execute the 
Architekten-Service command provided in 
the Text libraries tool on the Tools menu. 

 ausschreiben.de You can use this tool to execute the 
ausschreiben.de command provided in the 
Text libraries tool on the Tools menu. 

 HeinzeBauOffice You can use this tool to execute the 
HeinzeBauOffice command provided in the 
Text libraries tool on the Tools menu. 

 DBD-Dynamische 
Kostenelemente 

You can use this tool to execute the DBD-
Dynamische Kostenelemente command 
provided in the Text libraries tool on the 
Tools menu. 

 DBD-LVexpress You can use this tool to execute the DBD-
LVexpress command provided in the Text 
libraries tool on the Tools menu. 

 Standard service catalog 
for building 

You can use this tool to execute the STLB-
Bau command provided in the Text libraries 
tool on the Tools menu. 

 GreenBASE - Plant 
Disposition 

You can use this tool to execute the 
GreenBASE - Plant Disposition command 
provided in the Text libraries tool on the 
Tools menu. 

 sirAdos building data You can use this tool to execute the sirAdos 
building data command provided in the Text 
libraries tool on the Tools menu. 

 Standard service catalog You can use this tool to execute the StLB 
command provided in the Text libraries tool 
on the Tools menu. 



 

Integrated solutions  Getting Started with Allplan Building Costs 29 
 

Getting Started with 
Allplan Building Costs 

This chapter is designed to give you a quick and practical 
introduction to Allplan Building Costs. In a few short steps it shows 
you how to work with projects: in particular, you will learn how to 
create a new project, how to generate a file including titles, subtitles 
and items and how to import, delete and copy items. In addition, you 
will find out about the most important options provided for 
modifying files, you will change calculation types and set up the file 
and finally, you will print out the finished file. 

Furthermore, you will find an introduction to cost calculation, 
quotation check, price comparison list, awarding, invoicing and cost 
control. 

Note: Detailed information on the individual topics is provided in the 
relevant chapters. 

  

Important! 
The descriptions that follow are based on the PROFESSIONAL 
scheme! If you have set a different scheme for your data sheets, 
please switch to PROFESSIONAL. 

  

Tendering (Quick Reference Guide) 

Create a New Project 

New projects can be created using the Project Overview data sheet, 
for example. To do this, click Project Overview on the File menu. 
The Project Overview data sheet opens and any existing projects are 
displayed. Create a new project by clicking New on the File menu. 
The New Project dialog box opens. 

Tip: Advanced information 
can be found in the online 
help for Allplan Building 
Costs under "Defining 
Schemes for Data Sheets." 
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Enter a name for the new project, e.g. "Sample building". In addition, 
you can assign a status to the project. 

Projects that are to be available as master files require the ‘MASTER’ 
status. The ‘ELEMENT MASTER’ status needs to be assigned to 
element catalogs and ‘ELEMENT SCHEDULE’ to element calculations 
and room schedules. For tender projects select the ‘PROJECT’ status. 

The ‘PROJECT’ option is the default setting. Confirm your entries by 
clicking OK. 

The system now initializes (= creates) the database for the new 
project. Then this project opens automatically in the Calculation data 
sheet, which contains all the columns that are of relevance in this 
phase. 

The project you just created is added to the Project Overview data 
sheet. As the project overview is not required for the time being, 
close the Project Overview data sheet by clicking the  in the top 
right corner. 
 

Create Files 

Specification descriptions for the new project are edited in the 
Calculation data sheet. Start by creating files. 

The first line of the Calculation data sheet provides the following 
information: ‘Project’ is displayed in the Type column and the name 
of your project – ‘Sample building’ – in the Short text column. The 
second line includes the ‘Cost’ sum line, which will be used to 
totalize the project costs later. 

To create a file for this project, place the insertion marker in the cost 
line and click New on the Data Record menu. The New dialog box is 
displayed. You can choose between ‘Folder’ and ‘File’. Select the 
‘File’ option and click OK to confirm. 

Two new lines are added to the Calculation data sheet: ‘File’ and 
‘Total/End’. 

The ‘Type’ column in the data sheet indicates the hierarchic 
structure: whereas the ‘Project’ and ‘Cost’ entries are on the far left, 
the ‘File’ and ‘Total/End’ entries, which are subordinate in the 
hierarchy, are indented.  



 

Integrated solutions  Getting Started with Allplan Building Costs 31 
 

Enter a name for this file (e.g. "Unfinished structure work") in the 
Short text column of the file line and, for example, "TOTAL 
unfinished structure work" in the sum line of the file. 
 

Create Titles 

After you have created the file, you can add titles (crafts, service 
types) to refine the file’s hierarchical structure. Place the insertion 
marker in the sum line of the file and click New on the Data Record 
menu. 

The data records presented for selection in the New dialog box have 
changed: now you can choose between ‘Title’, ‘Item’ and ‘Comment’. 
Select ‘Title’ and click OK to confirm. Two new lines are added to the 
file displayed in the Calculation data sheet: they have the entries 
‘Title’ and ‘Total/End’ in the Type column. The entries are indented 
to indicate the hierarchic structure. Enter a name for this title (e.g. 
"Masonry work") in the Short text column of the title line and, for 
example, "TOTAL masonry work" in the sum line of the title. 

Enter a second title (e.g. "Concrete work") in the same manner. Place 
the insertion marker in the sum line of the file and click New on the 
Data Record menu again. Select ‘Title’ in the New dialog box and 
click OK to confirm. Then enter the name for this title in the Short 
text column. 

You can also create several data records in a single step. All you 
need to do is enter a number that is greater than 1 in the New dialog 
box. 

Now you have defined the file’s hierarchic structure. As the file is 
still missing the items, i.e. the bottom level in the hierarchy, you 
need to create them now. 
 

Create Items 

Begin by creating items for masonry work: Place the insertion 
marker in the sum line of masonry work and click New on the Data 
Record menu. Select ‘Item’ in the New dialog box and click OK to 
confirm. The new item is added to the Calculation data sheet. 

Enter information on this item in the Short text and Dimension 
columns. You can also make entries in the other columns to describe 
the item in detail. To enter the long text for this item, double-click in 
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the Long text column of the item line. A window opens. Now you 
can enter the long text. To close the text window, click .. 

To create more items for masonry work, place the insertion marker in 
the sum line of masonry work again and repeat the steps described 
above. 

You can also create several data records in a single step. All you 
need to do is enter a number that is greater than 1 in the New dialog 
box. 

By the way: When you select Paste instead of New on the Data 
Record menu after having created a data record, the last definition 
you made is inserted again in the hierarchy. 
 

Add Items Later 

There are times you will find that you want to insert an item at a 
specific place within a title later. 

To do this, place the insertion marker on the item above which the 
new item is to be created. On the Data Record menu, click New and 
select ‘Item’ in the New dialog box. Then click OK to confirm. The 
item is added as you wanted. 

Consequently, all the items below the new item move down a line. 
Now you can edit the short text, long text, dimension etc.  
 

Delete Items 

Item lines can be deleted at any time. All you need to do is place the 
insertion marker in the line you want to remove and click Delete on 
the Data Record menu. The item line is thus removed from the data 
sheet. All the other items within the relevant title are unaffected. 
 

Create Subtitles 

Until now, you have used the following levels to structure the 
project: File – Titles – Items. However, it is often necessary to refine 
the structure further; in other words, to create subtitles for a title. In 
this example, you will define subtitles (e.g. "Exterior walls", "Interior 
walls" and "Columns") for "Concrete work". This involves the 
following steps: 
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Place the insertion marker in the sum line of the "Concrete work" 
title and click New on the Data Record menu. Select ‘Title’ in the 
New dialog box. Enter descriptions in the title line (e.g. "SUBTITLE 
exterior walls") and in the sum line (e.g. "TOTAL subtitle 
exterior walls") of this subtitle. 

Although subtitles are given the name ‘Title’ (indicated in the ‘Type’ 
column), you can clearly see that they are hierarchically subordinate 
to titles – subtitles are indented. 

Repeat these steps for the subtitles "Interior walls" and "Columns". 
Make sure that you place the insertion marker in the sum line of 
"Concrete work". 

Here, too, you can create several data records in a single step. All 
you need to do is enter a number that is greater than 1 in the New 
dialog box. 

To create items for a subtitle, you need to place the insertion marker 
in the sum line of the relevant subtitle or in an item line within this 
subtitle. 

As you can see, Allplan Building Costs allows you to create files 
consisting of different hierarchic structures. This way, you can 
customize files to suit the task at hand. 
 

Copy Items 

If you want to create similar items that differ in length and width 
only, you can copy items as many times as you need and then 
modify them. 

This involves the following steps: Place the insertion marker on the 
item you want to copy. Select Copy on the Data Record menu. The 
Copy dialog box is displayed. Activate the Actual line option and 
click OK to confirm. The item is copied to the buffer. Place the 
insertion marker in the line above which the item is to be inserted 
and click Paste on the Data Record menu. The item is inserted. You 
can insert the item you copied beforehand in the data sheet as often 
as you want – just click Paste. Note, however, that you need to place 
the insertion marker in the line above which the item is to be 
inserted each time you place a copy. 
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You can also copy several items in a single step. To do this, repeat 
the steps described above – the only difference is that you need to 
select several items. When you have clicked all the relevant items, 
select Copy and then Paste (Data Record menu). 

The Data Record menu provides a number of tools for selecting 
items: Mark Line, Mark Hierarchy, Cancel Marking and Cancel 
Hierarchical Marking. 

For example, you can use Mark Hierarchy to select an entire title or 
file. It is important that you place the insertion marker in the desired 
line in the hierarchy (e.g. the title or file line). This tool selects all the 
items within the relevant hierarchy as well as the hierarchy itself 
including its sum line. 

You can use the Cancel Marking and Cancel Hierarchical Marking 
tools to unselect a single item and all the items of a level in the 
hierarchy, respectively. Here, too, it is important that you select the 
relevant item or hierarchy. 
 

Add Items from Master Text 

Items cannot only be copied within a datasheet but also across data 
sheets: for example, you can copy items from a project to a different 
one or from master text to a project. 

To do this, open the Master data sheet by clicking Open on the File 
menu. On the left in the Open data sheet dialog box, click ‘Master’ 
and on the right, select the ‘Demo master text’ entry. Then click OK 
to confirm. (Requirement: you have installed the demo data as 
described in the chapter entitled "Installing Demo Data".) 

The master text data sheet is now above the data sheet of the 
‘Sample building’ project. Select some items as described in 
"Copying Items" and copy them to the buffer by clicking Copy on 
the Data Record menu. 

Now switch back to the Calculation data sheet by clicking a visible 
part of the data sheet (this activates the data sheet again) and place 
the items you copied where you require. 

You can repeat these steps as often as you need and thus create a file 
based on master text. 
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Change the Calculation Type 

It is often necessary to define different item categories for tenders 
(e.g. requirement or contingency items). 

Place the insertion marker on an item whose category you want to 
change. Then, click Properties on the Tools menu. Alternatively, you 
can also place the insertion marker in the Type column and click the 
right mouse button. 

In the dialog box, which then appears, you can open the ‘Item 
category’ list box and select a calculation type (e.g. ‘Contingency 
item’). Click Apply to confirm your selection and close the dialog 
box by clicking OK. 

‘Cont. Item’ is displayed in the Type column of the item you selected 
in the data sheet. Now only the unit price of this item can be 
determined. The total price is not calculated. Consequently, this item 
is not taken into account for cost calculations or subsequent 
proposal checks. 
 

Set Up Files 

Of course, you can always set up files manually by entering item 
numbers in the Item no. column. But it is much easier to use Allplan 
Building Costs’ automatic algorithm. 

To benefit from this feature, place the insertion marker in the 
‘Unfinished structure work’ file line and click Set Up File on the 
Tools menu. Alternatively, you can also place the insertion marker in 
the Item no. column and click the right mouse button. 

A dialog box appears where you can define the formatting type in 
the ‘Format’ list box and specify the number at which this process is 
to start in the ‘Start with’ text box (not mandatory). Start the 
operation by clicking the Set up file button and then click Close to 
close the dialog box. 

Now all the items in the file are given a hierarchic structure. You can 
repeat this operation as often as you want. 
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Calculate Quantities 

Basically, Allplan Building Costs provides two methods for 
calculating quantities: 

• The first option is to determine the quantities in a conventional 
manner based on the quantity information provided in your 
plan(s). You can then enter this data in the Quantity column of 
each item. 

• Another alternative is to harness the advantages provided by 
using Allplan Building Costs’ integrated quantity takeoff 
operations. This option is covered in a later chapter (see 
"Accounting"). 

 

Print Files 

Place the insertion marker in the ‘Unfinished structure work’ file 
line and click Print on the File menu. Please note that the contents 
of the printout are defined by the position of the insertion marker. 
When the insertion marker is placed on a level in the hierarchy 
(‘Project’, ‘File’ or ‘Title’), the entire hierarchy is printed. When you 
place the insertion marker on an item, only the selected item is 
printed. 

You can select reports in the Print dialog box. It also makes sense to 
check the foot note. To do this, click the Options button. The 
Adjustments dialog box is displayed. In the Print tab, you can edit 
the text that appears in the foot note. It is a good idea to enter your 
company address. 

To check the printout on screen, click the Preview button in the 
Print dialog box. If the preview of the page is too small, just click it. 

Click the Print button to start printing. In the Windows Print dialog 
box, which then appears, you can enter the number of copies and set 
up the printer. 
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Calculate Costs 

Clients are often expected to submit rough cost estimates right from 
the beginning. Costs can be calculated in the Calculation data sheet. 

You can enter the estimated price for every item in the UP column 
(unit price). As soon as you quit the item line, Allplan Building Costs 
calculates all the prices for this item: 

• TP checked (total price checked = UP x number (quantity)) 

• TP eff. (total price effective = TP checked +  additional 
fee/discount (%)) 

• TP grs (total price gross = TP eff. + VAT) 

In the case of alternative items, you can enter the unit price. The 
total price, however, is set to zero. Consequently, any other 
associated prices are not calculated either. 

When you have entered all the unit prices, place the insertion marker 
in the ‘Unfinished structure work’ file line and click 
Calculate Everything New on the Calculation menu. Allplan 
Building Costs now re-calculates and updates all the prices and 
computes the totals, which are then displayed in the project, file and 
title lines.  

As this project currently contains a single file, the file’s total price, 
effective total price and gross total price are also displayed in the 
project line. 
 

Print Cost Calculations 

Place the insertion marker in the ‘Unfinished structure work’ file 
line and click Print on the File menu. Select a report and proceed as 
described above under "Printing Files (see "Print Files" on page 36)". 
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Awarding (Quick Reference Guide) 

Check Proposals 

You have sent the file to several tenderers who have entered prices 
and returned it to you. Now it is a question of checking and re-
calculating these prices. 

Click Open on the File menu. On the left in the Open Data Sheet 
dialog box, select the ‘Proposal check’ entry and on the right, select 
‘Sample building’. Then click OK. 

The selected project is displayed in the Quotation check data sheet. 
However, the price columns are empty and the Quantity column is 
also empty as this column is only displayed after you have created a 
tenderer. 
 

Create Tenderers 

Place the insertion marker in the ‘Unfinished structure work’ file 
line and click Create Tenderer on the Calculation menu. In the 
Create Tenderer dialog box, you can enter a tenderer name or select 
a name in the address database. Click OK to confirm. Now this name 
is entered in the Quotation check data sheet and displayed in the 
Tenderers column of each item. The quantities are also displayed. 

Now you can enter the unit prices quoted by this tenderer in the UP 
columns of the relevant items. Pressing the DOWN arrow key quickly 
takes you to the next data entry box. 

When you have entered all the unit prices, click 
Calculate Everything New on the Calculation menu. Allplan 
Building Costs calculates and displays all the title prices and the file 
price. This way, you can also check the totals of the proposal. 

To check other proposals, you can create additional tenderers in the 
same manner. Place the insertion marker in the file line, select 
Create Tenderer on the Calculation menu, specify a name for the 
tenderer, enter unit prices and calculate the total by clicking 
Calculate Everything New on the Calculation menu. 
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Note: You may have noticed that Allplan Building Costs does not 
display any prices in the project line and in the associated cost line 
at this stage. The reason for this is that project prices do not need to 
be calculated in this phase. The project total for the cost estimate is 
determined later in the Awarding data sheet. Proposals are always 
checked in a tenderer-specific manner. In other words, only the data 
in the relevant file are checked. 
 

Assign Additional Fees or Discounts 

You can enter additional fees and/or discounts specified by tenderers 
in the %+/- column. When a discount is to be applied to the entire 
file, place the insertion marker in the %+/- column in the file line 
and enter the amount as a percentage (e.g. "-5" for a discount of 
5%). After you have confirmed this value, Allplan Building Costs 
enters a discount of 5% for all the items in the file and immediately 
re-calculates and updates all the total prices. 

You can use the same approach to apply a discount to specific titles 
only. The only difference is that you need to place the insertion 
marker in the relevant title line. The price quoted is displayed in the 
TP effective column. 
 

Create Price Comparison Lists 

The prices entered in the Quotation check data sheet can now be 
compared in the Price comparison list data sheet. To do this, open 
the Price comparison list data sheet by selecting this data sheet in 
the list box. 

The Price comparison list data sheet shows the individual items 
(including item no., short text, dimension etc.) and the price lines of 
all tenderers. In addition, the cost calculation – i.e., the estimated 
prices you entered in the file – is displayed. 

Now you can select the tenderers you want to compare. Place the 
insertion marker in the ‘Unfinished structure work’ file line and 
click Select tenderer on the Calculation menu. The Select tenderer 
dialog box, which then appears, lists all the existing tenderers in the 
file. Select the tenderers that are to be included in the price 
comparison list and click OK. Now, only the tenderers you specified 
are visible in the data sheet. 
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Now you can compare the prices of the individual tenderers: place 
the insertion marker in the file line and then click Price comparison 
on the Calculation menu. In the Price comparison dialog box, select 
the column you want to compare in the Field to compare list box 
and the tenderer or situation on which the comparison is to be based 
in the 100% tenderer list box. The following entries are available: 
click ‘MIN’ if the lowest item price is to serve as the basis for the 
comparison. Select ‘MID’ to use the average price and ‘MAX’ to 
compare your selection with the highest price specified for an item. 
To compare tenderers, select a tenderer. Click OK to start the 
comparison. Allplan Building Costs calculates and displays the 
percentage figures in the % Td. comp. column. 

Before you print the price comparison list, specify the sequence of 
the tenderers in the Td. no. (= tenderer number) column: "1", "2", "3" 
etc. for the individual tenderers. In addition, check that the insertion 
marker is placed correctly. Then click Print on the File menu. 

Experiment with the numerous alternatives provided in Allplan 
Building Costs. For example, you can create a graphical price 
comparison list. To do this, select Chart wizard on the Tools menu. 
 

Create Tenderers of Order 

After you have checked all the proposals and compared the prices 
given by the individual tenderers, you can now appoint a tenderer of 
order for every file. Only one tenderer of order can be specified per 
file. 

Tenderers of order are assigned in the Price Comparison List data 
sheet. Place the insertion marker in the ‘Unfinished structure work’ 
file line and click Select Tenderer of Order on the Calculation menu. 
In the Select Tenderer of Order dialog box, select a tenderer and 
click OK to confirm. 

Open the Awarding data sheet. As opposed to the Price Comparison 
List data sheet, only the tenderer of order is displayed. 

You can now print out the associated file by placing the insertion 
marker in the file line and clicking Print on the File menu. 
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Remove Tenderers of Order 

If you inadvertently created a tenderer of order, you can undo this 
step again. This causes the ‘tenderer of order’ property to be removed 
from the relevant tenderer. It simply means that the tenderer of order 
becomes a normal tenderer again; all the other data associated with 
this tenderer is not affected. 

Open the Awarding data sheet, place the insertion marker in the file 
line of the file from which you want to remove the tenderer of order 
and click Remove Tenderer of Order on the Calculation menu. 

Now you can appoint a different tenderer of order. 

Note: When you have already assigned the ‘tenderer of accounting’ 
status to the tenderer of order you want to remove, you need to 
undo the ‘tenderer of accounting’ status before you can remove the 
‘tenderer of order’ status. 
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Accounting (Quick Reference Guide) 

Accounting 

Accounting includes many approaches that are familiar to you from 
file generation and cost calculation. Like cost calculation, accounting 
is based on quantities. Here, too, two methods are provided for 
documenting quantities: the first option is to enter the actual 
quantities used in the Quantity column. The second option is to 
check the record of detailed measures (if available) using Allplan 
Building Costs’ integrated quantity takeoff operations. 

Before you can start checking accounts, you need to specify the 
tenderer of accounting. This frees up hard disk space as you only 
create a tenderer of accounting when you actually want to use 
Allplan Building Costs for checking your accounts. 

Tenderers of accounting can only be appointed in the Awarding data 
sheet. Open this data sheet, place the insertion marker in the file line 
and click Create Tenderer of Accounting on the Calculation menu. 
Choose Yes at the following prompt. 
 

Remove Tenderers of Accounting 

When you want to remove a tenderer of order to whom you have 
already assigned the ‘tenderer of accounting’ status, you need to 
remove the ‘tenderer of accounting’ status first. You can then remove 
the ‘tenderer of order’ status. 

Open the Accounting data sheet, place the insertion marker in the 
file line of the file from which you want to remove the tenderer of 
accounting and click Delete Tenderer on the Calculation menu. 

All the other data associated with this tenderer is not affected. 
 

Calculate Quantities 

Switch from the Awarding data sheet to the Invoicing data sheet. 
The quantities and total prices in this data sheet are reset to zero as 
information on the actual quantities used was not available at the 
beginning of the invoicing phase. The unit prices for invoicing were 
adopted from the tenderer awarded the contract. 
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Note: To see better what you are doing, you can divide the Invoicing 
data sheet into two separate viewports that are mutually dependent. 
To do this, close all the data sheets, click Scheme on the Extras 
menu and activate the Separate diagrams for quantities and 
tenderer prices check box in the Special tab. Then open the project 
in the Invoicing phase again. 
 
The window on the left now displays the Invoicing data sheet with 
the Type, Item no., Short text and, if applicable, Long text columns. 
On the right, the Quantities to be invoiced data sheet window shows 
the quantity block with the Description, Factor, Calculation and 
Result columns. Please note that the quantity block always displays 
the data of the data record on which you have placed the insertion 
marker in the Invoicing data sheet window. 

To enter quantities for an item, place the insertion marker in the 
quantity block (e.g. in the Calculation column) of the relevant item 
line. Click New on the Data Record menu. Specify the number of 
quantity lines in the New quantity lines dialog box and click OK to 
confirm. 

Place the insertion marker in the Calculation column and make an 
entry. If you want, you can enter a comment on the calculation in 
the Description column. As soon as you leave the calculation line, 
Allplan Building Costs calculates the quantities and displays the 
result in the Quantity column. The result line in the price block is 
also calculated. 

Repeat these steps with all the items and quantities from the 
measurement sheets. Do the same with the other invoices and/or 
measurement sheets. You can then enter "2nd PP" (second progress 
payment) or "3rd PP" (third progress payment) etc. in the 
Description column. This way, you document the status of the 
quantities used. In addition, you can check the current cost status of 
your project. 

Tip: When you create a new quantity line, you can use the 
calculation of the quantity line in which you have placed the 
insertion marker (= current quantity line) for the new quantity line. 
Therefore, to record many individual quantities with a similar 
calculation, define a quantity line with this calculation, place the 
insertion marker in this line and create several new quantity lines in 
one go. Now, all that remains is to modify the calculations to suit 
your requirements. 
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Alternatively, use the Quantity calculation processing template for 
quantity takeoff operations. Place the insertion marker in the 
quantity block, click Processing templates on the Data Record menu 
and select Quantity calculation in the Processing templates dialog 
box. 

When you have entered all the relevant data, click Close to quit the 
Quantity calculation processing template. 
 

Split Quantities and Check Accounts 

In addition to evaluations based on costs and/or the actual quantities 
used, it is often necessary to run more detailed analyses according to 
a wide range of different criteria, such as the costs allocated to 
different clients or the individual progress payments or invoices. This 
way you can limit the evaluation to specific quantities and/or costs. 
These quantities and the resulting prices and/or total prices are then 
analyzed as follows: 

Let us assume that you want to check the second progress payment 
of the ‘Sample building’ project. You have already entered all the 
quantities specified in the records of detailed measures in the 
Accounting data sheet. The entire "Unfinished structure work" file is 
to be included in the analysis. To check the second progress 
payment, you need to filter out the quantities associated with this 
payment. 

Before you can filter the data sheet according to specific quantities 
and quantity calculations, you need to enter the relevant split code 
for each quantity calculation. First, check whether each quantity line 
has been assigned the correct split code in the Split column. Add 
missing split codes. 

Then place the insertion marker in the Split column of a quantity 
line containing the split code "2nd PP" and click Macros on the 
Tools menu. Select the Mengensplit wie aktuelle Zeile macro in the 
Apply Macro dialog box and click Apply. Now the data sheet 
displays only those quantity lines that match the selected split code 
"2nd PP". The total quantities and total prices are calculated 
automatically, based on the filtered items. 

As data in filtered data sheets is lost when they are closed, you need 
to print out the results of the current quantity split. The procedure is 
basically the same as when printing a normal file, except that you 
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select a different report in the Print dialog box: Abrechnung 
Mengen und Kosten. 

Then reset the quantity split. To do this, click Macros on the Tools 
again, select the Mengensplit aufheben macro and click Apply. 
 

Check and Control Costs 

There are times you may find that you want to compare the 
individual stages of a project. The phases most commonly compared 
are Awarding and Accounting. To do this, click Open on the File 
menu. Select the Cost Control data sheet and the ‘Sample building’ 
project. 

All the items of the project and the associated phases (calculation, 
awarding and accounting) are displayed in the Cost Control data 
sheet. 

Click Select Tenderer on the Calculation menu. A dialog box is 
displayed. Select the ‘Awarding’ and ‘Accounting’ phases. Now the 
Cost Control data sheet only shows the price lines for the selected 
phases. 

Place the insertion marker in the project line and click Price 
Comparison on the Calculation menu. A dialog box appears. Define 
the column which is to serve as the basis for the comparison. Here, it 
makes sense to select ‘Effective total price’. In addition, specify the 
phase for the comparison, i.e., awarding in this case. Click Compare 
to confirm your selection and Close to close the dialog box. Now the 
following information is provided in the % Phase comparison 
column: for awarding, a value of 100% is entered and for 
accounting, the corresponding differences are displayed. 

To print out the Cost Control data sheet, place the insertion marker 
in the ‘Unfinished structure work’ file line and select Print on the 
File menu. 

Note: This way, you can check all the phases and the associated data 
in your project. For example, to get detailed information on the 
development of prices in your project, all you need to do is select all 
the phases (i.e., calculation, awarding and accounting).  

To get a better overview, you can also harness the advantages 
provided by using graphics. 
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Basic Introduction 
This chapter deals with the basics that are essential for your 
understanding of Allplan Building Costs. 

Here, you can find general information about data sheets as well as 
specific information on the purpose, structure, and setup of the 
individual data sheet types. 

In addition, this chapter provides detailed information on memo 
fields, object fields, and processing templates. It also shows you how 
you can use the user-definable settings to customize Allplan 
Building Costs to your needs. 

Furthermore, this chapter covers how to generate printouts, i.e. how 
to print overviews, files, cost calculations, quantity calculations, etc.. 

  

ATTENTION! 
Data backup is generally one of the critical issues in the IT industry. 
For this reason, backing up data and archiving projects are covered 
in a separate section. There, you will learn how to archive, back up, 
and restore projects and how to back up your individual column 
settings, column definitions and reports, and how to restore them. 

  

 
 

About Data Sheets 
Data sheets play a central role in Allplan Building Costs. Opening a 
data sheet establishes a link between the data sheet and the relevant 
database. The relevant data is read from the database into the 
selected data sheet where it is entered in the individual lines and 
columns, as in a spreadsheet. This link is retained until you close the 
data sheet. 
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There are three types of data sheets: 

• Project-independent data sheets 

• Data sheets for managing master data 

• Project-specific data sheets 

  

Project-independent data sheets 

All the projects and master data are managed in the Project 
overview data sheet (see ""Project Overview" Data Sheet" on page 
50) where you can create new projects, delete projects you no longer 
need, or save and load projects. 

In the Address overview data sheet (see ""Address Overview" Data 
Sheet" on page 51), you can access and organize addresses. In 
addition to the various options provided for sorting, finding and 
filtering addresses, you can also print out the addresses you have 
archived. 

Objects (e.g. images and sketches) are managed centrally in the 
Image overview data sheet (see ""Image Overview" Data Sheet" on 
page 52). For example, you can copy objects to this data sheet using 
the Windows Clipboard or add OLE objects to the image database. 
The objects archived in the image database can then be copied to the 
Windows Clipboard and pasted into the object windows of project-
specific data sheets. This way, objects can be integrated into projects 
or used as company logos in printouts, for example. 

The CAD XPad (see ""CAD XPad" Data Sheet" on page 53) data 
sheet displays the CAD data currently imported. In addition, you 
select the items to be integrated in a project in this data sheet. 

  

Data sheets for managing master data 

Allplan Building Costs provides the Master and Element master data 
sheets for managing master data. 

The difference between master text and element catalogs is that 
master text is usually structured based on the individual items in a 
file (i.e. sorted by title). In element catalogs, on the other hand, items 
are structured on a component-oriented basis. 

Tip: A general description of 
how to work with data sheets 
is provided in the section 
entitled "Using Data Sheets". 
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Note: As the Master and Element master data sheets have a data 
structure similar to project-specific data sheets and work in the same 
way, they are not explained separately. Where differences exist, they 
will be pointed out in the relevant description. 

  

Project-specific data sheets 

Projects are edited using the project-specific data sheets. Allplan 
Building Costs provides data sheets for all the phases of a project; 
this means that you can use the data sheet best suited to the task at 
hand. Only the data that is relevant to the current phase is entered in 
the data sheet associated with the phase in question. 

Initial cost estimates are drawn up right from the outset. Using the 
options provided by Allplan Building Costs, an estimate can quickly 
be obtained as to the cost of the building and/or the individual 
components used. All you need to do is copy the elements you want 
to include from the Element master data sheet into the project-
specific Element schedule data sheet. Then, you need to complete 
the quantities - that’s all! You can also sort an element schedule by 
DIN 276 cost groups in the DIN 276 estimation data sheet. 

In the Calculation data sheet, you can create files for a project and 
perform quantity and cost calculations. 

To calculate costs in compliance with DIN 276, you can use the 
DIN 276 Calculation data sheet for this phase of the project. This 
data sheet sorts all the items of the Calculation data sheet by the 
DIN 276 cost group numbers and computes the totals for each cost 
group. 

You then use the Quotation check data sheet to check individual 
quotations. To do this, enter the prices quoted by each tenderer into 
the data sheet or import them from quotations submitted in GAEB 
format DA 84. 

You can compare the prices quoted by the individual tenderers in the 
Price comparison list data sheet. In this data sheet, you also select 
to which tenderer you want to award the contract. The prices of 
the selected tenderer are transferred to the Awarding data sheet. 

The Awarding data sheet then shows the contractor's prices, i.e. the 
file that was awarded the contract. In this phase of the project, you 
can also open the DIN 276 Awarding data sheet to display the 
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individual totals that were calculated for the costs after awarding in 
compliance with DIN 276. 

Next, you select the tenderer for invoicing in the Awarding data 
sheet. You then switch to the Invoicing data sheet and start checking 
the measurement sheet and entering the quantities used. You can 
also enter claims in this data sheet. When you have entered all the 
quantities used in the Invoicing data sheet, you can open the 
DIN 276 Invoicing data sheet to determine the totals for the final 
costs in compliance with DIN 276. 

The Cost control data sheet gives you an easy way to monitor the 
cost development of a project. It lists the quantities and costs for 
each of the calculation, awarding and invoicing phases for direct 
comparison. To compare the individual phases by DIN 276 cost 
group, use the DIN 276 Cost control data sheet. 

 
 

"Project Overview" Data Sheet 

In Allplan Building Costs, the term "project" encompasses master 
text, element catalogs, element and room schedules as well as the 
actual files. The Project overview data sheet (how to open...) 
provides up-to-date information on the projects (in the currently set 
data directory) and their processing status. 

You can customize the contents and layout of the Project overview 
data sheet to suit your needs. For example, a Project overview data 
sheet that has just been opened might look like this: 
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The projects displayed in the Project overview data sheet can be 
sorted alphabetically by column and filtered according to different 
criteria. This way, you keep a good overview, even with a large 
number of projects. Moreover, for each project overview output, only 
the data lines displayed in the Project overview data sheet will be 
taken into account. Thus, all sorting and filter criteria you have 
specified will also be included in printouts. 

An overview of the projects included in the project management can 
be displayed on screen or sent to a printer. Here again, the output 
will be limited to the data lines displayed in the Project overview 
data sheet. This means that all the criteria you have defined using 
the Organize and filter tool will be taken into account. 

Projects you no longer need can be deleted from the current project 
management data directory and from the archive. 

Note: For descriptions of how to do all this, see the "Editing projects" 
section. The "Columns in the Project overview data sheet" section 
provides information on the columns of this data sheet and their 
contents. 
 

"Address Overview" Data Sheet 

The contact data of your clients, design partners and potential 
contractors, which you need for your daily work, can be managed in 
the central Allplan Building Costs address database. This means that 
you do not have to re-enter the addresses each time again, but you 
can retrieve them easily from the address database when working 
within any program module. 

The Address overview data sheet (how to open...) provides an 
overview of all addresses archived in the central database (e.g. 
addresses of clients, authorities, employees etc.). 

You can customize the contents and layout of the Address overview 
data sheet to suit your needs. For example, an Address overview 
data sheet that has just been opened might look like this: 
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The addresses displayed in the Address overview data sheet can be 
sorted alphabetically by column and filtered according to different 
criteria. This way, you keep a good overview, even with a large 
number of archived addresses. Moreover, for each address overview 
output, only the data lines displayed in the Address overview data 
sheet will be taken into account. Thus, all sorting and filter criteria 
you have specified will also be included in printouts. 

An overview of the addresses archived in the address database can 
be displayed on screen or sent to a printer. Here again, the output 
will be limited to the data lines displayed in the Address overview 
data sheet. This means that all the criteria you have defined using 
the Organize and filter tool will be taken into account. 

Addresses you no longer need or that have become obsolete can be 
deleted from the address database including all associated address 
data. 

Note: For descriptions of how to do all this, see the "Editing 
addresses" section. The "Columns in the Address overview data 
sheet" section provides information on the columns of this data sheet 
and their contents. 

 
 

"Image Overview" Data Sheet 

In Allplan Building Costs, you can enhance your files by adding 
images and sketches (= "objects"). The image database offers the 
option to centrally archive all the objects available for your projects. 
Consequently, the objects saved in the image database can be 
accessed from within any program module, either while editing your 
projects or by retrieving them from the address database. 
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The Image overview data sheet (how to open...) provides a list of all 
the objects archived in the image database. 

You can customize the contents and layout of the Image overview 
data sheet to suit your needs. For example, an Image overview data 
sheet that has just been opened might look like this: 

  

 

  

The objects displayed in the Image overview data sheet can be 
sorted alphabetically by column and filtered according to different 
criteria. This way, you keep a better overview, even with a large 
number of archived objects. Moreover, for each object overview 
output, only the data lines displayed in the Image overview data 
sheet will be taken into account. Thus, all sorting and filter criteria 
you have specified will also be included in printouts. 

An overview of the objects archived in the image database including 
the associated object information can be displayed on screen or sent 
to a printer. Here again, the output will be limited to the data lines 
displayed in the Image overview data sheet. This means that all the 
criteria you have defined using the Organize and filter tool will be 
taken into account. 

Note: For descriptions of how to do all this, see the "Editing images 
and sketches" section. The "Columns in the Image overview data 
sheet" section provides information on the columns of this data sheet 
and their contents. 
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"CAD XPad" Data Sheet 

The CAD XPad data sheet (how to open...) represents the interface 
between project handling with Allplan Building Costs and other 
applications such as the Allplan CAD system. The CAD XPad data 
sheet should be considered as a temporary database for CAD data to 
be imported (e.g. results from quantity calculations). In addition, this 
tool provides a convenient way to quickly make entries which can 
later be used to generate element schedules or files. 

Before integrating Allplan data into an element schedule or a file, 
you can import this data into the CAD XPad data sheet first. Once 
the import process is complete, you can check its results by 
displaying the contents of the CAD XPad data sheet. The CAD XPad 
further enables you to filter the imported data records for the specific 
components you want to transfer to your file structure. 

ATTENTION! 
Bear in mind that the entries in the CAD XPad data sheet are not 
saved permanently. They will rather be overwritten whenever you 
import new data. To preserve the current contents of the CAD XPad 
data sheet, you need to integrate the data into a file structure. 

You can customize the contents and layout of the CAD XPad data 
sheet to suit your needs. For example, a CAD XPad data sheet that 
has just been opened might look like this: 
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The components contained in the CAD XPad data sheet after 
importing the CAD data can be sorted alphabetically by column and 
filtered according to different criteria. As only the components that 
are displayed when you access the CAD XPad -> Element Schedule 
or CAD XPad -> Project tool are transferred to an element schedule 
or file, the filter functions play a decisive role here. 

Note: For descriptions of how to do all this, see the "Editing CAD 
data" section. The "Columns in the CAD XPad data sheet" section 
provides information on the columns of this data sheet and their 
contents. 

 
 

Project-Specific Data Sheets 

To edit a project, you need to open it in a project-specific data sheet. 
To facilitate showing and hiding of parts of the hierarchy, a 
"navigator", which is similar to that in Windows Explorer, is 
displayed in the Type column of these data sheets (not available in 
the CLASSIC scheme). This navigator has much in common with the 
Windows Explorer: You can open and close hierarchies simply by 
clicking on the corresponding  or  icon. Or, for example, you can 
reposition or copy items to other data sheets by dragging and 
dropping them. 

But there are some differences to the navigator in the Windows 
Explorer: in the Windows Explorer, there is no fixed order for the 
file display. After each update, the files will be reordered, e.g. 
alphabetically. In Allplan Building Costs however, the data records 
are always arranged in the order specified by you. For this reason, 
when dragging and dropping an item, do not drag it to the title 
where you want to insert it, but exactly to the line above which you 
want to insert the item. 

The contents and layout of an open data sheet depend on your 
personal settings and of course on your project data. For example, a 
project-specific data sheet that has just been opened might look like 
this: 
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While you edit a project using a project-specific data sheet, Allplan 
Building Costs buffers your edits line by line. This means that, each 
time you enter or modify data, these will be stored temporarily in the 
RAM of your computer. The changes are not written to the database 
until you exit the line to edit another line. When you are working in 
a network, this mode allows multi-user access; in other words, the 
project can be opened and edited on several computers 
simultaneously. 

Note: For a general description of how to set up and use project-
specific data sheets, see the section entitled "Using Data Sheets". The 
"Columns in project-specific data sheets" section provides further 
information on the columns of these data sheets and their contents. 
More detailed information on creating and editing data records is 
provided in the "Basics of Working with Data Records" section. 
 



 

Integrated solutions  Basic Introduction 57 
 

Calculation Elements in Data Sheets 
As you work in Allplan Building Costs, you will find that the Master, 
Element Master and Element Schedule data sheets as well as the 
project-specific data sheets contain similar hierarchic structures, 
which consist of data lines opening levels in the hierarchy and data 
lines closing levels in the hierarchy. 

Data lines opening levels in the hierarchy never exist on their own. 
Rather, they are always complemented by the associated data lines 
closing levels in the hierarchy. When, for example, you create a new 
project and open the data sheet, the ‘Project’ entry has already been 
created in the first data line and the ‘Cost’ entry in the second data 
line. This means that the ‘Cost’ data line closes the ‘Project’ level. 

  

 

  

All the data you enter now is integrated in the hierarchy defined and 
delimited by "Project - Cost". Each time you create a new data record 
in the hierarchy, you will find that the associated data line closing 
this level in the hierarchy - ‘Total’ or ‘Cost’ - is created 
automatically. 

These additional data lines closing the hierarchy are always 
appended to the end of a level in the hierarchy. When, for example, 
you place the insertion marker in a sum line and create a new item, 
this item is inserted in this line and consequently, the sum line 
automatically moves down a line. 
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As you can see in the illustration, the ‘Project’, ‘Folder’, ‘File’ and 
‘Title’ data lines open a level in the hierarchy. 

The ‘Total/End’ and ‘Cost’ data lines close a level in the hierarchy. 

The data lines of the lowest level in the hierarchy - ‘Item’ and 
‘Comment’ – cannot open a new level in the hierarchy. 
Consequently, there are no associated data lines closing this level. 

In addition, the DIN 276 data sheets include data records for 
analyzing and evaluating data. 

 
 

"Project - Cost" Calculation Element 

The "Project - Cost" combination opens the hierarchy in each 
calculation data sheet. All the other levels in the hierarchy (e.g. 
folders or files) are delimited by this combination, which exists just 
once in each calculation data sheet. 
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The data records that are directly subordinate to the project level in 
the hierarchy are totalized both in the project line and in the cost 
line. 
 

"Folder - Cost" Calculation Element 

The "Folder - Cost" level, which can be inserted between the project 
level and the file level in the hierarchy, allows you to refine the 
hierarchic structure of projects (e.g. taking into account various 
construction stages, sections or components). 

  

 
  

The elements that are directly subordinate to the ‘Folder’ level in the 
hierarchy are totalized in the ‘Folder’ line and the associated cost 
line. 

 
 

"File - Total/End" Calculation Element 

The "File – Total/End" level cannot include any further files. A folder 
or project, on the other hand, can contain several files. Files are 
always subordinate to the project or folder line. 
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The elements that are directly subordinate to the ‘File’ level in the 
hierarchy are totalized in the ‘File’ line and the associated sum line. 
 

"Title - Total/End" Calculation Element 

Titles refine a file’s structure. The "Title – Total/End" level can 
include any number of subordinate titles (e.g. subtitles). 

  

 
  

The elements that are directly subordinate to the relevant title in the 
hierarchy are totalized in the ‘Title‘ line and the associated sum line. 

 
 

"Item" Calculation Element 

Items are data records of the lowest level in the hierarchy. You 
cannot create any items that are subordinate to items. Consequently, 
items consist of one line only (an associated sum line does not 
exist!). 
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"Comment" Calculation Element 

As with items, comments are data records of the lowest level in the 
hierarchy. You cannot create any comments that are subordinate to 
comments. 

  

 
  

 
 

"Element - Total/End" Calculation Element 

The "Element – Total/End" level in the Element Schedule and 
Element Master data sheets can be considered equivalent to files and 
titles in other data sheets. 

  

 

  

It is often necessary to create mixed hierarchic structures in the 
Element Schedule and Element Master data sheets (for example, 
"Story" element, "Room" element including the "Chair" item and an 
additional element - "Computer"; this "Computer" element in turn 
contains the items "Processor", "Screen" and "Keyboard"). 
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The elements that are directly subordinate to the relevant title in the 
hierarchy are totalized in the ‘Title‘ line and the associated sum line. 

 
 

"DIN 276 Classification" Calculation Elements 

In the data sheets for cost calculation in compliance with DIN 276 
(DIN 276 Estimation, DIN 276 Calculation, DIN 276 Awarding, 
DIN 276 Accounting and DIN 276 Cost Control), these lines are used 
for analyzing and evaluating. They are created and calculated after 
entry in the DIN 276 column. All the items that can be assigned to 
the DIN 276 cost group are totalized. 
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Memo Fields and Text Windows 
Memo fields cannot be filled in directly in data sheets; in other 
words, you cannot make any entries in the columns of memo fields. 
They are rather used as placeholders for text. Therefore, these data 
fields are simply characterized by the entry ´Memo´ or ´memo´ in 
data sheets. 

The difference in spelling – ´Memo´ or ´memo´ – indicates whether 
or not text has already been assigned to a memo field: ´Memo´ fields 
include text while ´memo´ fields are still empty. 

When you open a memo field, the hidden text associated with this 
field is displayed in a separate window (also referred to as a text 
window). You can enter any text in a text window. This text can 
then be included in printouts of projects or overviews if an 
appropriate report has been selected. 

For example, memo fields are included in the Construction project, 
Client and Note columns of the Project overview data sheet as well 
as in the Long text column of project-specific data sheets. 

When you activate the search tool in an open text window, this tool 
offers an advanced option: you can search AND replace any 
alphanumeric character string. Starting at the current position of the 
insertion marker, the search tool scans text from top to bottom. The 
first occurrence of the specified term is selected. The selected 
characters can be replaced automatically with a different term, if 
specified. 

You can use all Windows fonts installed on your computer for the 
on-screen display of text in text windows. In addition, you can 
choose from standard, italic, bold and bold/italic styles. The font 
sizes that are available to you depend on the fonts you have 
installed. 

Note: You can change the appearance of fonts for the on-screen 
display of text windows using the Data sheets tool on the Extras 
menu.  

Important! 
To modify the appearance of fonts for printouts, use the report 
designer. 
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Object Fields and Object Windows 
Object fields are data fields which only contain an ´Obj´ or ´obj´ 
entry in data sheets. When you double-click on an object field, the 
hidden object associated with this field is displayed in a separate 
window (also referred to as an object window). 

The difference in spelling – ´Obj´ or ´obj´ – indicates whether or not 
an object has already been assigned to the respective object field: 
´Obj´ fields include an object while ´obj´ fields are still empty. 

Object fields are arranged in the Image column of data sheets. 

Note: If the Image column is not displayed in your data sheet, close 
the data sheet and reopen it using the ADMINISTRATOR scheme. If 
you are using a user-defined scheme, add this column to the scheme 
(cf. "Add Normal Columns to Data Sheets"). 

  

 
 

Shortcut Menu 
In addition to the menus (see "Menu Bar in Allplan Building Costs" 
on page 22), toolbars (see "Toolbars in Allplan Building Costs" on 
page 22) and shortcuts, Allplan Building Costs also provides shortcut 
menus as an alternative way to access tools and execute commands. 

Shortcut menus have the advantage that they can be accessed 
directly and offer a context-sensitive set of tools and commands. 
This means that the available choices always depend on the state or 
context from which you open the shortcut menu. To give you an 
example, if you are setting up a file and the insertion marker is in 
the Short text column, you will get a different shortcut menu than if 
you are calculating quantities and the insertion marker is in a 
column of the quantity block. Not all input fields have a shortcut 
menu, though. When right-clicked, some open a dialog box instead 
(e.g. the Dimension input help dialog box opens from the Dim 
column). In other input boxes, no functionality is assigned to the 
right mouse button (e.g. in memo fields). 
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Note: The tools and commands provided on the shortcut menus are 
the same as those you can access or select through the menus, 
shortcuts or toolbars. 

  

Here you can see the shortcut menus for the Short text column (left) 
and the Quantity column (right), both opened from the Calculation 
data sheet: 

 

  

 
 

Processing Templates 
Allplan Building Costs provides a number of processing templates for 
editing master text and files. As with data sheets, processing 
templates for all the phases of a project are available; this means 
that you can select the processing template that best suits your 
current task. 

Each processing template already contains all data from a data 
record that is relevant to a specific phase. Therefore, processing 
templates provide an alternative method for displaying data sheets, 
allowing you to focus on the data of a specific data record (e.g. item) 
for a certain processing phase. 
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When you open a processing template, the values and texts from the 
data record in which the insertion marker is currently placed are 
entered in the processing template and can then be edited. 

  

 
  

By using the six buttons in the lower left corner of each processing 
template, you can retrieve the data of a different data record for 
display in the processing template without having to close and re-
open it for the new data record: 

Icon Function 

 Display the data of the first data record in the data sheet. 

 Display the data of the previous data record on same level in the hierarchy. 

 Display the data of the previous line. 

 Display the data of the next line. 

 Display the data of the next data record on same level in the hierarchy. 

 Display the data of the last data record in the data sheet. 

  

Important! 
When you display data of a different data record by using buttons or 
by closing a processing template, the data of the current data record 
in the data sheet will be updated. So before you display data of a 
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different data record or close a processing template, check whether 
you really want to keep the changes you have made to the current 
data record and apply them to the data sheet. 

If you do not want to apply the changes you have made in the 
processing template, discard them before you close the processing 
template or display a different data record. 

  

 
 

Macros 
Allplan Building Costs provides a number of macros that facilitate 
more complex tasks. As with data sheets, macros are available for all 
the phases of a project; this means that you can use the macro that 
best suits the current task. 

Not all macros are helpful or required in all phases/data sheets. For 
this reason, macros are usually associated with specific phases/data 
sheets, i.e. macros that are, e.g., available in the Calculation data 
sheet are not automatically available in all other phases. 

However, it is possible to copy macros from one phase/data sheet to 
another phase/data sheet. However, please note the following: 

Important! 
Please note that macros that have been copied to a different phase 
might need to be adjusted to that phase. The program does not 
automatically analyze whether it makes sense to copy the macro or 
whether its contents need to be adjusted! 

  

 
 

Wizards 
Wizards guide you comfortably through unusual tasks. 

Just like macros, not all wizards are helpful or required in all 
phases/data sheets. For this reason, some of the wizards are 
associated with specific phases/data sheets, i.e. a wizard that is 
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available, e.g., in the Calculation data sheet is not automatically 
available in all other phases. 

  

The following wizards are available: 

Wizard Function Requirements 

Print user settings Prints the user settings  
of the current user or of all Allplan 
Building Costs users set up in the 
Allplan Building Costs user manager. 

All data sheets and dialog 
boxes are closed. 

Copy reports Copies reports across phases. Available in all phases/data 
sheets. 

Integrate DIN-Classification Copies the entire DIN 276 classification 
to the new project (cf. "Copying the 
DIN 276 Cost Classification in Its 
Entirety"). 

The DIN 276 Estimation or 
DIN 276 Calculation data sheet 
is active and the DIN 276 
CLASSIFICATION project has 
been installed. 

Create data for MS Project Copies the data relevant for scheduling 
with MS Project to the Clipboard from 
where they can be inserted into MS 
Project (cf. "Scheduling"). 

The Calculation data sheet is 
active. 

Allocate variables of elements Creates a table where you can easily 
assign values to all variables available 
in an element schedule (cf. 
"Calculating Element Quantities" and 
"Calculating Quantities by Using 
Variables"). 

The Element schedule data 
sheet is active. 

Copy macros Copies macros across phases (cf. 
"Copying Macros"). 

Available in all phases/data 
sheets. 

Diversify display of schemes Temporarily changes the representation 
(grid lines and font) of the current data 
sheet. 

Any data sheet is open in a 
scheme without tabs. 

Integrate Ö-Norm B 1801 
structure 

Copies the entire classification (or 
"structure") in compliance with Ö-
Norm B 1801 to the current project. 

The DIN 276 Estimation or 
DIN 276 Calculation data sheet 
is active and the Ö-Norm 
B 1801 structure project has 
been installed. 
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User-Definable Default and Data Sheet 
Settings 

User-definable default settings 

In Allplan Building Costs, you can select various defaults that are 
saved permanently. 

For example you can specify 

• in which paths and directories the data is stored and saved, 

• whether and when prices, quantities and other entries in data 
sheets are calculated and/or updated, 

• whether a selection dialog box is displayed when data records are 
copied or deleted, 

• whether projects are optimized automatically when they are 
opened, 

• whether you are running Allplan Building Costs in a network. 

These default settings can be defined in the Adjustments dialog box. 

  

User-definable data sheet settings and column definitions 

Besides the default settings, you can also define various data sheet 
settings (font, columns, column sequence, column headers etc.) for 
the data sheets. You can save the settings in a custom scheme, so 
that you can open the data sheets with the settings best suited for 
your requirements right away. 

Besides these custom data sheet settings, each data sheet provides 
several free columns, which you can use as required. For example, 
you can create columns for a separate key number or a second set of 
long text (comments on items or the translation of long text into a 
different language). 

The settings for the data sheets are defined in the Scheme dialog 
box. 
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Mobile Working 
You can turn your Allplan Building Costs workstation into a "mobile 
workstation" by logging off from the network. The network is then 
no longer required for running Allplan Building Costs (you can use a 
notebook, for example). 

When you have finished your mobile session, log on and integrate 
the projects into the Allplan Building Costs database again. That’s 
all! 

  

Logging off from the network 

When logging off, you select the projects to be transferred to the 
"mobile workstation". 

You can specify whether the relevant projects can be edited in the 
network while you are away. Another alternative is to lock them. 

Other data such as addresses, reports etc. can also be transferred to 
the "mobile workstation". Please note that any changes you make to 
addresses or reports while you are working in a mobile manner 
cannot be transferred to the address database or report database in 
the network. 

  

Logging on to the network 

When you have finished your mobile session, all you need to do is 
log on again. 

Now you can integrate the projects you previously transferred to the 
"mobile workstation" in the database in the network. Finally, you 
can start Allplan Building Costs in network operation again and 
access all the data in the network. 
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Tendering 
The "Tendering" chapter deals in detail with all the topics pertinent 
to tendering using Allplan Building Costs. 

  

In particular, you will learn how to 

• Create files 

• Define item categories and item types 

• Set up files 

• Insert sketches in files 

• Calculate file quantities 

• Calculate the total costs of files or projects 

• Print files 

• Back up files 

  

 
 

Creating Files 
There are different ways of creating files in Allplan Building Costs. 
Files can be based on custom specification descriptions, master data 
(e.g. user-defined master catalogs or master files, predefined text 
such as sirAdos text) or on standard service catalogs. If you created 
files for a similar construction project some time ago, you could also 
copy the relevant project and then modify the specification 
descriptions. 

A combination of custom text and master text is usually used. In 
practice, users often copy items from similar projects. All the 
possibilities mentioned above can be combined as desired. 

When items in your files are associated with unit prices of other 
construction projects or with prices in master catalogs, Allplan 
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Building Costs offers the option to quickly draw up initial cost 
estimates for the relevant trade right from the outset. If you have 
already created files for all the trades, you can also calculate the 
costs for the entire project. 

  

 
 

Creating Files Based on Custom Text 

If no master text is available yet or if the tender is too specific to use 
predefined text, you can create a file based on custom text. Once the 
project is complete, you can copy the text you created from the file 
into a master directory and thus generate your own master text 
catalog. 

  

Creating folders 

The "Folder - Cost" level, which can be inserted between the project 
level and the file level in the hierarchy, allows you to refine the 
hierarchic structure of projects (e.g. taking into account various 
construction stages or components). 

It is not necessary to create a folder line. A structure consisting of 
trades and files is usually sufficient for small construction projects. 
In this case, you insert the file lines below the "Project - Cost" 
hierarchy. 

Important! 
If you want to tender different companies individual titles (in the 
case of tenders based on sections), you must use the "Folder - Cost" 
level for files and the "File - Total/End" level for titles. It is 
absolutely essential that you stick to this hierarchic structure. 
Otherwise, you cannot check quotations as this requires entire files! 

The elements that are directly subordinate to the ‘Folder’ level in the 
hierarchy are totalized in the ‘Folder’ line and the associated cost 
line. 

When you have created a folder, two new indented lines – the folder 
and the cost line - are displayed below the project line in the Type 
column. 
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Enter descriptive text (e.g. "Component 1") in the Short text column 
of the folder line and a sum name for this construction stage (e.g. 
"Total – component 1") in the Short text column of the cost line. 

Note: You can configure the program to transfer the contents of the 
short text line automatically to the first long text line (provided you 
have enabled the relevant option in the Settings tool on the Extras 
menu). 

  

Creating files 

Subsequent awarding procedures are based on files. A file is created 
for each trade in a project. The "File - Total/End" level cannot 
include any further files. A folder or project, on the other hand, can 
contain several files. Files are always subordinate to the project or 
folder line. 

Important! 
It is essential that you create files as tenderers can only be created 
for files (not possible for folders, titles or items)! Otherwise, you 
cannot check any quotations! 

The costs of the items that are directly subordinate to the ‘File’ level 
in the hierarchy are totalized in the ‘File’ line and the associated 
total/end line. 

When you have created a file, two new indented lines – the file and 
the total/end line - are displayed below the project or folder line in 
the Type column. 

Enter text (e.g. "Unfinished structure work") in the Short text 
column of the file line and a sum name for this trade (e.g. "Total – 
Unfinished structure work") in the Short text column of the 
total/end line. 

  

Create titles 

Titles refine a file’s structure and are usually used for service types. 
You can subordinate an unlimited number of titles of the same level 
in the hierarchy to a file. 

The "Title - Total/End" level can include any number of subordinate 
titles (for example, the "Masonry work" title can consist of the 
subordinate "Exterior walls", "Interior walls" etc. subtitles). 
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The elements that are directly subordinate to the relevant title in the 
hierarchy are totalized in the ‘Title’ line and the associated total/end 
line. 

When you have created a title, two new indented lines – the title and 
the total/end line - are displayed below the file line in the Type 
column. 

Enter the service type (e.g. "Earthwork title") in the Short text 
column of the title line and a sum name for this title (e.g. "Total – 
Earthwork title") in the Short text column of the total/end line. 

Note: To create subtitles for a title, place the insertion marker in the 
total/end line of the relevant title and repeat the steps above. 

  

Creating items 

Items are data records of the lowest level in the hierarchy. You 
cannot create any items that are subordinate to items. Consequently, 
items consist of one line only (an associated sum line does not 
exist!). 

The sections that follow explain how to turn "empty" items into 
specification descriptions. 

  

Creating comments 

Comments can be used to describe files, titles, subtitles and items 
more precisely. As with items, comments are data records of the 
lowest level in the hierarchy. You cannot create any comments that 
are subordinate to comments. 

To assign a comment to a title, place the insertion marker in the first 
item line of the relevant title. 

If this title does not contain any items, place the insertion marker in 
the title’s total/end line. To create a comment that precedes one or 
more items, place the insertion marker in the item line of the first 
item to which you want to assign this comment. 

Note: To add text notes to files, you can also define items as text 
items. This item category is used exclusively for purely "textual" 
files and must not be used within GAEB-compliant files (for details 
see "Assigning Categories and Types of Items in Compliance with 
GAEB Guidelines"). 
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Creating tenderer text supplements 

A tenderer text supplement is additional information on the long 
text (e.g. item number or finish definition) that the tenderer may be 
requested to provide in the quotation. Tenderer text supplements can 
be added to one or more items. 

  

Editing specification descriptions 

You have created a file with one or more titles containing one or 
more empty items to which text, dimensions, quantities etc. need to 
be assigned. If you want to perform initial cost calculations for the 
trade right from the outset, you need to enter estimated unit prices. 

If you are working with the DIN 276 optional module, it is advisable 
to define DIN 276 cost groups. 

  

 
 

Creating Files Based on Master Data 

Besides using custom text, you can also create files based on master 
data such as user-defined master text, predefined text (e.g. sirAdos 
text) or existing files. 

Creating files based on master data involves the following steps: 

• Open the data sheet containing the master data. 

• Display or select the prices that are to be copied to the new file 
and that are to serve as the basis for initial cost calculations. 

• Select the desired items in the master data. 

• Copy the selected items, including prices, to the new file. 
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Selecting Estimated Prices in the Master Catalog 

Data records saved as master data usually contain several price lines 
(e.g. items with several estimated prices in a master catalog). When 
you copy data records (e.g. items from a master catalog to a new 
file), Allplan Building Costs automatically copies a price for each 
data record. 

Prior to copying, you can specify which price is transferred to the 
new file using one of the following options: 

• To use the prices of a single tenderer, display the prices of this 
tenderer only. 

• To use the prices of two or more tenderers, display all the price 
lines and select the line with the price you want to use for each 
item. These can be price lines of different tenderers. 

Note: You can also copy the prices of one or more tenderers (e.g. the 
average prices of the MID tenderer) to an existing file later. Detailed 
information is provided in the "Cost Calculation" section. 

  

 
 

Selecting Data Records in Master Catalogs 

Allplan Building Costs allows you to copy entire folders, files and 
titles as well as individual items and comments quickly and easily. 
When creating files based on master data, this is very useful as you 
can select specification descriptions including prices and hierarchic 
structures from a master catalog and transfer this data to a new file 
in a single step. Start by selecting data records in the master catalog. 

If you know the item number or code text of the specification 
descriptions, you can also enter this information directly. 

Note: When you select entire levels in the hierarchy in a single step, 
only the prices of a single tenderer can be used for the individual 
levels in the hierarchy. To transfer the prices of different tenderers, 
you need to select the price lines individually. 
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Copying Data Records from the Master Catalog to a File 

The process of copying data records is easy: select the relevant data 
records, activate the tool you want to execute, place the insertion 
marker as you need in the new file and insert the data records there. 
You can also drag and drop the selected data records out of the 
master catalog into the new file. 

  

When you copy and insert folders, files, titles, items or comments, it 
is important that you take the hierarchic structure into account: 

 Project 

  Folder 

   File 

    Title  

     Comment 

     Item 

     Item 

     Item 

    Total/End Title 

   Total/End File 

  Cost Folder 

 Cost Project 

      

To copy a title to the end of a file, place the insertion marker in the 
file’s total/end line before you insert the title. When, for example, a 
copied title is to precede another title, place the insertion marker in 
the title line which is to be preceded by the new title prior to 
inserting. When inserting items, place the insertion marker on the 
item that is to follow the item to be inserted. 

Note: When you transfer specification descriptions from an existing 
file to a new file and copy data records without opening the dialog 
box for copying data, quantity calculations are automatically copied 
at the same time. If you do not want to transfer these quantity 
calculations to the new file, you need to copy the data records 
without quantity calculations using the dialog box for copying data 
records. Alternatively, delete the quantity calculations later. 
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Including quantity calculations in copy operations can be useful 
when you want to create an alternative or contingency item based 
on a "normal" item, for example. 

  

 
 

Creating Files Based on the StLB 

The standard service catalog (= StLB), which is issued by the German 
Institute of Standardization, is designed for describing any tasks 
related to construction work - ranging from the building process 
itself to maintenance and management of buildings and real estate. 

In Germany, the StLB is used especially for public tenders. 

Text in the standard service catalog consists of five parts. A number 
of variants is available for each part. These five text parts are 
structured hierarchically. Users can choose one of the variants 
presented on each of the five levels in the hierarchy. Each text 
variant in the standard service catalog includes a specific number. 

The advantage of the StLB is that it provides standard specification 
descriptions, which can be understood by everyone. A disadvantage, 
however, is that estimated prices cannot be entered. 

Note: Before you can create a file based on the StLB in Allplan 
Building Costs, you need to purchase the relevant service types from 
the Beuth Verlag in Germany and install them. 

  

Installing and deleting StLB service types 

The individual service types of the standard service catalog can be 
purchased on storage media from the Beuth Verlag in Germany. 

By installing the StLB, the files on the storage medium are imported 
to the hard disk and automatically converted to a data format that 
can be processed by Allplan Building Costs. 

You can delete service types you no longer require from the hard 
disk to free up disk space, for example. 

  

 



 

Integrated solutions  Tendering 79 
 

Printing StLB service types 

You can print the service types you have installed. The printout has 
the same layout as the original standard service catalog. 

  

Creating a file using the StLB 

Specification descriptions based on the StLB are defined using the 
Standard Service Catalog processing template. 

Some text parts in the StLB include additional text. Depending on 
the selected text part, there are three types of additional text: 

• Additional text which must be entered by the party issuing the 
invitation to tender. 

• Additional text which can be entered by the party issuing the 
invitation to tender; the tenderer must enter additional text if the 
party issuing the invitation to tender has not done this. 

• Additional text which must be entered by the tenderer. 

  

Editing specification descriptions based on the StLB 

Normally, you cannot edit specification descriptions you have 
created based on the StLB. In other words, you cannot modify short 
or long text, for example. However, you can convert individual StLB 
items to open text items, which are editable. In this case, the StLB 
code of the relevant item is deleted automatically and the additional 
text "Based on StLB no. ....." followed by the StLB number is added 
to the item’s long text. 

  

 
 

Creating Files Using STLB-Bau or DBD 

When you have purchased the "STLB-Bau Dynamische Baudaten" 
and/or "DBD Dynamische Kostenelemente" CD, you can also use the 
specification descriptions of these databases for Allplan Building 
Costs. To install this application, follow the instructions given by 
STLB-Bau. The CD includes the entire range of items provided by 
STLB-Bau. The data that is actually available to you depends on the 
license you have purchased. If you can access the demo data only, 
please contact the CD supplier. 
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Note: Before you work with "STLB-Bau Dynamische Baudaten" 
and/or "DBD Dynamische Kostenelemente", check that this 
application has been installed correctly. 

The "STLB-Bau Dynamische Baudaten" or "DBD Dynamische 
Kostenelemente" database can be accessed using the STLB-Bau 
Dynamische Baudaten / DBD - Dynamische Kostenelemente 
processing template which has been specially developed for this 
application. This processing template assists you in the process of 
creating and editing text. The data you set up in this application can 
be imported quickly and easily to Allplan Building Costs. 

You can use this processing template to create one or more items in 
a single step. The item text is transferred straight to the current data 
sheet and can be changed at any time. All you need to do is open the 
relevant processing template and modify the transferred item. 

Text that is still missing information can be completed automatically 
in this processing template without you having to start "STLB-Bau" 
and/or "DBD". In addition, this processing template allows you to 
check that text is complete and valid. 

Icon Use 

 You can use this tool to unlock an STLB-Bau item. The item is 
not a standard item any longer and can be edited freely (only 
available if the item is STLB-Bau text). 

 You can use this tool to create a new item based on STLB-Bau. 
Click OK to exit STLB-Bau. The new item is inserted below the 
current item. 

 You can use this tool to create several new items based on STLB-
Bau. Click OK in STLB-Bau to transfer text to Allplan Building 
Costs and select the next text you want to use. Click Cancel to 
exit STLB-Bau. The new items are inserted below the current 
item. 

 You can use this tool to modify the current item in STLB-Bau 
(only available if the item is STLB-Bau text). 

 You can use this tool to automatically complete the definition of 
an STLB-Bau item that is still missing information (only 
available if an STLB-Bau text is still incomplete). 

 You can use this tool to delete the current item. 

 You can use this tool to display the key number of a specific text 
(only available if the item is STLB-Bau text). 

Tip: Please consult the "STLB-
Bau Dynamische Baudaten" 
and "DBD Dynamische Kosten-
elemente" documentation for 
details. 
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The text of an STLB-Bau item is standard text. It cannot be modified. 
However, when tenders do not necessarily have to be based on StLB, 
you can customize this text by removing the write protection. 

When you have purchased "STLB-Bau mit Baupreisen", the unit 
prices calculated are transferred to Allplan Building Costs. 

  

 
 

Creating Files Using HeinzeBauOffice 

When you have purchased the BauOffice CD from Heinze, you can 
use the specification descriptions provided in this database for 
Allplan Building Costs. To install HeinzeBauOffice, follow the 
instructions given by Heinze. The CD includes the entire range of 
items provided by Heinze. The data that is actually available to you 
depends on the license you have purchased. If you can access the 
demo data only, please contact Heinze. 

Note: Before you can import Heinze specification descriptions, you 
have to install HeinzeBauOffice. 

You can activate HeinzeBauOffice straight from Allplan Building 
Costs using the HeinzeBauOffice processing template. The data you 
assemble in this application can be imported quickly and easily to 
Allplan Building Costs. The data, which is transferred via the GAEB 
interface, is entered in the open data sheet. 

  

Besides the buttons provided by all Allplan Building Costs processing 
templates (at the bottom left), the HeinzeBauOffice processing 
template includes the following additional tools: 

Icon Function Use 

 Create new item You can use this tool to create a new item. 

 Create master item You can use this tool to create a master item. 

 Create custom item You can use this tool to create a custom 
item. 

 Revise text of this item You can use this tool to modify the text of 
an item. 

 Research You can use this tool to research an item. 

Tip: Please consult the 
HeinzeBauOffice 
documentation for details. 
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Icon Function Use 

 Delete item You can use this tool to delete the current 
item. 

 Settings You can use this tool to make settings for 
interfacing with HeinzeBauOffice. 

   

  

Importing individual items straight from HeinzeBauOffice 

Items are always transferred to Allplan Building Costs. This applies 
regardless whether you create master or custom items. 

The difference is that you cannot specify the contents of long text in 
HeinzeBauOffice when you use master items. 

In the case of custom items, however, you can quickly and easily 
define the contents of the items yourself by selecting the relevant 
questions. 

You can also combine master and custom items. 

  

Options for HeinzeBauOffice 

To harness all the advantages provided by using HeinzeBauOffice in 
conjunction with Allplan Building Costs, the options need to be set 
correctly. This is done automatically when you install 
HeinzeBauOffice and then start Allplan Building Costs. However, if 
these settings have been modified, you need to correct them 
manually. 

  

 
 

Creating Files Using sirAdos Building Data 

When you have purchased sirAdos®-Baudaten, you can also use the 
sirAdos item and element catalogs for tendering in Allplan Building 
Costs. To do this, install sirAdos-Baudaten as described in the 
sirAdos/WEKA MEDIA installation instructions. 

Tip: Master items that have 
already been transferred to 
Allplan Building Costs can be 
edited at any time. 
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The data that is actually available to you depends on the license you 
have purchased. If you can access the demo data only, please contact 
sirAdos. 

  

 
 

Creating Master Text for Allplan Building Costs Based On 
sirAdos Building Data 

As opposed to previous versions of sirAdos Building Data (e.g. 
sirAdos-select), the latest the sirAdos Building Data CD does not 
contain any prepared MDI files with the complete trades. This way 
you can choose which trades and items you want to transfer and 
generate your own MDI files in sirAdos Building Data for data 
transfer to Allplan Building Costs. 

You can import the generated MDI files into Allplan Building Costs 
through the MDI interface and then create your own masters, 
element masters, files or element schedules based on this data. 

Note: As complex projects increase the computing time, it is 
advisable to define a maximum of 15 trades per master catalog. You 
should therefore spread master text among several master catalogs. 

  

 
 

Importing Individual Items from the sirAdos Building Data 
CD into Allplan Building Costs 

If you do not want to manage your own item masters with sirAdos 
text, you can use the sirAdos Building Data CD as a master. The 
advantage is that you need much less hard disk space and that you 
can immediately use the text provided on the CD without having to 
install it first (in the case of updates, for example). 

  

You can import one or more sirAdos items from one or more titles 
either into the buffer database or directly into your current file in 
Allplan Building Costs. The contents of the buffer database can be 
inserted anywhere into any project at any time (if the data types 
match). 
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The data can be pasted into a file at the position of the insertion 
marker or it can be sorted by code text number. In the latter case, 
the Calculation data sheet must be open. 

  

Two options are provided for importing data to files and to the 
buffer database: 

• sirAdos text is pasted at the position of the insertion marker 
(default) - requirement: the Sort after insertion option in the 
Settings dialog box must be deactivated. All the levels in the 
hierarchy (titles) are removed from the buffer. Irrespective of the 
sequence and trade from which it originates, text is always pasted 
at the current position of the insertion marker in the data sheet. 

• sirAdos text is sorted and inserted in a file - requirement: the 
Sort after insertion option in the Settings dialog box must be 
activated. With this method, it is important that you maintain the 
Codetext column as the items in a file are sorted by this column. 
Consequently, this method cannot be used with elements and 
masters without file lines. 

However, it is particularly useful when you create files using 
sirAdos text only. When the data is pasted in the data sheet, all 
the lines in the buffer are taken into account. Note, however, that 
only the lines whose code text numbers do not yet exist in the 
file are inserted. The lines to be inserted are sorted by code text 
number and added to the file accordingly. 

Important! 
Before you can import individual sirAdos items directly into Allplan 
Building Costs, you have to install the sirAdos Building Data CD and 
correctly configure the online interface between sirAdos and Allplan 
Building Costs. 

  

 
 

Creating Files Using a Bar-Code Reader 

You can use bar-code readers to quickly and easily create files based 
on sirAdos master text, for example. All you need to do is scan the 
bar-code label of an item using a bar-code reader and copy the 
selected specification descriptions to a project in a single step. That's 
all! 
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Note: Bar-code readers do not come with Allplan Building Costs. As 
they must be consistent with the bar-code labels used in 
specification descriptions, bar-code readers are usually distributed by 
the providers of tender text. 

  

Preparations for using bar-code readers 

Connect the bar-code reader or another suitable input device to your 
computer as described in the documentation provided by the 
manufacturer of the device. 

In addition, you need to install all the specification descriptions you 
want to select with the bar-code reader as a master catalog in 
Allplan Building Costs. 

  

Creating a file using the bar-code reader 

You can only create a file in this manner when all the specification 
descriptions you want to select using the bar-code reader are 
available as a master catalog in Allplan Building Costs. In addition, 
the specification descriptions including suitable bar-code labels must 
be available on paper. These requirements are met by sirAdos text, 
for example. 

  

 
 

Adding Specification Descriptions Using the BRUNS Plant Catalog 

General information 

You need to purchase a license in order to use plant catalogs in 
conjunction with Allplan Building Costs. Otherwise, the functions for 
editing plant catalogs are not available to you. 

The Allplan DVD includes the specification descriptions of the 
BRUNS Plant Catalog 2004/2005. This project, which has already 
been converted to Allplan Building Costs format, is located in the 
directory <dvd>\programs\Allplan 
BCM\Demodaten_Baukosten\Stämme on the CD and can be 
loaded using Allplan Building Costs’ archive administration. 
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Note: Updated versions of the BRUNS Plant Catalog (if any) can be 
obtained directly from BRUNS. How to import this data in Allplan 
Building Costs is described below in the "Importing the BRUNS Plant 
Catalog from floppy disk" section. 

  

Plant Disposition processing template 

Allplan Building Costs provides a special processing template for 
creating text using the BRUNS Plant Catalog: the Plant Disposition 
processing template. 

You can use this template to select plants and generate estimated 
prices for cost estimates. The master project called 
"BRUNS Plant Catalog" serves as the basis. 

Icon Function Use 

 Create new item You can use this tool to create a new item 
based on a specification description from the 
plant catalog. 

 Edit item You can use this tool to modify an item 
based on a specification description from the 
plant catalog. 

 Delete item You can use this tool to delete an item based 
on a specification description from the plant 
catalog. 

   

Important! 
Activate the Apply price check box to automatically transfer the 
unit price from the price list according to the quantity entered. 

  

Using the price list of the BRUNS Plant Catalog 

The BRUNS Plant Catalog contains a price list with prices for all the 
plants including quantity discounts (the discounts allowed vary 
depending on the selected plant). 

Allplan Building Costs automatically recalculates the prices in the 
processing template when you change the quantity. When you have 
activated the Apply price check box, the unit price is copied from 
the price list, taking quantity discounts into account. When the 
Apply price check box is deactivated, you enter the price directly. 
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As quantity data can also be entered using quantity takeoff 
operations or via the CAD interface, for example, you can update the 
prices and quantity discounts in the processing template for all the 
plants selected from the BRUNS Plant Catalog. 

  

Data exchange between Allplan and Allplan Building Costs 

In order for the data exchange between Allplan and Allplan Building 
Costs to run smoothly, the two programs must use the same master 
data. The master data provided by Allplan Building Costs is managed 
as a material catalog in Allplan. The essential data field is the Code 
text column. 

If Allplan and Allplan Building Costs are installed on the same 
computer or if the Allplan data directory is shared on the network, 
you can enter the destination path directly. 

Note: More detailed information on exchanging data between 
Allplan and Allplan Building Costs is provided in the chapter entitled 
"Quantity Takeoff Operations using Graphics". 

  

Importing the BRUNS Plant Catalog from floppy disk 

Updated versions of the BRUNS Plant Catalog (if any) can be 
obtained directly from BRUNS. Before you can create tenders in 
Allplan Building Costs using these up-to-date specification 
descriptions, which you are given on a floppy disk, this data needs to 
be imported into Allplan Building Costs as a master project. 

The BRUNS Plant Catalog is provided as a self-extracting EXE file. 
Copy the BRUNS catalog file to a temporary directory on your hard 
disk or network and unpack it by executing the file. Once the plant 
catalog has been imported in Allplan Building Costs, you can delete 
the temporary directory, including the BRUNS catalog file. 

Note: The catalog file requires approx. 30 MB, the Allplan Building 
Costs master project that is created requires 60 MB of free hard disk 
space. Before you start unpacking or importing the catalog file, make 
sure that you have enough free hard disk space. 
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Adding Specification Descriptions using GreenBASE Plant Disposition 

General information 

You need to purchase a license in order to use plant catalogs in 
conjunction with Allplan Building Costs. Otherwise, the functions for 
editing plant catalogs are not available to you. 

When you have purchased the GreenBASE Plant Disposition CD from 
GreenX, you can also use these plant lists for Allplan Building Costs. 
To install GreenBASE Plant Disposition, follow the instructions given 
by GreenX. The data that is actually available to you depends on the 
license you have purchased. If you can access the demo data only, 
please contact GreenX. 

There are two ways to use the GreenBASE Plant Disposition 
application: 

• You can create a catalog containing the plants you selected 
(including quality and price details). You can then use this 
catalog as a master catalog for creating tenders in Allplan 
Building Costs or you can export it as a material catalog to 
Allplan. 

• While creating files in Allplan Building Costs, you can directly 
access the GreenBASE Plant Disposition application, select plants 
in its extensive database and paste these plants into a file (see the 
section entitled "Transferring GreenBASE plants directly to 
projects"). 

  

Plant Disposition processing template 

Allplan Building Costs provides a special processing template for 
creating text using GreenBASE Plant Disposition: the Plant 
Disposition processing template. 

You can use this template to select plants and generate estimated 
prices for cost estimates. The master project called 
"GreenBASE Plant List" serves as the basis. 
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Icon Function Use 

 Create new item You can use this tool to create a new item 
based on a specification description from the 
plant catalog. 

 Edit item You can use this tool to modify an item 
based on a specification description from the 
plant catalog. 

 Delete item You can use this tool to delete an item based 
on a specification description from the plant 
catalog. 

   

Important! 
Activate the Apply price check box to transfer the unit price from 
the price list automatically, according to the quantity entered. 

  

Using the price list of GreenBASE Plant Disposition 

The GreenBASE plant catalog contains a price list with prices for all 
the plants including quantity discounts (the discounts allowed vary 
depending on the selected plant). 

Allplan Building Costs automatically recalculates the prices in the 
processing template when you change the quantity. When you have 
activated the Apply price check box, the unit price is copied from 
the price list, taking quantity discounts into account. When the 
Apply price check box is deactivated, you enter the price directly. 

As quantity data can also be entered using quantity takeoff 
operations or via the CAD interface, for example, you can update the 
prices and quantity discounts in the processing template for all the 
plants selected from the plant catalog. 

  

Data exchange between Allplan and Allplan Building Costs 

In order for the data exchange between Allplan and Allplan Building 
Costs to run smoothly, the two programs must use the same master 
data. The master data provided by Allplan Building Costs is managed 
as a material catalog in Allplan. The essential data field is the Code 
text column. 
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If Allplan and Allplan Building Costs are installed on the same 
computer or if the Allplan data directory is shared on the network, 
you can enter the destination path directly. 

Note: For more detailed information on exchanging data between 
Allplan and Allplan Building Costs, please consult the manual 
entitled "Quantity Takeoff Operations using Graphics". 

  

Transferring GreenBASE plants directly to projects 

When you do not manage your own plant master with all the 
GreenBASE plants, you can use GreenBASE Plant Disposition as a 
master catalog. For this, you can import individual plants from 
GreenBASE directly into the current projects. 

The advantage of this is that you require not so much hard disk 
space and that you can immediately use the text provided on the CD 
without having to install it first (in the case of updates, for example). 

You can copy one or more plants straight to the current file. The 
selected plants are inserted where the insertion marker is located in 
the file. 

If the plant items created in the file have been generated including 
BRUNS price details, you can assign the relevant quantity-based unit 
prices to the items by using the Plant Disposition processing 
template. For details, see the section entitled "Update the Price List 
According to the GreenBASE Plant Catalog". 

Note: Before you can import GreenBASE plants, you have to install 
the GreenBASE CD. 
 

Create Files Based on CAD Data 

When you have created a three-dimensional building in Allplan and 
used the specification descriptions prepared by Allplan Building 
Costs to define the materials of the components, you can create a 
special Allplan Building Costs schedule including the item quantities 
calculated during quantity takeoff operations. 

This quantities schedule is transferred to Allplan Building Costs and, 
based on the code text, the quantities specified in this schedule are 
associated with the specification descriptions of Allplan Building 
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Costs. As you go along, the files/element schedules created in this 
manner can be evaluated and edited according to various criteria. 

Note: A detailed description is provided in the section entitled 
"Importing Quantity Takeoff Schedules into Allplan Building Costs 
(see "Importing Allplan Quantity Takeoff Schedules into Allplan 
Building Costs" on page 215)". 

 
 

Create Files Based on Element or Room Schedules 

When element and/or component calculations are performed, several 
items of different trades are used to calculate elements that represent 
entire components. A possible element, for example, would be an 
interior wall consisting of masonry, plaster, wallpaper, paint and 
baseboard. 

Using these elements, Allplan Building Costs creates a project-
specific element schedule, which can then serve as a basis for 
automatic generation of trade-specific files. In other words, when an 
element schedule is used to create a file, the items of different trades 
of an element are written to the relevant trades in accordance with 
the structure of the master data. 

Note: A brief description of generating files based on element 
schedules is provided in the section entitled "Creating a CAD Item 
Catalog (Master File) Based on an Element Catalog". 

 

 
 

Defining Item Categories and Item Types 
Files often contain not only normal items, which are added up, but 
also other item categories and types: alternative items, for example, 
replace normal items. If needed, contingency items may be added in 
case special services are required. A basic item is a normal item with 
one or more alternatives. In printouts, text items are larger than 
other items as they do not contain any prices or quantities. You can 
also use the 'Text' item category to give preliminary notes a 
hierarchical structure, for example. 
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The calculation results of files vary depending on the item categories 
used. For example, normal, requirement and basic items are taken 
into account when the total price is calculated. Contingency and 
alternative items, on the other hand, are excluded. You can combine 
these categories with item types. By defining reference items and 
repetitive items, you can create cross-references between items. 

As categories and types of items can be reset and redefined at any 
time, you can quickly and easily calculate a number of variants 
when drawing up initial cost estimates or checking quotations. 

The categories and types of items are defined in the Properties of 
(name of item) dialog box. 

Note: When you want to exchange GAEB-format files with design 
partners, you have to take into account the special conditions for 
defining categories and types of items. For detailed information, 
please see "Exchanging Data via the GAEB Interface". 

  

You can enter the item categories most commonly used in practice 
directly in the Type column: 

• Alternative item 

• Requirement item 

• Contingency item 

• Basic item 

• Normal item 

• Text item 

If these item categories do not meet your requirements, you can also 
use the Properties of (name of item) dialog box to define items. 

  

Points to bear in mind when defining categories and types of items: 

• Basic item associated with alternative item – a basic item must 
be defined for each alternative item! One or more alternative 
items must be assigned to each basic item. These assignments are 
made using assignment numbers. 
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• Reference item associated with repetitive item – a repetitive item 
requires a reference item whose item number has to be entered as 
the reference. 

• Implementation description associated with repetitive item – an 
item relating to an implementation description requires an 
implementation description whose number has to be entered as 
the reference. 

• Main description and sub-description – main descriptions 
always require sub-descriptions and vice versa. When files are set 
up, sub-descriptions have to be assigned consecutive, two-digit 
values in ascending order starting with 01. 

• Special notes on DA82 – items without total prices cannot be 
exported. Basic items are treated as normal items. Open tenderer 
quantities have to be specified. 

• Requirement and contingency items are mutually exclusive in 
files. 

• Comments – text supplements to be entered by tenderers cannot 
be added to comments. 

• Quantity and dimension – quantities and dimensions have to be 
specified for items. 

  

 
 

Setting up Files 
Files can basically be organized and structured to suit your own 
needs and requirements. Allplan Building Costs provides an easy-to-
use algorithm that sets up files and automatically assigns item 
numbers according to your settings. How this is done is described in 
the section entitled "Setting up Standard Files". 

When you want to exchange GAEB-format files with design 
partners, however, the files have to be set up in compliance with the 
GAEB guidelines. The requirements that must be met as well as the 
options offered by Allplan Building Costs are described in the section 
entitled "Setting up Files in Compliance with GAEB Guidelines (on 
page 99)". 
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Setting up Standard Files 

You can set up files manually by entering item numbers in the Item 
no. column of the data sheet. But it is much easier to use Allplan 
Building Costs’ automatic algorithm. 

In automatic mode you can choose to set up files 

• by applying a logical structure, 

• by using consecutive numbers or 

• in compliance with GAEB guidelines. 

  

In addition, you can specify whether file, title and/or item lines are 
to be set up, define the values at which the operation is to start and 
decide which fillers and separators are to be used. 

  

The data line in which the insertion marker is currently placed and 
all the associated, subordinate data records in the hierarchy can be 
set up in a single step. When, for example, the insertion marker is in 
a file line, this line and all the subordinate titles, items and/or 
comments can be set up. To set up an entire project including all the 
subordinate files, you need to place the insertion marker in the 
project line. 

Note: When you want to exchange GAEB-format files with design 
partners, you have to take into account the special conditions for 
assigning item numbers. Detailed information is provided in the 
"Exchanging Data via the GAEB Interface" chapter. See the section 
entitled "Setting up Files in Compliance with GAEB Guidelines (on 
page 99)". 

You can set up files as often as you want; the results are always 
displayed immediately. This way, you can quickly and easily test a 
wide range of options of structuring files by combining the different 
criteria and thus find the setting best suited for your purpose. 

  

  

The examples that follow illustrate some basic options for 
structuring your files. 



 

Integrated solutions  Tendering 95 
 

Example 1: 

In the first example, the default setting was used. The insertion 
marker was placed in the project line before setting up the file: 

  

Using these settings ... 

 

  

… the result might look like this: 
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Example 2: 

In the next example, the width of format was set to three characters 
and "0" was selected for the filler; the text "R / 013." is to be applied 
to the title "Concrete and R.C. works". The insertion marker was 
placed in this title line before setting up the file: 
 
Using these settings ... 

 

 
… the result might look like this: 
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Example 3: 

In this example, a standard numeration was entered that is to apply 
to items only; the width of format was set to five characters and "0" 
was selected for the filler so that up to 99,999 items can be 
numbered using a consistent logical system; no separator was 
specified. The insertion marker was placed in the file line before 
setting up the file: 

  

Using these settings ... 

 

  

… the result might look like this: 
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Example 4: 

In the fourth example, the file was set up using the GAEB 
numeration suggested by Allplan Building Costs. To set up a file in 
this manner, you have to place the insertion marker in the file line 
(required by GAEB guidelines). You can then click the Suggestion 
button to use Allplan Building Costs’ suggestions: 

  

Using these settings ... 

 

  

… the result might look like this: 
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Setting up Files in Compliance with GAEB Guidelines 

Files you want to exchange via the GAEB interface have to be set up 
in compliance with GAEB guidelines. The "Set up files in GAEB 
format" feature lets you set up files quickly and easily. 

Allplan Building Costs automatically creates a key for ordinal 
numbering (= ON key), which you can accept or modify (even at a 
later stage). Based on the format of this ON key, Allplan Building 
Costs then sets up the entire file in ascending order. 

  

The ON key, which consists of a maximum of nine digits, defines the 
format of the item numbers to be assigned. The characters of the ON 
key represent the number of digits for the individual levels in the 
hierarchy, the items and the item index. 

For example, the "1122PPPPI" ON key creates the following item 
number: "01.22.  12a". "01" is the number of the first title in the 
hierarchy, "22" is the number of the second title, "  12" is the item 
number and "a" the item index. 

Note: The item index is not used in Allplan Building Costs. 

The result might look like this: 
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Important! 
Comments and the ‘Sub-description’ and ‘Execution description’ item 
categories are not set up automatically. You can use the "Change 
item category" tool to assign consecutive numbers to these item 
categories when defining them. 

  

 
 

Add Images and Sketches 
Allplan Building Costs allows you to integrate objects in order to 
touch up your files. This way, you can enhance simple text by 
adding graphics or even acoustic elements – making things a lot 
clearer! These objects can be images or, depending on your 
hardware, audio elements or videos. In practice, however, images are 
most commonly used. 

The "Basic Introduction" chapter provides detailed information on 
"Object Fields and Object Windows" and describes the process of 
"Inserting Objects in Object Windows". 

When you copy specification descriptions from master text where 
sketches have already been inserted, these sketches are automatically 
included in the copy operations. 

When you select an appropriate report, the objects integrated in a 
file are included in printouts. 
 

Determining File Quantities for Tenders 
Your file contains the specification descriptions, the definition of the 
item categories and the item numbers. All that is still missing in the 
tender is the file quantities. 

There are basically two ways to enter quantities in files. You can 

• specify quantities by direct entry in the Quantity column 
(individual quantities cannot be determined; quantities cannot be 
split) or 
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• calculate quantities using quantity calculations (individual 
quantities are easy to determine; quantities can be split). 

Which method is to be preferred depends on various aspects: 
entering quantities directly is easier, but usually only suitable for 
small construction projects and only if the quantities do not have to 
be split up. 

The initially more complex method of using individual quantity 
calculations is preferable when you transfer the item quantities from 
several different components or when you want to split quantities, 
i.e. if the quantities used are to be allocated to various construction 
projects or clients. To assist you in defining and using quantity 
calculations, Allplan Building Costs offers a processing template as 
well as the possibility to enter custom calculations, REB formulas 
and variables. 

Note: More detailed information on calculating quantities is 
provided in the "Conventional Quantity Takeoff Operations" chapter. 

 

 
 

Calculate the Total Costs of Files or Projects 
You have created and set up the file, and calculated the file 
quantities. When all items of the file have been assigned estimated 
prices, you can already perform initial calculations to determine the 
estimated total costs of the file or entire project. This is the case, for 
example, when you have created the file based on master text or a 
master file and transferred the specification descriptions together 
with the associated prices. 

Note: If no prices have been assigned, you need to enter them before 
you can calculate the costs. How this is done is described in the 
chapter entitled "Calculating Costs", in the "Cost Calculation" 
section. 

  

 
 

Tip: When choosing the 
method, spend some time 
thinking ahead: how do you 
want to determine the 
quantities in subsequent 
phases of the project? One 
advantage of quantity 
calculations is that they can 
be used throughout the 
project, from setting up the 
file all the way through to 
invoicing. 
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Printing Files 
You have created the file and calculated the file quantities. All you 
need to do now before dispatching the file is print it. 

  

Note: More detailed information on printing and alternative output 
options (e.g. output to MS Word or output in RTF, HTML or PDF 
format) is provided in the section entitled "Printing Files, Cost and 
Quantity Calculations". 

  

Important! 
To add a cover sheet to a file, you need both the project data (e.g. 
name of client, project name etc.) and the file data. Please make sure 
that this data is complete. Where this data needs to be entered is 
described in detail in the "Data for the File Cover Sheet" section. 

  

 
 

Back up Files 
Printing and dispatching a file marks the end of the first stage in 
editing files. At this point in time, at the latest, you should create a 
backup of the project. not only to be able to restore it in case of data 
loss, but also to document the file contents at the different phases of 
the construction project. Allplan Building Costs' Archive 
Administration tool therefore offers quick and easy backup options. 

More detailed information is provided in the "Backing Up Data and 
Archiving Projects" chapter. See the section entitled "Backing up and 
Archiving Projects Using the Archive Administration Tool". 
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Tendering Procedure Using 
the Tenderer Module 

Today, information is increasingly exchanged electronically. To meet 
the requirements of modern data exchange technology, Allplan 
Building Costs provides options for sending electronic files to 
tenderers. 

In addition to the file, you can include a program that the tenderer 
can use to edit the file: Allplan's program for editing quotations. This 
has the advantage that the tenderers to whom you send files do not 
need any additional software. The only requirement is a computer 
with at least Microsoft Windows 2000 or Microsoft Windows XP. 

To perform analyses and evaluations, you can quickly and easily 
transfer the prices specified by the tenderers straight to the 
Quotation check data sheet and compare the prices there. 

  

In this chapter, you will learn how to create files that are ready to 
send in electronic form. In particular, this chapter shows how to 

• create a file in BDF format (see "Creating a BDF File" on page 
103), 

• load a file for editing quotations (see "Loading Files for Editing 
Quotations" on page 107), 

• prepare a quotation (see "Editing Quotations" on page 108) using 
Allplan's program for editing quotations, and 

• transfer prices specified by tenderers (see "Transferring Prices for 
Checking Proposals" on page 108) to the Quotation check data 
sheet. 

  

 
 

Tip: You can of course make 
the files available to 
tenderers in all standard 
ways, e.g. as a download from 
your web site or by email. 
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Creating a BDF File 
Allplan Building Costs automatically creates a file in BDF format 
that you can transmit directly to the tenderers. You can optionally 
also create Allplan's program for editing quotations, which the 
tenderer can then use to edit the file and enter prices. 

  

 
 

Allplan's Program for Editing Quotations 
After you have opened a file, the application window of Allplan's 
program for editing quotations looks like this: 

  

 

  

The menu bar and toolbar are displayed below the title bar of the 
application window. The tables below briefly introduce the tools that 
are provided on the menus and in the toolbar. 
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Note: It is assumed that a file is open. Otherwise the Datei (File) 
menu, for example, will only provide the Öffnen (Open) and 
Beenden (Exit) tools. 

The file in table form and two windows for entering text are 
displayed in the middle of the application window. You can adapt 
the application window to your needs and requirements. For 
example, you can modify the width of the columns or change the 
height of the segments. 

  

  

The Datei (File) menu includes tools that you need to open, save and 
print quotations: 

Tool Use 

Öffnen (Open) You can use this tool to open files in BDF format 
(used by Allplan's program for editing 
quotations) or DA 83 format (in compliance with 
GAEB). 

Speichern (Save) You can use this tool to save edited files. 

Seitenansicht (Preview) You can use this tool to add data to be included 
in printouts and to display a print preview on 
screen. 

Drucken (Print) You can use this tool to print out files. 

Beenden (Exit) You can use this tool to exit Allplan's program 
for editing quotations. 

  

The Bearbeiten (Edit) menu contains tools for editing files: 

Tool Use 

Rückgängig (Undo) You can use this tool to undo the last action. 

Ausschneiden (Cut) You can use this tool to copy the characters you 
have selected to the Clipboard. This process 
deletes the selected characters from the data 
entry box. 

Kopieren (Copy) You can use this tool to copy the characters you 
have selected to the Clipboard. This process does 
not delete the selected characters from the data 
entry box. 
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Tool Use 

Einfügen (Paste) You can use this tool to paste the characters 
from the Clipboard to the current position of the 
insertion marker. 

  

The Projekt (Project) menu contains tools that you need for working 
in data sheets: 

Tool Use 

Alles berechnen 
(Calculate everything) 

You can use this tool to calculate the total prices 
of the current quotation. 

Informationen zum LV 
(Information on file) 

You can use this tool to make settings (tenderer 
name, currency, VAT) that are valid for the 
entire file. 

  

You can use the tools on the Ansicht (View) menu to define how the 
toolbar and the status bar are displayed: 

Tool Use 

Symbolleiste (Toolbar) You can use this tool to show and hide the 
toolbar. 

Statusleiste (Status bar) You can use this tool to show and hide the 
status bar. 

  

You can use the tools on the ? (= Help) menu to get information on 
Allplan's program for editing quotations and answers on questions 
of usage: 

Tool Use 

Hilfe (Help) You can use this tool to get help on Allplan's 
program for editing quotations. 

Info über Bdisk (About 
Bdisk) 

You can use this tool to display information on 
the program and version installed. 

You can use the buttons provided in the toolbar to activate the main 
tools without having to select a menu first. 
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Icon Tool Use 

 Projekt öffnen (Open 
project) 

You can use this tool to execute the Öffnen 
command on the Datei menu. 

 Projekt speichern (Save 
project) 

You can use this tool to execute the Speichern 
command on the Datei menu. 

 Projekt berechnen 
(Calculate project) 

You can use this tool to execute the Alles 
berechnen command on the Projekt menu. 

 Verzeichnisinformatione
n bearbeiten (Edit file 
information) 

You can use this tool to execute the Informatio-
nen zum LV command on the Projekt menu. 

 Seitenansicht 
einblenden (Open 
preview) 

You can use this tool to execute the Seitenansicht 
command on the Datei menu. 

 Projektdaten drucken 
(Print project data) 

You can use this tool to execute the Drucken 
command on the Datei menu. 

 Online-Hilfe aufrufen 
(Online help) 

You can use this tool to execute the Hilfe 
command on the Hilfe menu. 

   

 

 
 

Loading Files for Editing Quotations 
Files provided in the tenderer module’s BDF format are edited using 
Allplan's program for editing quotations. You can also use the 
program to edit files created by other applications for tendering, 
awarding and invoicing, provided the file has been stored in DA 83 
format (file extension .D83) in compliance with GAEB guidelines. 

You start Allplan's program for editing quotations via the 
BDISK.EXE file. This file is generated whenever a BDF file is 
created with the Tenderer module option enabled (see "Create a BDF 
File"). 
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Editing Quotations 
To edit tenders, open the relevant file using Allplan's program for 
editing quotations and enter data in the file displayed in table form 
in the application window. As certain data in the file must not be 
changed, you can only make entries in the fields where the program 
expects you to enter data. 

In file and title lines, you can only enter VAT and additional fees 
and/or deductions as a percentage. The program then calculates and 
includes these values in all the subordinate items in the hierarchy. 
This operation has to be confirmed in a dialog box. The entry you 
have made in the title or file line is subsequently deleted. 

BDF-format files can be saved at any time. This way, you can quit 
editing files as you want. To resume work, all you need to do is start 
Allplan's program for editing quotations and load the file you have 
saved (as described in the section entitled "Open a File in BDF 
Format for Editing"). 

When editing files in GAEB format of data type 83 (DA 83), 
however, any changes to the files must be saved in DA 84 format. To 
resume work, you need to load the file in DA 83 format again. The 
file then includes the changes you have made (cf. section entitled 
"Open a GAEB-Compliant File in DA 83 Format for Editing"). 

When you have finished, you can print out the file for checking. 

Important! 
Before you (or the tenderer) print(s) out or send(s) a quotation, make 
sure to recalculate it. Otherwise, it might happen that the current 
values and totals are not applied! 

 
 

Transferring Prices for Checking Proposals 
To perform analyses and evaluations, you can transfer the prices 
from the tenderer disk(s) straight to the Proposal Check data sheet 
and immediately compare the prices there. You do not need to copy 
the prices manually from the proposal to the data sheet first. 
 



 

Integrated solutions  Exchanging Data via the GAEB Interface 109 
 

Exchanging Data via the 
GAEB Interface 

Different software systems impose ever-increasing demands on data 
exchange. As a result, there has been a call for a standardized 
format, which simplifies the process of exchanging data used for 
tendering (contractual agreements, text, quantities, prices). 

In November 1985, the first version of a standardized exchange 
format was introduced by the German committee for electronics in 
the construction industry (= GAEB). This standard was revised in 
June 1990 and in January 1997. Today the GAEB XML-format is 
commonly used. 

Allplan Building Costs’ GAEB interface is based on the standard 
specified by the German committee for electronics in the 
construction industry. This standard controls the exchange of data 
between tendering and costing applications of different providers. 

  

This chapter provides detailed information on all the questions 
pertaining to the GAEB interface. In addition, you will learn about 
everything related to the exchange of data in GAEB format. In 
particular, this chapter shows how to 

• create files in compliance with the GAEB guidelines, 

• assign item categories in a GAEB-compliant manner, 

• set up files in compliance with the GAEB guidelines (see "Setting 
up Files in Compliance with GAEB Guidelines" on page 99), 

• add comments and technical contract conditions, 

• enter additional information on files (on page 118), 

• export data via the GAEB interface and 

• import data via the GAEB interface. 
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Special Feature Relevant to Exchanging 
Data via GAEB 90 

Files in GAEB 90 format are pure text files in ASCII format. 
Consequently, it can happen that Windows formatting applied to 
text (tabs, for example) is lost. 
 

Data Exchange Phases in Compliance with 
GAEB 

In compliance with GAEB the process of exchanging data consists of 
six phases (also referred to as "data types"), which are defined as 
follows: 

Data type Phase 

DA 81 Transfer of file: exchange of specification 
descriptions without prices 

DA 82 Transfer of estimated costs: exchange between 
client – architect – engineer during the design 
process 

DA 83 Invitation to tender: transfer of file to tenderer 

DA 84 Submission of quotation: transfer of quotation 
(including prices, quantities etc.) from tenderer 
to architect 

DA 85 Additional quotation: transfer of alternative 
data in addition to the main quotation 

DA 86 Awarding: transfer of file including the checked 
tender data to the tenderer who is awarded the 
contract (contractor) 
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The following illustrates the relationship between the phases: 

Client    Contractor 

 
Engineer 

    

 
    

Transfer of file: 
DA 81 / DA 82 

  or   

    

 
    

 

Architect 

 Invitation  
to tender: 

DA 83 

  or   

 
 

Tenderer 

 

 

    Preparation of 
quotation 

 

     

 

Architect 

 

 

 Submission of 
quotation: 

DA 84 

  or   

 

 
 

Tenderer 

Quotation 
check 

 

        

     

 

Architect 

 Awarding: 
DA 86 

  or   

 
 

Contractor 
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Creating Files in Compliance with GAEB 
Guidelines 

Allplan Building Costs allows you to customize the structure of your 
projects to suit your own needs and requirements. But there are other 
applications used for tendering, ordering and billing that cannot 
process these structures. 

If you want to transfer data to other applications via the GAEB 
interface, it is worth spending some time planning a project’s 
structure before even making the first entry to ensure that the 
destination program can interpret the selected structure. 

  

Special attention should be paid to the following issues: 

• Files must be structured in compliance with GAEB. 

• Some applications used for tendering, ordering and billing can 
process two hierarchical levels maximum. 

• All the items must be on the same level in the hierarchy. 

• Files must be set up in compliance with GAEB. 

• Additional information on files must be entered correctly. 

  

If you do not know which settings can be processed by the 
destination program, you should structure projects based on the 
guidelines given below. The project suggested is structured in 
compliance with GAEB and can be read by all applications used for 
tendering, ordering and billing that have a certified GAEB interface. 

Note: These are only suggestions – try out different options yourself! 

  

 
 

Structuring Files in Compliance with GAEB Guidelines 

The process of exchanging data using the GAEB format is based on 
file structures. This means that individual files and text are 
transferred rather than entire projects. It is therefore important that 
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you create at least one file line in projects you want to transfer via 
the GAEB interface. 

  

A file structure might look like this: 

 
  

 
 

Assigning Categories and Types of Items in Compliance with GAEB 
Guidelines 

The following item categories can be used without restrictions in 
GAEB-compliant files: 

• Normal item, 

• Basic item, 

• Alternative item, 

• Requirement item, 

• Contingency item, 

• Inapplicable item 

and 

• Work for hourly wage. 
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Similarly, you can use the following item types without restrictions: 

• Normal item, 

• Main description, 

• Sub-description, 

• Start of execution description  

and 

• Block of execution description. 

  

Please pay careful attention to the following special features: 

• Do not use the item categories TextComment or TextItem within 
files; use the Comment data record type only! The TextComment 
and TextItem item categories are used exclusively for pure "text 
files" (e.g."comments and technical contract conditions"). 

• Requirement and contingency items are mutually exclusive in 
files. 

• When data is exchanged based on DA 82, items without total 
quantities must not be exported (i.e. no alternative or 
contingency items). Basic items are treated as normal items. 
Tenderer quantities must be specified as estimated quantities. 

  

In addition, the basic rules for defining item categories and types 
apply. 

Note: For a detailed description of item categories and types, please 
see the section entitled "Defining Item Categories and Item Types" in 
the "Tendering" chapter. 

  

 
 

Setting up Files in Compliance with GAEB Guidelines 

Files you want to exchange via the GAEB interface have to be set up 
in compliance with GAEB guidelines. The "Set up files in GAEB 
format" feature lets you set up files quickly and easily. 
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Allplan Building Costs automatically creates a key for ordinal 
numbering (= ON key), which you can accept or modify (even at a 
later stage). Based on the format of this ON key, Allplan Building 
Costs then sets up the entire file in ascending order. 

  

The ON key, which consists of a maximum of nine digits, defines the 
format of the item numbers to be assigned. The characters of the ON 
key represent the number of digits for the individual levels in the 
hierarchy, the items and the item index. 

For example, the "1122PPPPI" ON key creates the following item 
number: "01.22.  12a". "01" is the number of the first title in the 
hierarchy, "22" is the number of the second title, "  12" is the item 
number and "a" the item index. 

Note: The item index is not used in Allplan Building Costs. 

The result might look like this: 

  

 
  

Important! 
Comments and the ‘Sub-description’ and ‘Execution description’ item 
categories are not set up automatically. You can use the "Change 
item category" tool to assign consecutive numbers to these item 
categories when defining them. 
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GAEB-Compliant Units of Quantity 

Allplan Building Costs checks the entered quantity units to verify 
that they are commonly used and comply with the notation 
according to STLB-Bau. If you use a different quantity unit or 
notation/spelling, Allplan Building Costs indicates this when 
checking the file for compliance with GAEB guidelines (cf. "Checking 
Files (see "Checking Files" on page 118)"). This does not mean that 
your entry is incorrect, but rather that you may need to clarify the 
quantity unit with the persons you will be exchanging the data with. 

Important! 
Units of quantity can consist of a maximum of four characters. 

The following units of quantity are commonly used in GAEB-
compliant files: 

Unit Meaning 

d Day 

dam3 Cubic decameter (1000m³) 

h Hour 

Jr Year 

kg Kilogram 

km Kilometer 

km2 Square kilometer 

l Liter 

m Meter 

m2 or m² Square meter 

m3 or m³ Cubic meter 

Mt Month 

psch Lump sum 

St Piece 

t Ton 

Wo Week 

md Meters x days 

mWo Meters x weeks 
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Unit Meaning 

mMt Meters x months 

m2d Square meters x days 

m2Wo Square meters x weeks 

m2Mt Square meters x months 

m3d Cubic meters x days 

m3Wo Cubic meters x weeks 

m3Mt Cubic meters x months 

m3km Cubic meters x kilometers 

Sth Pieces x hours 

Std Pieces x days 

StWo Pieces x weeks 

StMt Pieces x months 

St/M Pieces per month 

St/J Pieces per year 

tMt Tons x months 

  

 
 

Comments and Technical Contract Conditions 

You can also exchange comments and additional contractual 
agreements (e.g. technical contract conditions) via the GAEB 90 
interface. All you need to do is integrate them as text files in GAEB 
files before and/or after the file they are associated with. 

Allplan Building Costs generates the term "Start of contractual 
agreement" for every text line and text comment line. Similarly, 
"Text of contractual agreement" is assigned to long text entered in 
text windows using memo fields. Consequently, the text sum line is 
the "End of contractual agreement". 
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The result might look like this: 

 
  

 
 

Additional Information on Files 

Additional information on files (such as "information on the project" 
or "information on the client") cannot be displayed directly in the 
file structure. 

You can use the Properties of (name of file) dialog box to enter 
additional information in an easy and comfortable manner, thus 
avoiding wrong entries. 

Note: You can enter additional information for each file even when 
a project consisting of several files is to be exported in its entirety. 

  

 
 

Checking Files 

Before you export files via the GAEB interface, you should check 
that these files actually meet the requirements imposed by the GAEB 
guidelines. 
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A log indicates whether errors have been detected. You might see the 
following messages: 

• When this message is displayed, the file complies with the GAEB 
guidelines and can be exported. 

 

• When this message appears, the file contains errors. Correct the 
error causes indicated in the log and check the file again. 

 

  

 
 

Exporting Files to GAEB Files 
There are two ways to export files to GAEB files: 

• You can export a single file to a GAEB-format file by placing the 
insertion marker in the file line of the relevant file before you 
start the export. 

• You can export several files (e.g. file with text file) to a GAEB-
format file by placing the insertion marker in the folder/project 
line of the level in the hierarchy that is superordinate to the 
relevant files. 

Note: When exporting files with contractual agreements (= file with 
text file), make sure that the insertion marker is positioned correctly: 
to export a file including contractual agreements to a GAEB-format 
file in a single step, you need to place the insertion marker in the 
superordinate folder/project line. To add a file (e.g. a text file) to a 
file that has already been exported to a GAEB file, you need to 
position the insertion marker in the relevant file line. 
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Options for GAEB export 

Advanced settings are available for exporting data to GAEB-format 
files. You can use the GAEB Options tab in the Properties of (name 
of file) dialog box to make these settings, which can vary depending 
on the GAEB phase. 

Allplan Building Costs provides a number of special settings for 
exporting data to GAEB 90-format files. 

  

 
 

Importing GAEB Files 
GAEB-format files can be imported into Allplan Building Costs via 
the GAEB interface. Imported files can be inserted in existing 
projects or in new projects you create during import. 

Note: To import prices from proposals in DA 84 format, you have to 
take into account the special features that are described in the 
section that follows. 

  

 
 

Importing Prices from DA 84-Format Files 
GAEB-format files of data type 84 (= proposal delivery) contain 
additional data that is created by tenderers only. Consequently, when 
you import GAEB files in the DA 84 format, Allplan Building Costs 
does not create a complete structure. Rather, the data (prices, 
quantities, additional text etc.) the tenderer has entered in the GAEB 
file is added to the existing file structure (= file in an existing 
project). 

Before the GAEB data is actually imported, Allplan Building Costs 
scans the current project for the file in the GAEB file. The search 
criterion is the short text of the file. When the file is found in the 
project (otherwise, the GAEB data is not imported correctly), Allplan 
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Building Costs displays all the tenderers created for this file. The data 
in the GAEB file can then be copied to an existing or new tenderer. 

If Allplan Building Costs does not find the file (in this case, the file 
has changed in the meantime), you can select a file to which the 
prices are to be copied. 

During import, Allplan Building Costs checks that the data (i.e. item 
numbers, item categories, prices, quantities, additional text etc.) is 
consistent and complete. If errors are detected, a log is generated. In 
this case, the file has changed in the meantime. Consequently, the 
proposal is invalid! 
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Calculating Costs in 
Compliance with DIN 276 

You can use the "DIN 276 – Cost Calculations" module to classify the 
costs of a construction project in compliance with the DIN 276 cost 
groups at any stage of a project – a process encompassing cost 
estimates, cost calculations, calculations of final costs, invoicing and 
cost control. 

Allplan Building Costs comes with a predefined project including the 
(new) DIN 276 cost classification, which is easy to install using 
Allplan Building Costs’ archive administration (cf. "Installing the DIN 
276 Cost Classification "). The DIN 276 classification is copied to the 
project directory and can then be modified. 

You can use the DIN 276 cost estimates to determine the estimated 
total costs of a project by assigning quantities and costs to the 
relevant cost groups (cf. "Cost Estimates Based on the DIN 276 Cost 
Classification"). In addition, you can estimate costs based on element 
or room schedules or by using the BKI construction cost database 
(see "DIN 276-Compliant Cost Estimates Based on BKI Construction 
Cost Database" on page 128). 

Cost calculations in compliance with DIN 276, Costs after 
awarding in compliance with DIN 276 and Final costs in 
compliance with DIN 276, on the other hand, are based on existing 
data. In these phases, the items, which were previously sorted by 
trade, are now sorted by DIN 276 cost group. 

DIN 276 Cost control operations allow you to set up all cost-related 
processes in a single data sheet. In addition, Allplan Building Costs 
offers a wide number of options for analyzing, evaluating and 
graphically displaying data. 

Different types of reports are available in all phases: neutral 
printouts or DIN 276-compliant forms. 

  

 
 



 

124 Calculating Costs in Compliance with DIN 276 Allplan BCM   

DIN 276-Compliant Cost Estimates 
Allplan Building Costs allows you to draw up cost estimates. In 
particular, you can 

• assign quantities and costs to DIN 276 cost groups 

• analyze and evaluate existing element or room schedules 

• load an object of comparison from the BKI construction cost 
database and add estimated quantities This function is only 
available when you have purchased the "BKI Baukosten 2000" 
CD. 

  

 
 

Cost Estimates Based on the DIN 276 Cost Classification 

This approach is particularly useful when you do not create an 
element or room schedule or when a suitable object of comparison is 
not available. 

To estimate costs based on the DIN 276 cost classification, you need 
to create a new project first. Then open this project in the DIN 276 
Estimation data sheet and copy the DIN 276 cost groups from the 
‘DIN 276 CLASSIFICATION’ project. If this project is not listed in the 
project selection box, install it as described in the section entitled 
"Installing the DIN 276 Cost Classification". 

  

Copying the DIN 276 classification 

You can copy the cost classification in its entirety or just parts of it. 

For example, if you merely need cost group 3 (= building structure), 
you can copy exactly this part of the classification to the project. If 
you want to use the main DIN 276 cost groups (i.e. cost groups 1 to 
7), simply copy these levels to the project. 

However, it usually makes sense to copy the entire DIN 276 cost 
classification right from the beginning as you will need the detailed 
classification later in subsequent phases anyway. 
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Note: Allplan Building Costs automatically ignores "empty" DIN 276 
classification levels (i.e. lines without quantity, UP and TP entries) 
when printing. To make sure that all the necessary levels are 
available, it is therefore advisable to always copy the entire 
classification. 

In addition, you can add your own levels to the DIN 276 cost 
classification you have copied. 

Important! 
If you want to determine estimated total costs for the individual 
cost/main cost groups as well as for the entire construction project, a 
DIN 276 project line must exist in the DIN 276 Estimation data 
sheet. If you have not copied such a line from the ‘DIN 276 
CLASSIFICATION’ project, you need to add it: create a classification 
point and delete the entry in the DIN 276 column. 

You only need to create a classification for every project once. The 
classification is retained and can be used for all subsequent phases. 

  

Assigning estimated prices and quantities to DIN 276 cost 
groups 

Next, you can assign estimated costs to the appropriate levels. All 
you need to do is enter values in the Quantity and UP columns.  

To obtain the sums for the individual cost groups and the estimated 
total costs of the entire project, you have to calculate the project in 
its entirety . Allplan Building Costs uses the estimated prices you 
have entered to calculate the total prices, which are characterized by 
the ‘Calculated’ entry in the Price memo column. Allplan Building 
Costs then adds up the total prices of the subordinate hierarchies to 
determine the total prices of the superordinate hierarchies, which are 
indicated by the ‘Totalized’ entry. 
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Entries in the Price memo column of the DIN 276 estimation data 
sheet: 

Entry Meaning 

Calculated The total price entered in the TP checked or 
TP grs column is the product of the estimated 
price in the UP column and the estimated 
quantity in the Quantity column. 

Totalized The total price entered in the TP checked or 
TP grs column is the sum of the prices of the 
subordinate hierarchy/hierarchies. 

Note: When you previously entered an estimated price and quantity 
for a hierarchy and assigned the ‘Calculated’ property to these 
estimated values, they are automatically set to ‘Totalized’ when you 
enter estimated prices for subordinate levels and re-calculate the 
project. This operation will replace the estimated price and quantity 
previously entered with the actual total values. 

The estimated total of the project is displayed in the top line, that is, 
the DIN 276 project line (= line without entry). 

Allplan Building Costs offers various reports for printing DIN 276-
compliant cost estimates. 

Note: Instead of drawing up cost estimates from scratch each time, 
just copy the cost estimates of an existing project and adjust the 
quantities and prices, if necessary. Then select the Calculate 
everything new tool and Allplan Building Costs automatically 
determines the new estimated sum. 

  

 
 

DIN 276-Compliant Cost Estimates Based on Element or Room Schedules 

You can quickly and easily draw up cost estimates in compliance 
with DIN 276 based on element or room schedules you have already 
created for a construction project. The only requirement is that the 
ordinal numbers of the cost groups are entered for the elements’ 
items in the DIN 276 column of the Element Schedule data sheet 
and that the current estimated quantities and prices are assigned to 
all the items. 
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As opposed to cost estimates based on the DIN 276 structure 
described above, all the items of the element/room schedule are 
displayed automatically in the DIN 276 Estimation data sheet. You 
do not need to enter estimated prices and quantities as the sums of 
the cost groups are obtained from the prices calculated for the items. 

All the items are sorted by ordinal number in ascending order in the 
DIN 276 Estimation data sheet for the element/room schedule. The 
DIN 276 levels, on the other hand, are not included. 

You can now copy either individual DIN 276 cost groups or the 
entire cost structure from the ‘DIN 276 STRUCTURE’ project to your 
project. If the ‘DIN 276 STRUCTURE’ project is not listed in the 
project selection box, install it as described in the section entitled 
"Installing the DIN 276 Cost Structure". 

When you copy the entire cost structure, all the cost groups are 
available. Consequently, a sum is determined for each cost group on 
each level. This means that sums for the cost groups 1 to 7, sums for 
the cost groups 31, 32 etc., for example, and sums for the bottom 
level (e.g. 311, 312, 313 etc.) are determined. 

The remainder of the procedure is analogous to the one for cost 
estimates based on the DIN 276 cost structure. 

Note: Before triggering calculations, check that the cost structure is 
sorted correctly. The following section lists possible errors: 

• You have not changed the entry "0" in the DIN 276 column. 
Consequently, the relevant data records have been inserted at the 
top of the data sheet or below the project line. 

• Ordinal numbers of items do not end with underscore characters 
("_") or other characters defined as additional sorting criteria. 
Consequently, ordinal numbers are in the same hierarchy as the 
cost group that is actually superordinate. 

• Due to incorrect ordinal numbers, data records are assigned to 
wrong cost groups. 

Correct the entry in the DIN 276 column. The element/room schedule 
will update automatically to reflect the changes you have made. 
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DIN 276-Compliant Cost Estimates Based on BKI Construction Cost 
Database 

In its information center for construction costs (BKI), the German 
Association of Architects has assembled a comprehensive database of 
key building characteristics based on the invoicing data of about 
1,600 construction projects. You can access these characteristics 
straight from Allplan Building Costs and use them in conjunction 
with the values you have defined yourself. This way, you can quickly 
and easily draw up DIN 276-compliant cost estimates for cost groups 
300 and 400. 

To use the BKI construction cost database for DIN 276-compliant 
cost estimates, you need to obtain the "BKI KOSTENplaner" 
application. 

Allplan Building Costs provides an interface to the BKI database 
through which you can transfer the cost estimates from the BKI 
construction cost index to your own DIN 276-compliant cost 
estimates in Allplan Building Costs. The BKI toolbar includes all the 
required tools. 

The BKI toolbar also provides the tools BKI -> Version 1.0, 1.1 and 
BKI -> Version 2.0 which allow you to use earlier BKI versions (if 
necessary or useful). 

Note: As not all users will need this functionality, the BKI toolbar is 
not installed automatically. To use the tools on this toolbar, you need 
to install it separately. 

  

 
 

DIN 276-Compliant Cost Calculation 
Based on drafts that are to scale and qualitative building 
descriptions, cost calculations are performed at the stage of 
designing. The level of detail you choose depends on the available 
cost data, amongst others. If detailed data is provided, you can even 
calculate the costs of individual tasks. 

Allplan Building Costs performs cost calculations based on a 
project’s files (including estimated prices and quantities). 
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Items in files are sorted by trade (i.e. item number). When costs are 
calculated in compliance with DIN 276, Allplan Building Costs does 
little more than rearrange all the items in a project so that they are 
sorted by the entry in the DIN 276 column. All the hierarchies like 
file lines, title lines etc. are ignored. 

  

Calculating costs in compliance with DIN 276 only involves a few 
steps: 

• open the DIN 276 Calculation data sheet 

• copy the DIN 276 cost classification (if you have not already 
done so when you drew up cost estimates in compliance with DIN 
276) 

• determine the sums 

• print out the results 

  

To ensure that everything runs smoothly, be sure to note the 
following: 

• The level of detail increases the more files are available in a 
project. 

• The items in the files must include the DIN 276 cost group 
numbers in the DIN 276 column of the data sheet. 
 
The cost group number of an item can consist of a maximum of 
nine digits plus one character (e.g. an underscore or the value 
"0") which is defined as an additional sorting criterion and which 
has to appear after the last digit. For example, the cost group 
numbers of items which are to be subordinate to cost group 331 
can be "331_" or "3310". 

• Estimated prices must be entered in the UP column and quantities 
in the Quantity column. 

  

 



 

130 Calculating Costs in Compliance with DIN 276 Allplan BCM   

Open the DIN 276 Calculation data sheet. All the items in the file(s) 
of the project are sorted by cost group number: 

 

  

Next, copy the DIN 276 cost classification to the data sheet. 

When you have drawn up cost estimates in compliance with DIN 
276, the cost groups you have used already exist in the project. If 
necessary, you can add the missing cost groups. 

Important! 
Do not make multiple copies of the cost classification. Otherwise, the 
data sheet will contain several instances of the cost classification. 

If you have already done so, you can select and delete the redundant 
cost DIN 276 lines. 

Note: To delete a large number of cost groups, you can apply a filter 
in order to limit the display to DIN 276 lines only. You can then 
select all the lines and delete them. If necessary, you can copy the 
cost groups again. 
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The next step is to calculate the sums of the DIN 276 cost groups. 
The result is the cost calculation. 

 

  

 
 

Costs after Awarding in Compliance with 
DIN 276 

When you have finished planning a project’s execution, you can 
calculate the costs after awarding, based on the price calculations 
provided by the tenderers. 

The DIN 276-compliant calculations of the costs after awarding in 
Allplan Building Costs are therefore based on the data provided in 
the awarded contract. 
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As with DIN 276-compliant cost calculations, Allplan Building Costs 
does little more than rearrange data – here, it’s the data specified by 
the tenderers in the Awarding data sheet – and determine the sums 
of the superordinate cost groups. 

Be sure to note the following: 

• The prices specified by the tenderers are only taken into account 
when you have already created all the relevant tenderers to be 
awarded the contract. Otherwise, this data sheet does not contain 
any prices or quantities. 

• The items in the files must include the DIN 276 cost group 
numbers in the DIN 276 column of the data sheet. 

Open the DIN 276 Awarding data sheet. All the items in the project’s 
file(s) are sorted by cost group number. 

The remainder of the procedure is analogous to the one for cost 
calculations in compliance with DIN 276. 

  

 
 

Final Costs in Compliance with DIN 276 
Upon completion of a project, you can calculate the final costs and 
prepare cost sheets, which serve to document costs. 

In Allplan Building Costs, calculations of the final costs in 
compliance with DIN 276 are based on the data in the Invoicing data 
sheet. 

As with DIN 276-compliant cost calculations, Allplan Building Costs 
does little more than rearrange data – here, it’s the data in the 
Invoicing data sheet – and determine the sums of the superordinate 
cost groups. 

Be sure to note the following: 

• Requirements: you must have created all the tenderers for 
invoicing and entered the actual quantities. Otherwise, this data 
sheet does not contain any prices or quantities. 

• The items in the files must include the DIN 276 cost group 
numbers in the DIN 276 column of the data sheet. 
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Open the DIN 276 Invoicing data sheet. All the "invoicing items" in 
the project are sorted by cost group number. 

The remainder of the procedure is analogous to the one for cost 
calculations in compliance with DIN 276. 

  

 
 

Cost Control in Compliance with DIN 276 
Cost control operations involve comparing the current cost situation 
with the costs determined at an earlier point in time. This way, you 
can detect any differences at an early stage and take appropriate 
counter measures. 

Allplan Building Costs compares the individual phases and highlights 
any differences it comes across. 

Based on the data in the Calculation, Awarding and Invoicing data 
sheets, Allplan Building Costs checks costs in the DIN 276 cost 
control data sheet. The program thus uses the same data as described 
in the "Cost Control" section of the "Customized Cost Calculations" 
chapter, but sorts them by DIN 276 cost group numbers. 

The table below lists the values that are displayed in the individual 
phases: 

Cost estimates: Calculated values 

Cost calculations: File quantity x estimated price 

Costs after awarding: File quantity x tenderer price 

Calculations of final costs: Quantity used x tenderer price 

  

In the DIN 276 Cost control data sheet, all four phases (cost 
estimates, cost calculations, costs after awarding and costs for 
invoicing) are displayed. If you want to compare specific phases only 
(for example, cost calculations with costs for invoicing), all you need 
to do is select the relevant lines. 

Besides selecting tenderers in the DIN 276 Cost control data sheet, 
you can also compare prices graphically using charts. 
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In addition, Allplan Building Costs offers a convenient approach for 
comparing costs on a percentage basis. This way, you can quickly 
and easily check whether costs are exceeded, for example. 

Open the DIN 276 Cost control data sheet. All the items in the 
project are sorted by cost group number: 

  

 

  

If there is a DIN 276-compliant cost estimate with the same project 
no., this phase and all its estimated sums are also displayed. 
However, estimated prices are only displayed for DIN 276 levels as 
item-specific costs are not included in cost estimates. 

The values calculated are displayed in the % Phase comparison 
column: If the value is less than 100, the costs/quantities have been 
fallen below. If the value is greater than 100, the costs/quantities 
have been exceeded. 

Important! 
The % Phase comparison column is only updated when you select 
the Price comparison tool. The Calculate everything new tool has 
no effect on this column. Therefore, remember to execute the Price 
comparison tool whenever you change any data or settings. 

  

 
 



 

Integrated solutions  Customized Cost Calculations 135 
 

Customized Cost 
Calculations 

It is not always necessary to calculate costs in compliance with 
DIN 276. There are times when you will find that this approach is 
not suitable for cost estimates either. 

In addition to DIN 276-compliant approaches, Allplan Building Costs 
offers you more methods for estimating and checking costs. For 
example, you can draw up initial cost estimates in a trade-specific 
manner and then perform detailed cost estimation operations using 
your own custom cost groups. Or, for example, you distribute an 
existing budget onto individual cost groups on a percentage basis 
and thus obtain initial cost estimates. 

Furthermore, cost checking operations based on items and trades are 
generally more useful than DIN 276-compliant cost control 
procedures. 

  

 
 

Estimating Costs Based on Custom 
Calculations 

Cost estimates based on custom calculations are performed using the 
same tools as for DIN 276-compliant cost estimation operations. 
These customized calculations are also performed in the 
DIN 276 Estimation data sheet, which has specially been designed 
for all types of projects and which can be used in conjunction with a 
variety of methods for estimating costs. 

This data sheet allows you to draw up cost estimates based on a 
freely definable cost structure, which can be refined later. You can 
also distribute an existing budget onto individual cost groups on a 
percentage basis. 
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Important! 
A sophisticated cost structure is particularly important for all cost 
estimation operations. 

  

Points to bear in mind when setting up the cost structure: 

• The sequence of the lines in the data sheet is defined by the 
numbers you specify. After you have entered the cost number or 
calculated the total sums, Allplan Building Costs automatically 
places the lines correctly in the data sheet (see example). Please 
note: numbers followed by letters and single-digit numbers 
followed by multi-digit numbers. 

• In addition, the numbers define the hierarchic structure. The 
DIN 276 entry in the Type column indicates a cost group’s level 
in the hierarchy. The further an entry is on the right, the lower its 
level in the hierarchy. The hierarchic level of a cost group is 
defined by its number of characters (see example: the cost group 
012345 represents the lowest level in the hierarchy). 

• The numbers also define which lines are Totalized lines and 
which lines are Calculated lines. Superordinate items are always 
‘Totalized’ lines (see example: 1, 10, 100, 6, A, B) and subordinate 
items are always ‘Calculated’ lines (see example: 1000, 1001, 
1002, 1003, 101, 61, A1, A2, AA, B1, B2). If a superordinate item 
does not contain any subordinate items, these lines are also 
‘Calculated’ lines (see example: 012345, 7, C). 

In other words, you define your own hierarchy by setting up a 
custom structure that suits your needs. However, don’t forget to 
create a superordinate level. Otherwise, Allplan Building Costs fails 
to calculate a total sum for the cost estimation (see example: line 
without entry in ‘DIN 276’ column). 

  

Cost group numbers can consist of a maximum of 9 characters 
(numbers and/or letters). Numbers less than 0 are not permitted; 
there is no differentiation between uppercase and lowercase. Cost 
group numbers must not include any special characters and blanks. 
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Estimating Costs Based on Custom Cost Structures 

Start by defining a rough structure, which will serve as the basis for 
subsequent cost estimation operations. 

Now you can refine the rough structure by adding subgroups to each 
main group. This way, you obtain more detailed results for each 
phase. 

  

When estimating the costs, Allplan Building Costs calculates the 
total prices of the lowest cost groups. Consequently, these prices are 
characterized by the 'Calculated' entry, which is displayed in the 
Price memo column. Allplan Building Costs then adds up the total 
prices of the subordinate hierarchies to determine the total prices of 
the superordinate hierarchies. These prices are characterized by the 
‘Totalized’ entry. 

Entries in the Price memo column of the DIN 276 Estimation data 
sheet: 

Entry Meaning 

Calculated The total price entered in the TP checked or 
TP grs column is the product of the estimated 
price in the UP column and the estimated 
quantity in the Quantity column. 

Totalized The total price entered in the TP checked or 
TP grs column is the sum of the prices of the 
subordinate hierarchy/hierarchies. 

  

Tip: For initial cost estimates, 
you should use ordinal 
numbers of the same level in 
the hierarchy (e.g. 1, 2, 3 etc. 
or A,B,C etc.). 
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Note: When you previously entered an estimated price and quantity 
for a hierarchy and assigned the ‘Calculated’ property to these 
estimated values, they are automatically set to ‘Totalized’ when you 
enter estimated prices for subordinate levels and re-calculate the 
project. This operation will replace the estimated price and quantity 
previously entered with the actual total values. 

  

The total sum of the cost estimation is displayed in the TP column in 
the line at the top. Check that you have actually created this sum 
line. If there is no entry in the ‘DIN 276‘ column, the line in question 
is interpreted as the total sum. 

You can delete individual lines. Place the insertion marker in the line 
you want to remove or select several lines. Then click Delete on the 
Data Record menu. 

Check that all the ‘Calculated’ lines actually include quantities. If 
you want to use flat-rate amounts, enter ‘1’ for the quantities. 

The total price is the product of the quantity multiplied by unit price. 
You can also enter the total sum instead of the UP. In this case, 
Allplan Building Costs calculates the unit price based on the total 
price divided by the quantity. 

  

 
 

Estimating Costs by Distributing Costs on a Percentage Basis 

Another option for estimating costs is provided by the 
DIN 276 estimation data sheet. You can calculate the percentage 
instead of ‘Quantity x UP’. This allows you to distribute the costs of 
a project, for which a specific budget is available, on a percentage 
basis. 

  

Example: Fees = 10% of the total project costs amounting to EUR 
500,000 

Enter the percentage in the Quantity column. A percent symbol ‘%’ 
must be displayed in the Dimension column. Otherwise, this line is 
not calculated as a percentage. Enter the total project costs in the UP 
column. Allplan Building Costs then calculates the total price TP 
automatically. 

Tip: It is a good idea to use 
this option as follows: enter 
the area [m2] or volume [m3] 
in the quantity column and 
Allplan Building Costs will 
automatically calculate the 
price per m2 or m3 and display 
the result in the UP column. 
This entry has no effect on 
the sums determined in cost 
estimation operations. 
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Quantity Dim UP TP 

10 % 500,000 50,000 

 

Besides drawing up detailed cost estimates, you can also use this 
option to calculate individual lines only. But you can also calculate 
the entire cost estimate in this way.  

  

 
 

Estimating Costs by Copying Data 

You can quickly estimate costs by copying data from existing cost 
estimates or a master project.  

All you need to do is check the calculations and, if necessary, add 
missing lines. Don’t forget to recalculate the sums! 

Tip: This approach allows you to copy data from different projects. It 
is also possible to transfer cost groups from the master project called 
"DIN 276 Structure" to custom cost estimates. 

But you can also combine your own custom structures in a "master 
project" you create yourself. 

  

 
 

Modifying Estimated Prices on a Percentage Basis 

When you copy data from other projects, the calculations are also 
copied at the same time. You need to check and, if necessary, modify 
the prices and quantities you have copied. You can modify the prices 
on a percentage basis or specify additional fees and discounts as a 
percentage. 

The following options are available: 

• 1st option: modify the unit prices expressed as a percentage. 
This causes the unit prices in the UP column to change. After this 
operation, they cannot be reset to their original values. 
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• 2nd option: specify additional fees and discounts as a 
percentage. 
A percentage is entered in the % +/- column. The unit and total 
prices remain unchanged. The modified sum is displayed in the 
TP eff. column (= effective total price). 
 
When entering additional fees and/or discounts, you can benefit 
from some of the advantages provided by Allplan Building Costs: 

- When you enter an additional fee or discount for a 
superordinate level in the hierarchy, Allplan Building Costs 
automatically applies this percentage to all the subordinate 
levels. 

- After having calculated the total sum, Allplan Building Costs 
displays the average percentage in the line at the top. 

  

 
 

Checking Costs Based on Trades 
Cost control operations involve comparing the current cost situation 
with the costs determined at an earlier point in time. This way, you 
can detect any differences at an early stage and take appropriate 
counter measures. 

Allplan Building Costs compares the individual phases and highlights 
any differences it comes across. 

The table below lists the values that are displayed in the individual 
phases: 

Cost calculations: File quantity x estimated price 

Costs after awarding: File quantity x tenderer price 

Calculations of final costs: Quantity used x tenderer price 

  

Based on the data in the Calculation, Awarding and Invoicing data 
sheets, Allplan Building Costs checks costs in the Cost control data 
sheet. 
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When you open the data sheet, the three phases in which costs are 
determined (cost calculations, costs after awarding and costs for 
invoicing) are displayed. If you want to compare specific phases only 
(for example, cost calculations with costs for invoicing), all you need 
to do is select the relevant lines. 

Besides selecting tenderers in the Cost control data sheet, you can 
also compare prices graphically using charts. 

Allplan Building Costs offers a convenient approach for comparing 
costs on a percentage basis. This way, you can quickly and easily 
check whether costs are exceeded, for example. 

The values calculated are displayed in the % Phase comparison 
column: If the value is less than 100, the costs/quantities have been 
fallen below. If the value is greater than 100, the costs/quantities 
have been exceeded. 

Important! 
The % Phase comparison column is only updated when you select 
the Price comparison tool. The Calculate everything new tool has 
no effect on this column. Therefore, remember to execute the Price 
comparison tool whenever you change any data or settings. 
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Cost Calculation Based on 
Element Method 

Using the options provided by Allplan Building Costs, you can 
quickly and easily determine the costs for a building. 

Elements consist of several items of different trades and represent an 
entire component. A possible element, for example, would be an 
interior wall consisting of masonry, plaster, wallpaper, paint and 
baseboard. If you want, you can add further items (from the fields of 
electrical installations and sanitary facilities) to this element. These 
items are integrated in the element using an "estimated" factor based 
on experience, for example. 

A distinction is made between element masters, element catalogs and 
element schedules. Masters and catalogs are master directories of 
elements. Element schedules are project-specific element directories. 

Elements should be generated based on items provided in the master 
directories. This means that the current prices can be copied from 
master files to element masters or schedules. 

Element schedules can be converted to (trade-specific) files and thus 
serve as the basis for tendering. In addition, DIN 276-compliant cost 
estimation operations can be based on element schedules. 

When designing using the CAD system (e.g. Allplan), you can assign 
elements to components and transfer this data to Allplan Building 
Costs via the interface. You can then edit this data in Allplan 
Building Costs. 

  

Element masters and element catalogs 

Element masters and element catalogs are project-independent 
master directories of components and serve as the basis for project-
specific element schedules. 

It is a good idea to sort element catalogs by logical groups, 
facilitating quick access to the elements. Possible element masters, 
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that is to say different directories in the hierarchy, would be exterior 
walls, interior walls, slabs etc., for example. 

  

Element schedules 

Element schedules are project-specific directories of components. It is 
advisable to create elements in element schedules based on the items 
provided in the master directories. This way, you can copy the 
current prices from the master data to the element schedules. 

Important! 
Files can only be generated from a finished element schedule if you 
have used the items from a master directory to create elements. 

Elements in element schedules are created in the same way as 
elements in the element master. 

It is advisable to use the elements provided in element masters as the 
basis for the generation of element schedules. 

  

 
 

Creating an Element Catalog 
If you have already created an element schedule for a similar 
construction project, you can copy this element schedule and modify 
the elements as you need. 

However, the common approach is to create a new element 
schedule/master based on elements you combine from items 
provided in the master file or elements you copy from other element 
catalogs. Start by creating a new element schedule/master in the 
project database. 
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Opening the "Element Master" or "Element 
Schedule" Data Sheet 

You have created a new element master or element schedule and, if 
necessary, made entries in the memo columns. Now you need to 
open the element master/schedule in the relevant data sheet so that 
you can further edit it. 

If you have not yet created any elements for the element 
master/schedule, the data sheet only includes two lines: the project 
line and the cost line. 

The "Project - Cost" combination opens the hierarchy in each 
calculation data sheet. All the other levels in the hierarchy (element, 
sub-element and item) are delimited by this combination, which 
exists just once in each calculation data sheet. 

The data records that are subordinate to the project level in the 
hierarchy are totalized both in the project line and in the cost line. 

  

 
 

Creating the Structure of an Element 
Catalog 

To structure an element master or element schedule, start by defining 
the basic structure using elements and sub-elements. Then add the 
relevant items for each element. 

  

Creating elements 

The "element" level is the first level in the hierarchic structure. 

The sub-elements and/or items that are directly subordinate to the 
‘Element’ level in the hierarchy are totalized in the ‘Element’ line 
and the associated cost line. 
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When you create the first element, two new indented lines – the 
element line and the total/end line - are displayed below the project 
line in the Type column. 

Enter descriptive text (e.g. "Brick wall, 24 cm") in the Short text 
column of the element line and a sum name for this assembly (e.g. 
"Total – brick wall, 24 cm") in the Short text column of the cost line. 

Note: You can configure the program to transfer the contents of the 
short text line automatically to the first long text line (provided you 
have enabled the relevant option in the Settings tool on the Extras 
menu). 

  

Creating sub-elements 

You can further subdivide an element by combining parts of a 
component in sub-elements. In other words, an element can consist 
of one or more sub-elements, which in turn consist of several items. 

 Element 

  Item  
  Item  
  Item  
  Item  
  (Sub-)element 
   Item 
   Item 
   Item 
   Item 
  Total (sub-)element 
  (Sub-)element 
   Item 
   Item 
   Item 
  Total (sub-)element 
 Total/end element 

 

This is an example of a hierarchic structure. A structure of this type 
can be very useful when it comes to calculating elements. You can 
use it, for example, to quickly calculate different variants for a 
specific part of a component within the element. 



 

Integrated solutions  Cost Calculation Based on Element Method 147 
 

Note: More detailed information is provided later in the section 
entitled "Defining item categories and item types". 

The items that are directly subordinate to the "Sub-"‘Element’ level 
in the hierarchy are totalized in the "Sub-"‘Element’ line and the 
associated total/end line. 

When you create the first sub-element, two new indented lines – the 
sub-element line and the total/end line – are displayed below the 
element line in the Type column. 

Enter descriptive text (e.g. "Interior plaster, wallpaper") in the Short 
text column of the sub-element line and a sum name for this 
element (e.g. "Total – interior plaster, wallpaper") in the Short text 
column of the cost line. 

Note: Here, too, you can have the program transfer the contents of 
the short text line automatically to the first long text line (provided 
you have enabled the relevant option in the Settings tool on the 
Extras menu). 

  

 
 

Obtaining Elements from Items 
If there are not yet any items available in the master data, it is often 
necessary to create elements based on items. You can then copy the 
item text you have created to the master data of your files. 

  

 
 

Creating the Structure of an Element Catalog 

To structure an element master or element schedule, start by defining 
the basic structure using elements and sub-elements. Then add the 
relevant items for each element. 
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Creating elements 

The "element" level is the first level in the hierarchic structure. 

The sub-elements and/or items that are directly subordinate to the 
‘Element’ level in the hierarchy are totalized in the ‘Element’ line 
and the associated cost line. 

When you create the first element, two new indented lines – the 
element line and the total/end line - are displayed below the project 
line in the Type column. 

Enter descriptive text (e.g. "Brick wall, 24 cm") in the Short text 
column of the element line and a sum name for this assembly (e.g. 
"Total – brick wall, 24 cm") in the Short text column of the cost line. 

Note: You can configure the program to transfer the contents of the 
short text line automatically to the first long text line (provided you 
have enabled the relevant option in the Settings tool on the Extras 
menu). 

  

Creating sub-elements 

You can further subdivide an element by combining parts of a 
component in sub-elements. In other words, an element can consist 
of one or more sub-elements, which in turn consist of several items. 

 Element 
  Item  
  Item  
  Item  
  Item  
  (Sub-)element 
   Item 
   Item 
   Item 
   Item 
  Total (sub-)element 
  (Sub-)element 
   Item 
   Item 
   Item 
  Total (sub-)element 
 Total/end element 
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This is an example of a hierarchic structure. A structure of this type 
can be very useful when it comes to calculating elements. You can 
use it, for example, to quickly calculate different variants for a 
specific part of a component within the element. 

Note: More detailed information is provided later in the section 
entitled "Defining item categories and item types". 

The items that are directly subordinate to the "Sub-"‘Element’ level 
in the hierarchy are totalized in the "Sub-"‘Element’ line and the 
associated total/end line. 

When you create the first sub-element, two new indented lines – the 
sub-element line and the total/end line – are displayed below the 
element line in the Type column. 

Enter descriptive text (e.g. "Interior plaster, wallpaper") in the Short 
text column of the sub-element line and a sum name for this 
element (e.g. "Total – interior plaster, wallpaper") in the Short text 
column of the cost line. 

Note: Here, too, you can have the program transfer the contents of 
the short text line automatically to the first long text line (provided 
you have enabled the relevant option in the Settings tool on the 
Extras menu). 

  

 
 

Create Items for Elements 

Items are data records of the lowest level in the hierarchy of 
elements. You cannot create any items that are subordinate to items. 
Consequently, items consist of one line only (an associated sum line 
does not exist!). The items are totalized on the superordinate level in 
the hierarchy, that is, the element or the sub-element (if available). 
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Add Comments to Elements 

Comments can be used to describe elements, sub-elements and (one 
or more) items more precisely. As with items, comments are data 
records of the lowest level in the hierarchy. You cannot create any 
comments that are subordinate to comments. Comments are not 
added to element masters/schedules as often as to files. 

To assign a comment to an element, place the insertion marker in the 
first item line of the relevant element. If the element in question does 
not include any items, position the insertion marker in the element’s 
total/end line. 

  

 
 

Edit Items of Elements 

You have created an element with one or more sub-elements. The 
element consists of one or more empty items to which text, 
dimensions, DIN 276 cost groups, calculations etc. need to be 
assigned. In addition, you can add unit prices. 

  

 
 

Copy, Move or Delete Elements 

In Allplan Building Costs, you can quickly and easily copy, move or 
delete entire elements and sub-elements as well as individual items 
and comments. When you create element masters/schedules, this is 
very useful when you want to apply similar specification 
descriptions several times or when you want to create an alternative 
or contingency item based on a "normal" item. You can even create 
an entire alternative or contingency element from an element. 

The procedures for copying, moving and deleting the data records 
mentioned above are basically the same: select the relevant data 
records, activate the tool you want to execute, place the insertion 
marker as you need and insert (or delete) the data records there. 

More detailed information on copying, moving and deleting data 
records is provided in the chapter entitled "Basics of Working with 
Data Records". 



 

Integrated solutions  Cost Calculation Based on Element Method 151 
 

Tips: 

• If you want to copy, move or delete several items or entire 
hierarchical structures (e.g. an entire element with all subordinate 
sub-elements), select all the relevant lines first. Now you can edit 
these lines in a single step. 

• Including quantity calculations in copy operations can be useful 
when you want to create alternative or contingency 
items/elements. 

• However, you need to include quantity calculations when you 
want to move elements, sub-elements or items within a project; 
in other words, when you want to change the position of these 
elements. 

• Element lines or sub-element lines containing subordinate data 
records can only be deleted together with all subordinate data 
records. In this case, you need to select the entire level in the 
hierarchy. 

 

 

 

Creating Elements Based on Items in Item 
Catalogs 

To make things easier, you can create elements based on items you 
have copied from item catalogs. The advantage of this is that item 
catalogs include valid prices, which are required in element 
calculations. 

Element schedules for trade-specific files must always be generated 
based on item catalogs. Another advantage is that items in item 
catalogs include DIN 276 cost group numbers. This allows you to 
quickly and easily draw up DIN 276-compliant cost estimates based 
on element schedules. 

 

Creating elements based on master data involves the following steps: 

• Create the element structure in an element master or element 
schedule. 
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• Open the item catalog and select the prices you want to transfer 
to the new element master/schedule in order to draw up initial 
cost estimates. 

• Copy the relevant items, including prices, to the structure of the 
new element master/schedule. 

  

When you copy and insert items or comments, it is important that 
you take the hierarchic structure into account: 

 Project 
  Element 
   Sub-element 
    Item 
    Item 
    Item 
    Item 
   Total/End Sub-element 
  Total/End Element 
 Cost Project 

 

Place the insertion marker on the item that is to follow the item to 
be inserted. 

Note: When you transfer specification descriptions from an existing 
file to an element master/schedule and copy data records without 
opening the dialog box for copying data, quantity calculations are 
automatically copied at the same time. As it is not useful to transfer 
these quantity calculations to new element masters/schedules, you 
need to copy the data records without quantity calculations using 
the dialog box for copying data records. Alternatively, delete the 
quantity calculations later. 

  

 
 

Creating the Structure of an Element Catalog 

To structure an element master or element schedule, start by defining 
the basic structure using elements and sub-elements. Then add the 
relevant items for each element. 
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Creating elements 

The "element" level is the first level in the hierarchic structure. 

The sub-elements and/or items that are directly subordinate to the 
‘Element’ level in the hierarchy are totalized in the ‘Element’ line 
and the associated cost line. 

When you create the first element, two new indented lines – the 
element line and the total/end line - are displayed below the project 
line in the Type column. 

Enter descriptive text (e.g. "Brick wall, 24 cm") in the Short text 
column of the element line and a sum name for this assembly (e.g. 
"Total – brick wall, 24 cm") in the Short text column of the cost line. 

Note: You can configure the program to transfer the contents of the 
short text line automatically to the first long text line (provided you 
have enabled the relevant option in the Settings tool on the Extras 
menu). 

  

Creating sub-elements 

You can further subdivide an element by combining parts of a 
component in sub-elements. In other words, an element can consist 
of one or more sub-elements, which in turn consist of several items. 
 Element 
  Item  
  Item  
  Item  
  Item  
  (Sub-)element 
   Item 
   Item 
   Item 
   Item 
  Total (sub-)element 
  (Sub-)element 
   Item 
   Item 
   Item 
  Total (sub-)element 
 Total/end element 
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This is an example of a hierarchic structure. A structure of this type 
can be very useful when it comes to calculating elements. You can 
use it, for example, to quickly calculate different variants for a 
specific part of a component within the element. 

Note: More detailed information is provided later in the section 
entitled "Defining item categories and item types". 

The items that are directly subordinate to the "Sub-"‘Element’ level 
in the hierarchy are totalized in the "Sub-"‘Element’ line and the 
associated total/end line. 

When you create the first sub-element, two new indented lines – the 
sub-element line and the total/end line – are displayed below the 
element line in the Type column. 

Enter descriptive text (e.g. "Interior plaster, wallpaper") in the Short 
text column of the sub-element line and a sum name for this 
element (e.g. "Total – interior plaster, wallpaper") in the Short text 
column of the cost line. 

Note: Here, too, you can have the program transfer the contents of 
the short text line automatically to the first long text line (provided 
you have enabled the relevant option in the Settings tool on the 
Extras menu). 

  

 
 

Select Estimated Prices in the Master Catalog 

Data records saved as master data usually contain several price lines 
(e.g. minimum price, average price, maximum price). When you copy 
items from a master catalog to an element master/schedule, the price 
line you have selected for each data record in the master data is also 
copied. Element schedules only include one price line. In element 
masters, on the other hand, you can create additional price columns. 
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Before copying, you can specify which price line is copied to the 
new element master/schedule using one of the following options: 

• To use the prices of a single tenderer, display the prices of this 
tenderer only. 

• To use the prices of two or more tenderers, display all the price 
lines and select the line with the price you want to use for each 
item. These can be price lines of different tenderers. 

Note: You can also copy the prices of a tenderer (e.g. the average 
prices of the MID tenderer) to an existing element master/schedule 
later. Several price lines can be created in element masters. In 
element schedules, only one price line can be created at a time. More 
detailed information is provided in this chapter. See the section 
entitled "Calculating Prices Based on Element Method". 

Selecting estimated prices in master catalogs is described in detail in 
the "Tendering" chapter. See the section entitled "Selecting Estimated 
Prices in the Master Catalog". 

 
 

Creating Elements Based on Items in GAEB-
Format Files 

If a file has already been created for the project and is available in 
GAEB format, you can use its specification descriptions as an item 
catalog. To do this, assign this file as the element master in Allplan 
Building Costs. You can then use it to define materials in Allplan. 

  

Creating elements based on the items of a GAEB-format file involves 
the following steps: 

• Import the file via the GAEB interface. 

• Create the element structure in an element master or element 
schedule. 

• Copy the relevant items from the file to the structure of the new 
element master/schedule. 
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You create the structure for the elements by setting up the 
appropriate hierarchy of elements and sub-elements in the new 
element master/schedule. More detailed information is provided in 
the section entitled "Obtaining Elements from Items". 

  

When you copy and insert items or comments, it is important that 
you take the hierarchic structure into account: 

 Project 
  Element 
   Sub-element 
    Item 
    Item 
    Item 
    Item 
   Total/End Sub-element 
  Total/End Element 
 Cost Project 

 

Place the insertion marker on the item that is to follow the item to 
be inserted. 

  

 
 

Generating Element Schedules Based on 
Elements in Element Masters 

The quickest way to determine the costs for a project based on the 
element method is to copy finished elements from master catalogs to 
the relevant project. As described earlier, it is a good idea to sort 
elements by logical groups. Create several element master directories. 
Possible element masters would be exterior walls, interior walls, 
slabs etc., for example. You should create a separate directory for 
each element master in the project overview. 
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Creating element schedules based on element masters involves the 
following steps: 

• Open the element master and select the prices you want to 
transfer to the new element schedule in order to draw up initial 
cost estimates. 

• Select the desired elements in the master data. 

• Copy the selected elements, including prices, to the new element 
schedule. 

  

 
 

Select Estimated Prices in the Master Catalog 

Data records saved as master data usually contain several price lines 
(e.g. minimum price, average price, maximum price). When you copy 
items from a master catalog to an element master/schedule, the price 
line you have selected for each data record in the master data is also 
copied. Element schedules only include one price line. In element 
masters, on the other hand, you can create additional price columns. 

Before copying, you can specify which price line is copied to the 
new element master/schedule using one of the following options: 

• To use the prices of a single tenderer, display the prices of this 
tenderer only. 

• To use the prices of two or more tenderers, display all the price 
lines and select the line with the price you want to use for each 
item. These can be price lines of different tenderers. 

Note: You can also copy the prices of a tenderer (e.g. the average 
prices of the MID tenderer) to an existing element master/schedule 
later. Several price lines can be created in element masters. In 
element schedules, only one price line can be created at a time. More 
detailed information is provided in this chapter. See the section 
entitled "Calculating Prices Based on Element Method". 

Selecting estimated prices in master catalogs is described in detail in 
the "Tendering" chapter. See the section entitled "Selecting Estimated 
Prices in the Master Catalog". 
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Copy Data Records from Element Masters to Element Schedules 

To create element schedules, all you need to do is copy elements 
from the element master. Element masters include all the information 
that is required (DIN 276 cost groups, dimensions and calculations). 
You only need to select the relevant data records in the element 
master, copy these records to the element schedule and add 
quantities there. 

The process of copying data records is easy: select the desired 
elements, activate the tool you want to execute, place the insertion 
marker as you need in the new element schedule and insert the data 
records there. 

  

When you copy and insert elements, it is important that you take the 
hierarchic structure into account: 

 Project 
  Element 
   Sub-element 
    Item 
    Item 
    Item 
    Item 
   Total/End Sub-element 
   Sub-element 
    Item 
    Item 
    Item 
    Item 
   Total/End Sub-element 
  Total/End Element 
  Element 
   Item  
   Item  
   Item  
   Item  
  Total/End Element 
 Cost Project 

 

Place the insertion marker in the element line that is to follow the 
element to be inserted. 
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Note: Here, too, it is not useful to transfer quantity calculations to 
new element schedules. Therefore, you have to copy the data records 
without quantity calculations using the dialog box for copying data 
records. Alternatively, delete the quantity calculations later. 

More detailed information on selecting and copying data records in 
provided in the "Basics of Working with Data Records" chapter. See 
the sections entitled "Selecting Data Records" and "Copying Data 
Records". 
 

Creating Element Schedules Including Links 
to Element Masters 

In cost calculations based on the "normal" element method, you use 
elements that you have worked out in detail in a project. Allplan 
Building Costs offers an alternative approach for calculating 
elements: instead of defining elements with all the necessary sub-
items, you can place links to elements provided in element masters 
or element schedules. 

When it comes to calculating and printing out data, Allplan Building 
Costs follows, analyzes and processes these links without transferring 
the relevant data records to the project. Prices and calculations 
(variables defined) are taken into account. 

In addition, this method provides a quick and convenient way of 
calculating costs and defining equipment based on master data. For 
example, project-specific element schedules will update 
automatically to reflect any changes in element masters. 

  

 
 

Possible Applications of the Link Technology 

Element schedules including links 

Links can be used to set up complete element schedules. These links 
are associated with existing element masters/schedules which 
contain the relevant elements. 
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An example of an element schedule including links is provided on 
the Allplan DVD in the directory 

<dvd>\programs\Allplan 
BCM\Demodaten_Baukosten\Elemente&Linkanalyse 

  

Self-researching element schedules 

You can create self-researching element schedules. This means that 
elements (e.g. FF-FLOOR-SPACE element) are transferred to element 
schedules based on the definitions you have made. These elements 
include the calculation logic and the initial values. 

If, for example, an ‘FF-FLOOR-SPACE’ element is also to be 
calculated for ‘Building 2’, all you need to do is place a link to FF-
FLOOR-SPACE and check that the relevant initial values are 
available. This way, you obtain calculation models with a relatively 
small amount of project data. When you analyze the links in this 
project, Allplan Building Costs transfers the values from the floor 
space element in ‘Building 1’ to the link while taking into account 
the calculation logic and initial values defined for ‘Building 2’. 
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The following illustration will make things clearer: 

  

 

  

Two options are available for creating the calculation logic and 
initial values in self-researching element schedules. 

Create a new quantity line in the "floorspace" element line of 
Building 1. Assign a variable to this quantity line, variable '_A_', for 
example, and define any initial value for this element (e.g. 80). 

The next step is to assign the '_A_' variable, a calculation formula 
and factors to the relevant items at the item level in the hierarchy. 
When placing the link (Building 2), you enter the '_A_' variable in 
the In variable column. 
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Using a variable in the In variable column of the element line: 

 

  

When you want to use the '_ELEMENT_' variable to calculate the 
quantities of items, you do not need to define this variable in the In 
variable column. Allplan Building Costs automatically uses the 
quantity entered in the element line to calculate the item quantities. 

  

Using the _ELEMENT_ variable to calculate item quantities from the 
element quantity: 
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Calculating Elements Using Links 

Requirements 

One or more element masters and/or element schedules must exist so 
that you can place links. 

The items provided in these element masters/schedules must include 
unique code text; i.e. identical items must have the same code text. 
Otherwise, files cannot be created.  

Variables must be used for calculating item quantities. 
 

Defining research projects 

The element masters/schedules containing elements to which you 
want to place links have to be defined as research projects. 

The sequence in which you specify projects as research projects also 
defines the sequence in which the projects are researched. In 
addition, research can be performed within the current element 
schedule; in other words, element schedules can be "self-
researching". 
 

Placing links 

Start by creating a data record in an element schedule. The 
procedure is the same as for "normal" data records. The actual link is 
defined later. 
 

Defining links 

You can use the Define link tool to define and modify links to 
elements included in element catalogs defined as research projects. 
The code text and names of the selected elements are entered in 
element schedules. 

You can only place links to elements that are included in element 
catalogs you have defined as research projects. 
 

Displaying links 

You can use the Display link tool to get detailed information on the 
elements and/or the items of which these elements consist. 

Tip: Spend some time 
thinking about how best to 
structure the elements in the 
element schedule. Create the 
links as the lowest level in the 
hierarchic structure. 
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Analyzing links 

You can use the Analyze link tool to update the unit prices and total 
prices of links in data sheets. 

If you want to compare variants, it is best to copy an existing 
calculation to a new element schedule. You can then modify the data 
using the tools described above. Finally, compare the variants using 
the project-independent options for analyzing data provided in the 
project overview. 

  

Unlinking 

Links in element schedules can be unlinked using the Unlink tool. 
Allplan Building Costs copies the relevant element from the element 
master to the element schedule. As a result, the element schedule is 
no longer associated with the element master. After you have 
executed this tool, you can alter the element to suit the needs of 
your project. The following illustrations will make things clearer. 

Link to element: 

 
Unlinked element: 

 
  

Creating a structure 

You can use the Create structure tool to create file structures based 
on element schedules including links and elements. 

The structure can be predefined: trades can be created as files or 
titles. Alternatively, you can arrange items in an unstructured list. 
Grouping is based on the first digits of the code text, which allows 
you to combine codes in a list. 



 

Integrated solutions  Cost Calculation Based on Element Method 165 
 

Example of a file structure with file lines and title lines: 

 
This list can be transferred to a new project, pasted from the buffer 
or integrated as an item list in an existing structure. 

  

Revising projects 

When projects are generated based on element schedules including 
links, the quantity calculations defined in the element schedules are 
transferred. But if you want Allplan to provide these quantity 
calculations, the project in question must not include any quantity 
calculations. 

Delete all the quantity calculations and quantities using the Delete 
quantity lines tool and reset the quantities and total prices specified 
in the item lines using the Initialize calculation tool. 

 
 

Reports for Link Analyses 

Special reports are provided for analyzing element schedules 
including links: 

• Reports for analyzing links in compliance with DIN 

• Reports for analyzing links based on buildings 

• Reports for analyzing links based on trades (3-digit code) 

• Reports for analyzing links based on trades (4-digit code) 

A special point about these reports is that they save research 
operations. This way, you can print out these reports without having 
to repeat researches you have already performed. You only need to 
trigger new researches when calculations have changed. 
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Set up Element Catalogs 
You can set up element masters or element schedules manually by 
entering item numbers in the Item no column of the data sheet. But 
it is much easier to use Allplan Building Costs’ automatic algorithm. 

In automatic mode you can choose to set up element 
masters/schedules 

• by applying a logical structure or 

• by using consecutive numbers. 

  

In addition, you can specify whether project, element and/or item 
lines are to be set up, define the values at which the operation is to 
start and decide which fillers and separators are to be used. 

The data line in which the insertion marker is currently placed and 
all the associated, subordinate data records in the hierarchy can be 
set up in a single step. When, for example, the insertion marker is in 
an element line, this line and all the subordinate sub-elements, items 
and/or comments can be set up. To set up an entire project including 
all the subordinate elements, you need to place the insertion marker 
in the project line. 

More detailed information on setting up element masters and 
element schedules is provided in the "Tendering" chapter. See the 
section entitled "Setting up Files". 
 

Calculating Element Quantities 
Elements usually include items with different dimensions. A wall 
element could consist of a 36.5 cm wall, plaster and a coat of paint, 
for example. For the wall, the volume is calculated; for the plaster 
and coat of paint, on the other hand, Allplan Building Costs 
determines the area. 

Variables are used to calculate quantities of elements: the unknown 
calculation or the unknown quantity of an element is defined as a 
variable. Once you have defined a variable, you can integrate it in 
any subsequent quantity calculations of subordinate data records 
(sub-elements and items). 
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Based on this variable and the relevant factors, Allplan Building 
Costs calculates the quantities of the sub-elements and/or of the 
items of the element. The wall element mentioned above, which 
consists of a 36.5 cm wall, plaster and a coat of paint, would get the 
unit [m²] as most items of this element are calculated in [m²].  

The wall item would be multiplied by 0.365 and would get the unit 
[m³]. If the plaster and coat of paint are to be applied to one side 
only, this item would be multiplied by 1.000; if they are to be 
applied to both sides of the wall, a factor of 2.000 would be used. 

Let us assume that this wall element also includes an item defined as 
"wall openings", which is to be analyzed based on the number of 
openings. This is possible only if the factor for this item consists of a 
value that specifies the average number of wall openings per square 
meter of wall. 

Note: For calculating quantities, it is a good idea to set up the data 
sheet as follows: Hide all the columns that are not relevant to the 
calculations. Alternatively, you can divide the data sheet into two 
viewports so that the descriptive text block and the Quantity column 
are displayed in the window on the left, and the quantity block is 
shown on the right. 

  

 
 

Defining Calculation Factors for Elements 

Instead of quantities, the element master contains factors for 
calculating the individual item quantities. Therefore, the unknown 
quantity of an element is entered as a variable. The item quantities 
of the element are determined from the variable and the factors for 
calculating the quantity. When the element calculation is processed, 
the variable is then replaced with the element quantity. 

Before you start calculating the quantities, you need to create 
quantity lines. 
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Entering Quantities of Elements Manually 

When you create element schedules, all you need to do is either 
replace the variable defined in the element line with the quantity or 
calculate the relevant quantities in the element line. 

When the (re-)calculation is complete, the results are displayed in the 
Result and Quantity columns in the item lines. If the items include 
prices, Allplan Building Costs also takes these prices into account 
during calculation and enters the results in the TP checked, TP eff. 
and TP grs columns in the item lines, element lines and the total/end 
lines as well as in the cost line of the project. 

  

 
 

Calculating Quantities of Elements 

As well as entering the quantities of elements manually, you can 
also have the Allplan Building Costs perform quantity takeoff 
operations. 

You first need to create new quantity lines for the element you want 
to include in quantity takeoff operations. The program creates the 
first quantity line in the same line as the specification description in 
the text block. You have already created this line and defined the 
variable. All the other quantity lines of this element, which are 
characterized by ´*****´ in the text block, are inserted below this line. 
These lines are named ´new2´, ´new3´, ´new4´ etc. 

Enter the description and calculation for a component. The quantities 
of this component are calculated and entered in the Result column. 
Repeat these steps for all the other components which consist of this 
element. 

Finally, all the quantities in the individual quantity lines have to be 
totalized in the first quantity line of the element. 

If you have created too many empty quantity lines, you can delete 
the lines you do not need later. 
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Calculating Prices Based on Element Method 
In Allplan Building Costs, you can calculate items, sub-elements 
(component parts) or entire elements based on different item 
categories and types. This way, various alternatives can be created. 

To do this, element masters can be associated with several price 
lines. When creating element schedules, you can copy various prices 
(minimum price, average price, maximum price) to the data sheet. In 
addition, you can specify additional fees or discounts for individual 
items or entire elements. 

  

 
 

Define Item Categories and Item Types of Elements 

In Allplan Building Costs, you can choose different calculation types 
for elements, sub-elements and items. 

When you create element masters, it makes sense to assign different 
alternative items or alternative sub-elements to an element. When it 
comes to generating project-specific element schedules, you can 
switch between calculation types, and Allplan Building Costs 
immediately displays the costs of the alternative you have selected. 
For example, contingency items can be included as normal items in 
cost estimates – all you need to do is change the calculation type.  

Using sub-elements, you can replace the costs of entire component 
groups within elements simply by choosing different calculation types.  

Basically, all the calculation types available in an element 
master/schedule can be selected. Below is a description of the item 
categories most commonly used In the case of elements and sub-
elements, it is possible to change the item category. All the other 
options are only available with items. 

 

Item category Characteristic 

Item Normal item – including quantity, unit price 
and total price; no special features. 
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Item category Characteristic 

Basic Basic item – including quantity, unit price and 
total price; in addition to a normal item, a basic 
item is assigned one or more alternative items 
based on the assignment number. 

Alt. Alternative item – including quantity and unit 
price but no total price; is not included in 
calculations of the total price; is an alternative 
to a basic item to which it is assigned based on 
the assignment number. 

Requ. Requirement item – including quantity, unit 
price and total price; is included in calculations 
of the total price; requirement and contingency 
items are mutually exclusive. 

Cont. Contingency item – including quantity and unit 
price but no total price; is not included in 
calculations of the total price; requirement and 
contingency items are mutually exclusive. 

Text Text item – including neither quantity nor unit 
price; can be used to give comments a 
hierarchical structure. 

  

You can combine these categories with item types. This allows you 
to refine the structure of items. You can use the Properties of (name 
of item) dialog box to define the following item types: 

Item type Characteristic 

Item Normal item – an item without a structure. 

  

Points to bear in mind when defining categories and types of items: 

• Basic item associated with alternative item: using assignment 
numbers, you have to assign one or more alternative items to 
each basic item. 

• Requirement and contingency items are mutually exclusive in files. 
This should be taken into consideration when you create elements! 

• Comments: additional text to be entered by tenderers cannot be 
added to comments. 

• Quantity and dimension: quantities and dimensions have to be 
specified for items. 
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More detailed information is provided in the "Tendering" chapter. 
See the section entitled "Defining Item Categories and Item Types". 

 
 

Enter or Change Prices Manually 

You can enter prices manually or change the estimated prices copied 
from master files, master catalogs, element masters, element 
schedules or from other projects later. 

  

To enter the unit price 

1 Select the data field in the UP column of the item line for which 
you want to enter a price. 

2 Enter the appropriate price and press ENTER to confirm. 
 

 

Copying Prices from Master Data or Existing Projects 

You can select both the data records from which you want to copy 
prices and the data records to which you want to copy prices prior to 
copying. This has the advantage that the program does not scan 
entire projects; rather, it only checks the selected data records to see 
whether they match. 

In order for prices to be copied correctly from projects, master files, 
master catalogs, element masters or element schedules to a new 
element master/schedule, the following requirements must be met: 
the Short text, Item number or Code text must be exactly the same 
in both source project and destination project. 

Allplan Building Costs automatically creates a price column both in 
the element master and element schedule. This price column is called 
Estimation in element schedules and Master in element masters. In 
element schedules, it is not possible to change the names of 
tenderers – i.e. the names of the price columns – or to create several 
price columns at the same time. In element masters, on the other 
hand, you can create several price columns as well as modify or 
delete the names of the tenderers specified by Allplan Building Costs 
(as with master directories). 
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Important! 
Copy operations will overwrite the prices in the destination project! 
This is irrecoverable. To calculate temporary alternatives only, you 
should open the destination project as a "working copy". 

  

 
 

Calculating Total Prices 

Before you can determine the estimated total costs of element 
schedules, you have to enter all the quantities and prices. Otherwise, 
the sums of the items and consequently the total sums cannot be 
calculated. 

Note: As the Element Schedule data sheet includes estimated prices 
only, you can calculate the costs as far as the project line. 

When you (re-)calculate the total costs of a project, all the quantity 
lines are (re-)calculated and the results are entered in the Quantity 
columns of the relevant items. Next, these results are multiplied by 
the unit prices to get the total prices of the items. These total prices 
are finally summed up for every column. This is always done on the 
next superordinate level in the hierarchy. 

When the (re-)calculation is complete, the results are entered in the 
Quantity, TP checked, TP eff. and TP grs columns in the item lines 
and total/end lines of the elements as well as in the TP checked, 
TP eff. and TP grs columns in the cost line of the project. 

  

 
 

Assign Additional Fees or Discounts 

You have copied prices from the master data to a new element 
master/schedule. When it comes to estimating costs, you can assign 
additional fees and/or discounts as a percentage to the unit prices or 
total prices. The same applies for prices entered manually. 

Additional fees and/or discounts can be assigned not only to entire 
elements but also to individual sub-elements or items. In addition to 
individual prices, you can also update and thus change entire price 
columns. 
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If, for example, you assign additional fees and/or discounts to 
individual items, Allplan Building Costs immediately calculates the 
effective total prices of these items. The following applies: 

TP ± % +/- = TP eff. 

Total price ± additional fee/discount = effective total price 

When you assign additional fees and/or discounts to entire levels in 
the hierarchy, Allplan Building Costs initially enters the additional 
fees and/or discounts in the % +/- columns of all the subordinate 
data records. The effective total prices are only calculated when you 
trigger a new calculation of the entire element master/schedule. 

You can then "normalize" the unit prices; in other words, you can 
configure the program to include the additional fees and/or 
discounts in the unit prices. When additional fees and discounts are 
specified after you have entered the unit prices, you can use the 
"Normalize Unit Prices" tool to include these additional fees and 
discounts in the unit prices. The entries in the % +/- column are 
then reset to "0". 

More detailed information is provided in the "Tendering" chapter. 
See the sections entitled "Assigning Additional Fees or Discounts" 
and "Normalizing Unit Prices". 
 

Creating Files Based on Element Schedules 
Allplan Building Costs allows you to automatically generate trade-
specific files based on element schedules. In other words, when an 
element schedule is used to create a file, the items of different trades 
of an element are written to the relevant trades in accordance with 
the structure of the master data. 

Let us assume that an element schedule contains a number of 
elements consisting of masonry, plaster, wallpaper and paint. If, for 
example, you generate an element schedule based on the ‘Unfinished 
structure work’ master text, all the items belonging to ‘Unfinished 
structure work’ are taken from the element schedule and written to a 
file called ‘Unfinished structure work’. The same applies for plaster 
and painting work.  

Important! 
For this, the short text, item number or code text must be exactly the 
same in both directories. 
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After you have generated a file based on the trade you have selected 
in the element schedule, the quantity and price columns include 
entries. When the (re-)calculation is complete, the results are entered 
in the Quantity, TP checked, TP eff. and TP grs columns in the item 
lines and title lines as well as in the total/end lines of the file and in 
the cost line of the project. Now you can edit the file as usual: add 
items, modify quantities, calculate quantities etc. 

Note: Before you can generate a file based on an element schedule, 
you need to create a new project in the project overview. 

  

 
 

Print Element Catalogs 
Predefined reports are available for every data sheet. For example, 
you can create printouts of element schedules based on various 
layouts straight from the Element Schedule data sheet. In addition, 
cost calculations with or without quantity calculations can be 
included in printouts. 

  

Allplan Building Costs always prints the data of the open and active 
data sheet. In addition, printouts always include 

• the data line where the insertion marker is located and 

• all the data lines that are hierarchically subordinate to this data 
line. 

The following applies: the contents of the printout is defined by the 
position of the insertion marker in the data sheet before the Print 
dialog box is opened. Allplan Building Costs initially assembles the 
printout based on the data line in which you have currently placed 
the insertion marker and all the data records that are hierarchically 
subordinate to this line. You can then refine the settings in the Print 
dialog box, where you can specify which lines are to be included in 
the printout (open lines only, selected lines or all the lines). 
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Printing involves the following steps: 

• Define the contents of the printout and select the data you want 
to print. For example, place the insertion marker in the data line 
at which printing is to start, and display the data records to be 
printed.  

• Open the Print dialog box. 

• Select a report in the Output tab and specify the data records to 
be printed out. 

• If needed, change the footer, font and currency. 

• Set up the printer and start printing. 

Note: More detailed information on printing element masters and 
element schedules is provided in the "Basic Introduction" chapter. 
See the section entitled "Printing Files, Cost and Quantity 
Calculations". 
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Planning Costs Using CAD 
Objects 

When you have created a 3D building with standard materials in 
Allplan or imported a drawing (e.g. IFC file) from a different system 
into Allplan and assigned a 3D building model to this drawing, you 
can quickly and easily create an element schedule using the building 
list derived from the building model, which allows you to 
immediately determine the building costs for your current design. 

In addition, you can use the element schedule created with a 
building structure to check whether the design of your building is 
complete and correct. Any changes made to materials and/or quality 
characteristics affecting the project costs can also be tracked 
efficiently. 

  

CADOBJECT toolbar and BUILDING PROCESS scheme 

All the tools you need to perform cost planning operations are 
combined in logical groups and can be found 

• in the CADOBJECT toolbar (see ""CADOBJECT" Toolbar" on page 
179) and 

• in the BUILDING PROCESS scheme for the Element schedule 
data sheet. 

  

Planning costs in Allplan and Allplan Building Costs 

You can use the "CAD Objects" module to draw up rough cost 
estimates for a planned construction project in a comfortable and 
easy manner. 

The following example is provided to illustrate this approach: 

A layout with a 3D building model including standard materials has 
been created in Allplan or a drawing has been imported from a 
different system into Allplan (e.g. via the IFC interface) and a 3D 
building model has then been assigned to this drawing. 
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The general descriptions for the components drawn are entered in 
the Material/Code Text column.  

Now there are two ways to perform quantity takeoff operations 
and/or to create material and quantities schedules in Allplan: 

You can create quantities schedules  

• using Allplan’s building list (= method 1) or  

• using the CAD Objects schedule (= method 2). 

The quantities schedules are transferred to Allplan Building Costs 
and can then be analyzed and evaluated there. This way, you can 
draw up initial cost estimates. 

  

Analyzing and evaluating cost planning operations 

Special reports are provided for analyzing element schedules 
including links: 

• Analyzing links in compliance with DIN 

• Analyzing links based on buildings 

• Analyzing links based on trades (3-digit code) 

• Analyzing links based on trades (4-digit code) 

  

More tools in the "CAD Objects" module 

The "CAD Objects" module offers additional easy-to-use tools that 
facilitate cost planning in Allplan Building Costs and Allplan: 

• Transferring additional information from research projects 

• Checking quantity calculations visually using Allplan 
components 

• Filtering components based on object type 

• Converting items to links (and vice versa) 

• Replacing items and links 

• Modifying CAD attributes 

• Transferring changes made to material definitions back to Allplan 
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Performing quantity and cost calculations without Allplan 

You can also draw up cost estimates based on the element method 
without performing quantity takeoff operations in Allplan. In that 
case, however, you cannot take advantage of a set of convenient 
tools and automatic features that have been provided for this 
purpose. 

  

 
 

"CADOBJECT" Toolbar 
  

 

  

This toolbar has been developed specially for cost planning 
operations using Allplan Building Costs and Allplan. 

Icon Use 

 To execute the Import objects tool. 

 To execute the Define research tool. 

 To execute the Transfer source information tool. 

 To execute the Visualize objects tool. 

 To execute the Filter objects based on object type 
tool. 

 To execute the Toggle items/links tool. 

 To execute the Replace items/links tool. 

 To execute the Edit attributes tool. 

 To execute the Analyze link tool. 

 To execute the Export objects tool. 

 To execute the Calculate item quantities tool. 
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Important! 
The CADOBJECT toolbar is not installed automatically. To use the 
tools on this toolbar, you need to install it separately. 

  

 
 

"BUILDING PROCESS" Scheme for the 
"Element Schedule" Data Sheet 

The BUILDING PROCESS scheme for the Element Schedule data 
sheet has been developed specially for cost planning operations 
using the "CAD Objects" module. This scheme contains all the 
columns you need to perform cost planning operations. 

Important! 
The BUILDING PROCESS scheme is not installed automatically. To 
use this scheme, you need to import it separately. 

  

 
 

Initial Cost Estimates Without Allplan 
IntelligenteBauDaten IBD (= Option 1) 

You have created a layout in Allplan or imported it via the IFC 
interface, for example. The layout includes the general descriptions 
for the components drawn (= material definition) as well as the 
material IDs entered in the Material/Code Text column.  

Now there are two ways to perform quantity takeoff operations 
and/or to create material and quantities schedules in Allplan: 

• creating quantities schedules using Allplan’s building list 
(= method 1) or 

• creating quantities schedules using the CAD Objects schedule 
(= method 2). 
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The quantities schedules are transferred to Allplan Building Costs 
and can then be analyzed and evaluated there. This way, you can 
draw up initial cost estimates. 

  

 
 

Calculating Costs Using Allplan 
IntelligenteBauDaten IBD (= Option 2) 

An efficient way to draw up more detailed cost estimates is to place 
links. Instead of entering several individual items that belong 
together, you simply place a link that refers to the relevant element 
in an element master. When it comes to calculating and evaluating 
data, Allplan Building Costs follows, analyzes and processes these 
links without transferring the relevant data records to the project. 
Prices and calculations (variables defined) are taken into account. 

To use this feature, you have to set up an element master containing 
the components you want to include in the element schedule by 
using links and assign a unique code text to each component. 
Allplan IBD provides predefined element masters designed to allow 
efficient use of links. 

Here, too, you can perform quantity takeoff operations and/or create 
material and quantities schedules in Allplan by using either of the 
two methods described above in option 1. 
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More Tools in the "CAD Objects" Module 
The "CAD Objects" module offers a set of additional tools. 

 
 

Transferring Additional Information from Research Projects 

When you have imported Allplan data to Allplan Building Costs 
element schedules, you can transfer additional information such as 
short text or DIN 276 numbers from research projects to element 
schedules. Please note that the DIN number of the element level in 
the hierarchy is automatically used for the DIN number of the link. 

Important! 
If an item includes a code text which exists in a research project, the 
short text and DIN number of the element are used for this item. 

  

 

  

 

Example of a link: after importing Allplan data into Allplan Building 
Costs (top) and after transferring source information from a research 
project (bottom) 

  

 
 

Checking Quantity Calculations Visually Using Allplan Components 

Each item or element in Allplan Building Costs is derived from an 
original Allplan component, which can be displayed. This way, you 
can efficiently check and monitor the individual quantity 
calculations at any stage. 
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Allplan displays the original component in selection color 

  

 
 

Filtering Components Based on Object Type 

You can filter components in element schedules based on object 
type. This way, you can apply a filter that will display components 
of a specific object type only. 

  

 
 

Converting Items to Links (and Vice Versa) 

If you have defined materials in Allplan using not only complete 
elements but also individual items from item catalogs or element 
masters, these items are not created as links in Allplan Building 
Costs. Rather, these items remain unchanged and thus exist as items 
in Allplan Building Costs. 
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When a material name defined in Allplan does not end with a 
backslash ("\"), items are transferred as items to element schedules in 
Allplan Building Costs. 

The disadvantage is that you need to enter the unit prices for these 
items manually in the element schedule as these prices cannot be 
determined in research operations due to the missing links. 

Items can be converted to links (and vice versa). If the code text of 
an item converted to a link exists in the research project, this item is 
also researched. 

The results are available as links (items converted). You can undo 
this operation at any time. 
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Replacing Items and Links 

The materials of the components you have designed in Allplan and 
transferred to Allplan Building Costs can still be changed in Allplan 
Building Costs. All you need to do is replace items and links with 
other items and links in element schedules. Please note that an item 
can only be replaced by another item (e.g. from an item catalog or 
element catalog) and a link can only be replaced by a link to another 
element (from an element catalog such as Allplan 
IntelligenteBauDaten IBD). 

Important! 
New links are only researched when the element catalog containing 
the element linked is defined as a research project. 

 

Code text and short text of linked elements are transferred from the 
research project. 

  

 
 

Modifying CAD Attributes 

You can modify the CAD attributes (and thus the material definition) 
of items and/or links in element schedules later. 

The modified CAD attributes can then be transferred back to Allplan 
(cf. "Transferring Changes Made to Material Definitions back to 
Allplan"). 
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Transferring Changes Made to Material Definitions back to Allplan 

When you have changed CAD attributes (e.g. material definitions) in 
element schedules in Allplan Building Costs, you can transfer the 
modified attributes back to Allplan. These changes are automatically 
applied in Allplan and reflected in the material definitions of the 
Allplan components. 

Important! 
You can only transfer changes you have made to material definitions 
back to Allplan, if you have used the  Import objects tool to 
create the element schedule from a quantity takeoff schedule that 
was generated using Allplan’s CAD Objects schedule. Otherwise, the 
required information for correct assignment to the Allplan 
components (referred to as CAD references) will not be available. 

  

 
 

Performing Quantity and Cost Calculations 
Without Allplan 

Drawing up cost estimates based on the element method without 
performing quantity takeoff operations in Allplan involves the 
following steps: determine the quantities of the elements in a 
conventional manner and enter the results directly in Allplan 
Building Costs. Taking into account the calculation rules you have 
defined for items, Allplan Building Costs automatically calculates the 
item quantities based on the element quantities. 

Item quantities obtained in this manner can be transferred from 
element schedules to files (see the section entitled "Update 
Quantities"). This is of relevance in the Calculation and Invoicing 
phases. 

Important! 
For this, a unique code text must exist in the element schedule. In 
addition, this code text must be exactly the same in both the element 
schedule and the file. Otherwise, the quantities cannot be assigned 
correctly. 
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Scheduling 
Construction drawings, time schedules and tenders are usually edited 
and processed by different persons. As the data available to all those 
involved in a project varies considerably, this can cause significant 
errors affecting project costs. 

To ensure a smooth and consistent design process, you can associate 
CAD objects with services and files. This approach lets you compare 
the planned services and thus the cost flow with the actual situation, 
simulate the entire building process visually, detect collisions at an 
early stage and manage deadlines. You can simultaneously apply all 
the tools provided for the individual phases. 

  

Consistent approach: 

 

  

Allplan Building Costs’s scheduling module allows you to optimize 
the planning of all tasks at any stage in the building process. Cost 
and time expenditure can be managed clearly and displayed 
graphically. All information is always provided in a transparent 
manner. This way, you can immediately see how services, deadlines 
and the geometric properties of a building interact. 

In addition, the scheduling module forms the basis for subsequent 
processes such as invoicing or controlling operations, for example. 
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You can quickly and easily perform quantity takeoff operations, 
check measurement sheets, create execution plans and draw up cost 
estimates using Allplan’s and Allplan Building Costs’s 
interdisciplinary solutions in conjunction with MS Project. 

  

Scheme of integrated design: 

 

  

First, CAD objects are associated with elements and their items based 
on schematic names. The results of quantity takeoff operations are 
then assigned to items in files, which in turn, are then associated 
(together with their quantity calculations) with processes. This way, 
all those involved in a project can work independently although they 
can access the same basic data. In addition, this approach facilitates 
common evaluations and analyses of deadlines, geometric properties, 
quantities and items. 

You can use the "Allplan Building Costs Mobile" option to take 
measurements directly on site, which provides a convenient way of 
quickly entering data such as quantity calculations of various items, 
completion dates and locations. Following this, you can use Allplan 
Building Costs to check the measurement sheets in a comfortable and 
easy manner as well as transfer the results as actual values to a time 
schedule. 

With this approach, you can obtain a comparison of planned and 
actual data not only for quantities and costs but also for deadlines. 
Furthermore, you can quickly and efficiently perform invoicing 
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operations and draw up estimates while taking deadlines into 
account. Different reports are provided for printing the results. 

  

BUILDING PROCESS and Import Export toolbars as well as 
BUILDING PROCESS scheme 

All the tools and columns you require for scheduling operations are 
combined in logical groups and can be found 

• in the BUILDING PROCESS toolbar in Allplan Building Costs, 

• in the BUILDING PROCESS scheme for the Calculation and 
Invoicing data sheets in Allplan Building Costs and 

• in the Import Export toolbar (see ""Import Export" Toolbar in MS 
Project" on page 191) in MS Project. 

  

Analyzing and evaluating scheduling operations 

In addition to the standard tools provided by MS Project, Allplan 
Building Costs offers a number of reports specially designed for 
scheduling operations. These reports illustrate the scheduled and 
actual progress of construction work. 

This way, you can compare the planned services and cost flow with 
the actual situation, simulate the building process visually and detect 
differences at an early stage. 

The following reports are available: 

• Progress, trades, cash flow, deadline 

• Progress, check, cash flow, overview 

• Progress, forecast, process, cash flow (compact or detailed) 

• Progress, payments made 

• Progress, payments received 

When you install Allplan Building Costs, these reports are stored in 
the directory ...\Daten\Berichte\EXTENDED.V2014. To 
print out scheduling data, you need to set the path to this directory. 
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More scheduling tools 

The scheduling module offers additional easy-to-use tools that 
facilitate scheduling in Allplan Building Costs and Allplan: 

• Checking processes visually 

• Filtering quantity calculations based on processes 

  

 
 

"BUILDING PROCESS" Toolbar 
  

 
  

This toolbar has been developed specially for scheduling operations 
using Allplan Building Costs. 

Icon Use 

 To execute the Import CAD data tool. 

 To execute the Display CAD map tool. 

 To execute the Assign processes tool. 

 To execute the Process list to Clipboard tool. 

 To execute the Import process data tool. 

 To execute the Filter process tool. 

 To execute the Accept process tool. 

 To execute the Visualize process tool. 

 To execute the Export progress tool. 

  

Important! 
The BUILDING PROCESS toolbar is not installed automatically. To 
use the tools on this toolbar, you need to import it separately. 
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"BUILDING PROCESS" Scheme for the 
Calculation and Invoicing Data Sheets 

The BUILDING PROCESS scheme has been developed specially for 
the Calculation and Invoicing data sheets. This scheme contains all 
the columns that are relevant to scheduling operations. 

The BUILDING PROCESS scheme is not installed automatically. To 
use it, you need to install it separately. 

  

 
 

"Import Export" Toolbar in MS Project 
The Import Export toolbar has been developed for MS Project to 
ensure smooth and efficient communications with Allplan Building 
Costs: 

  

 

  

This toolbar contains the following buttons: 

Icon Use 

Write Deadlines To transfer deadlines to Allplan Building Costs. 

Read Progress To import data from Allplan Building Costs into 
MS Project. 

  

Important! 
This toolbar is not installed automatically. To use it, you need to 
install it separately. 
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Scheduling using Allplan Building Costs and 
MS Project 

The quantity calculations resulting from graphical quantity takeoff 
operations in Allplan are given unique identifiers (task names) in 
Allplan Building Costs and then transferred to MS Project for further 
editing. 

In MS Project, you can complete the structure, adjust task names and 
enter scheduled deadlines. This data is then transferred back to 
Allplan Building Costs, where it is associated with the quantities 
calculated. 

Checking measurement sheets involves accepting the quantities 
determined. In other words, the quantities used are characterized by 
the ‘actual date’ entry, which you assign in this process. Finally, this 
data is transferred to MS Project again, where it can be analyzed and 
evaluated in order to track and illustrate progress. 

  

 
 

Assigning Task Names to Quantity Calculations 

Similar to code text, which serves as a unique identifier for 
components and items in graphical quantity takeoff operations, 
unique code keys – "task names" - are entered in the Measurement 
sheet column in Allplan Building Costs and in the Task Name 
column in MS Project. 

These task names can be generated automatically based on the trade 
and the building structure defined by the building list or transferred 
from a time schedule in MS Project (if available). 

To do this, the BUILDING PROCESS toolbar and the BUILDING 
PROCESS scheme must be installed in Allplan Building Costs. 
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Important! 
The task name of each quantity calculation must be exactly the same 
in both the Measurement sheet column in Allplan Building Costs 
and the Task name column in MS Project. Otherwise, the data 
cannot be transferred correctly. 

  

In the example below, the task name has been generated 
automatically based on the trade ("brick wall") and the building 
structure ("6-Rooms\First Floor) and entered in the Measurement 
sheet column. In this phase, the Scheduled date is derived from 
Allplan (date on which the component in question was designed) and 
is not relevant to scheduling operations. 

Entering the data relevant to scheduling operations in Allplan 
Building Costs (the Measurement sheet column includes the task 
name for item/quantity calculations): 

  

 

  

 
 

Setting up Time Schedules in MS Project 

You can generate a task list in MS Project based on Allplan Building 
Costs data by creating a new project, inserting the data and then 
adding a task structure. 

  

Tasks copied from Allplan Building Costs (if you have not yet 
created a corresponding project in MS Project): 
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Task list set up for a time schedule after the superordinate lines have 
been added to the hierarchy and structure: 

 
  

Now you have entered all the data you need to compare the actual 
situation with the scheduled situation. You can then transfer this 
data to your file in Allplan Building Costs where it can be compared 
with the measurement sheet. 

  

 
 

Checking Measurement Sheets and Entering Actual Dates 

The process of checking measurement sheets using Allplan Building 
Costs involves accepting the quantity lines of the actual quantities 
used and/or refusing incorrect quantity lines. Only the quantity lines 
you have accepted are transferred to MS Project. 

  

Checking measurement sheets in Allplan Building Costs – example of 
accepted and rejected quantity lines (Q type column): 

 

  

Before you can check the measurement sheets, the tenderer for 
invoicing must be specified in the Awarding data sheet and the 
quantity lines for invoicing must be created; in addition, the task 
names must be assigned in the Measurement sheet column. 
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Transferring Actual Data to MS Project 

Only accepted quantity calculations included in measurement sheets 
are transferred to MS Project, where you can then analyze and 
evaluate the progress of construction work. 

  

Actual data for analyses and evaluations in MS Project: 

 

  

 
 

More scheduling tools 
The scheduling module offers a set of additional tools. 

  

 
 

Checking Processes Visually Using Allplan Components 

Each task/process in Allplan Building Costs is derived from an 
original Allplan component in which the item quantities of the 
process in question originated. These original components can be 
displayed in Allplan. This way, you can efficiently check and 
monitor the individual quantity calculations at any stage. 

  

 



 

196 Scheduling Allplan BCM   

Allplan displays the original components of a process in selection 
color: 

 

 
  

 
 

Filtering Quantity Calculations Based on Processes 

To see better what you are doing in files, you can apply a filter that 
will select certain processes only. 
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Graphical Quantity Takeoff 
Operations Using Allplan 

Both when designing in 3D using Allplan and when editing files in 
Allplan Building Costs, you generate data that is of relevance to the 
architectural design process. This data includes material and 
component definitions, specification descriptions consisting of items 
and quantities (length, area, number, volume, etc.). 

You can transfer this data, which needs to be made available to both 
Allplan and Allplan Building Costs, from one system (in which the 
data originated) to the other system (where the data can be used for 
the subsequent design). This ensures that the data is only created 
once. Thus, possible sources of errors are excluded and the data 
volume is kept to a minimum. 

The quantities which are automatically created in Allplan when you 
design in 3D are particularly important for Allplan Building Costs: as 
all the item quantities are transferred from Allplan to Allplan 
Building Costs, is it not necessary to perform time-consuming 
quantity takeoff operations in Allplan Building Costs. Furthermore, 
the costs of construction projects can be calculated quickly and 
efficiently based on master catalogs associated with prices. 

  

 
 

Functional Principle of Quantity Takeoff 
Operations Using Graphics 

First, the relevant specification descriptions are set up as item 
catalogs with a trade structure (= master file) in Allplan Building 
Costs. In addition, a "code text" is assigned to these specification 
descriptions. Then, the items of this master file are used to create 
elements, which are combined in an element master. 
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The specification descriptions prepared in this manner are accessed 
when materials are defined in Allplan: in the process of designing 
components, materials are selected from the catalogs provided and 
assigned based on the code text. As Allplan automatically updates all 
the quantities of components, quantity takeoff schedules can be 
created quickly and easily once the design is complete. 

These schedules are transferred to Allplan Building Costs and the 
code text is used to assign the quantities specified to the 
specification descriptions. As you go along, you can run analyses 
based on a wide range of different criteria and/or process these files 
in many different ways. 

Two columns of quantity takeoff schedules created in Allplan play a 
central role in graphical quantity takeoff operations: the Code text 
column (which can be considered equivalent to a material or item 
number) and the Quantity column. All the other columns like 
Component number, Room number, Room name and Component 
ID are primarily used to identify the individual quantity calculations 
in Allplan Building Costs and only have a subordinate role as far as 
the actual data transfer is concerned. 

The significant advantage of this method is that VOB-compliant 
quantities are available immediately. In addition, fully automatic 
cost calculations can be performed when the items in the master 
catalogs are associated with the current prices. 
 

Catalog Types for Quantity Takeoff 
Operations Using Graphics 

A distinction is made between item catalogs and element catalogs. 

Specification descriptions in item catalogs are structured by trade. In 
element catalogs, the specification descriptions of different trades are 
automatically combined in "item packages" that fully describe a 
component. 

The master file is a special type of item catalog. It contains all the 
specification descriptions (= items) used for creating the individual 
elements in the element catalogs. 



 

Integrated solutions  Graphical Quantity Takeoff Operations Using Allplan 199 
 

While designing in Allplan, you can assign individual items from an 
item catalog (= item method) or entire elements from an element 
catalog (= element method) to components and then transfer this 
data to Allplan Building Costs where it can then be analyzed and 
evaluated in conjunction with the relevant file. 

  

Item catalogs 

The item catalogs are the master directories of all specification 
descriptions required for the implementation of construction projects 
and the associated tenders. 

Items in item catalogs are structured by trade. 

  

Master file 

The master file is the master directory of the specification 
descriptions required for creating elements in element catalogs. You 
can define your own specification descriptions. As an alternative, 
specification descriptions can be copied from item catalogs to the 
master file. 

Items in the master file are also structured by trade. 

Important! 
Using a master file is the best way to ensure that the quantities will 
be imported correctly. 

  

Elements 

An element consists of several items of different trades and describes 
a complete component. A possible element, for example, is an 
interior wall consisting of masonry, plaster, wallpaper, paint and 
baseboard. If you want, you can add further items (from the fields of 
electrical installations and sanitary facilities, for example) to this 
element. 

These items are integrated in the element using an "estimated" factor 
based on experience, for example. 
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You ideally create all the elements by using items from the master 
file. This way, you ensure that the item quantities specified in the 
quantity takeoff schedule can be correctly assigned to the relevant 
specification descriptions in the item catalog. The assignment is 
made based the code text and is only possible if the item catalog (= 
master file) used for creating the elements and the item catalog used 
as the basis for the import of quantities are exactly the same. 

  

Element master 

The element master is the project-independent master directory of all 
elements (= components) and serves as the basis for project-specific 
element schedules. 

It is a good idea to sort the element master by logical groups, 
facilitating quick access to the elements. Possible directories in the 
hierarchy would be exterior walls, interior walls, slabs etc., for 
example. 

  

Element schedules 

Element schedules are project-specific directories of elements 
(= components), which are set up based on the elements provided in 
the element master. Element schedules are used to limit the material 
offered for selection to only those elements (= materials) that are to 
be used in a project. 

Project-specific and trade-specific files are generated based on 
element schedules. This means that element schedules serve as the 
basis for item-specific quantity takeoff operations and the tender. In 
addition, element schedules can be used for cost calculations in 
compliance with DIN 276. 

Important! 
If you want to use element schedules to generate files later, the 
following requirements must be met: the elements must have been 
created based on items of the master file, which must include all the 
items and, in addition, the code text must match. 
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Requirements for Quantity Takeoff 
Operations Using Graphics 

System requirements 

Allplan and Allplan Building Costs must be installed on the same 
computer or in a common network. 

In addition, the two systems must have full access to the directories 
described in the section entitled "System Configuration and 
Settings". 

  

Software requirements 

As Allplan and Allplan Building Costs are continuously refined, new 
versions including new functions and improvements to existing 
features are available at regular intervals. 

To fully exploit the advantages provided by graphical quantity 
takeoff operations, you should always work with the latest versions 
of Allplan and Allplan Building Costs . 

  

Design requirements 

Basic requirements concerning the design: 

• The building model must be created in 3D, so that the 
dimensions, quantities, cubic volume, etc. can be calculated. 

• All materials and attributes you want to include in analyses must 
be defined based on the catalogs provided by Allplan Building 
Costs when you enter components or later. 
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System Configuration and Settings 
To ensure a seamless and smooth exchange of data between Allplan 
and Allplan Building Costs, you need to make/check some settings 
just once. 

Otherwise, "online" access to data is not possible. In other words, 
you cannot access Allplan Building Costs data while working in 
Allplan. 

  

Settings in Allplan Building Costs 

You need to make two path settings in Allplan Building Costs: 

• A path must be set to the data exchange directory in which 
Allplan stores the files with the results of quantity takeoff 
operations. 

• Another path must be set to the directory where Allplan’s default 
settings are saved. These defaults include component attributes 
(e.g. information on trades), which are important for setting up 
catalogs in Allplan Building Costs (cf. section entitled "CAD 
Attributes for Items"). 

  

Settings in Allplan 

You also need to make/check two path settings in Allplan: 

• Before you begin designing in Allplan, make sure that the 
nem_ava catalog is selected for the components that you will 
need for designing. You can check this setting globally in the 
default settings or by calling the relevant function for each 
component. 

Note: The nem_ava catalog is usually preset by default for most 
components, but it still always a good idea to check just in case. 

• In addition, you need to set the path to the Allplan Building Costs 
directory so that you can access the projects in this directory 
right from Allplan. 
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Catalogs for Quantity Takeoff Operations 
Using Graphics 

Catalogs provide the common basis for graphical quantity takeoff 
operations using Allplan and Allplan Building Costs. These catalogs, 
which contain specification descriptions as item data, are created 
and maintained using Allplan Building Costs. As you work with 
Allplan, you can assign individual items (= item method) or entire 
item packages (= element method) from catalogs to quantities 
generated. 

There are different ways of exchanging data between Allplan 
Building Costs and Allplan. The following descriptions explain the 
philosophy behind graphical quantity takeoff operations. Please note 
that the format of this manual puts a limit on the number of options 
we can present. With the wide variety of possibilities offered, you 
can create even very complex catalogs. 

When defining materials in Allplan, you can access all the projects 
available in the Allplan Building Costs directory you have set. The 
way in which materials are defined varies depending on the catalog 
type (item catalogs, master file or element catalogs) selected in 
Allplan Building Costs (cf. section entitled "Defining Materials in 
Allplan"). Please note the special features of the individual catalogs. 

Important! 
You can specify the catalog from which the elements or items are to 
be taken. This allows you to select the catalog that best suits your 
needs. 

Make sure that you are dealing with the correct catalog when 
importing CAD data into Allplan Building Costs later. Otherwise, the 
data may not be processed correctly. 

It is not advisable to mix catalogs. Before you begin, decide on the 
specification descriptions you require in Allplan and set up an 
appropriate "CAD catalog" in Allplan Building Costs. 
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Some notes on the individual catalogs: 

a) Item catalogs 
When you select materials in Allplan, item catalogs are marked with 
an (S) after the project name (exception: master file). 

CAD data generated based directly on item catalogs can be imported 
into Allplan Building Costs by using the "CAD XPad -> Project" tool 
when you import the data for the first time. When updating an 
existing file, use the "CAD XUpdate" tool. 

It is essential to make sure that you have specified all the catalogs 
needed for the import; otherwise, the quantities may not be assigned 
correctly. The best approach therefore is to create a special, CAD-
specific master file based on the items of the item catalogs. 

b) Master file 
As a master file is maintained like a "normal" project file, it is 
marked with a (P) after the project name when you select materials 
in Allplan. 

You can also use the "CAD XUpdate" tool to import CAD data into a 
master file (or a copy of a master file). You can then quickly and 
easily delete items that are not used or associated with quantities. 

c) Element catalogs 
When you select materials in Allplan, element catalogs are marked 
with an (E) (= project-independent element catalog) or with a (R) (= 
project-specific schedule) after the project name. 

Here, too, you can use the "CAD XUpdate" tool provided by Allplan 
Building Costs to import CAD data generated based on element 
catalogs. This data can be imported into a copy of the master file, for 
example. 
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Setup and Structure of CAD Catalogs 

Why are special CAD catalogs useful? 

When defining materials in Allplan, you can access all the projects 
available in Allplan Building Costs in order to select specification 
descriptions from different catalogs. In spite of significant 
advantages, this has several disadvantages, however: 

• It can happen that you need to open several catalogs and perform 
tedious searches until you find the item you want to use. 

• When importing CAD data into Allplan Building Costs, you need 
to specify the catalogs from which you have taken items 
(disadvantage: you must remember the catalogs you have used). 
As an alternative, you can also specify all existing catalogs 
(disadvantage: doing so can increase the time required for 
import). 

To avoid these disadvantages, you can use special CAD catalogs 
customized to meet the requirements imposed by design tasks. These 
catalogs, which are created based on existing item catalogs, 

have the following advantages: 

• CAD catalogs only contain items and/or elements that are 
relevant to the design, providing quicker access to 
items/elements. 

• When importing CAD data, you only need to specify a single 
catalog containing all necessary items. 

• Items can be set up to suit the needs of designers: for example, 
the specification descriptions of plaster and paint can be used to 
generate a single element named "Wall with plaster and paint". 
Although these specification descriptions belong to different 
trades in the item catalogs, you do not have to perform time-
consuming searches. 

  

Type and structure of a CAD catalog 

It is worth spending time carefully planning a CAD catalog's 
structure before even drawing the first line in Allplan: define the 
materials you want to use or decide on the rooms’ equipment 
properties, for example. 
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Combine the specification descriptions you require for these 
materials and equipment properties in a separate CAD item catalog 
(= master file). You can even use this catalog to define materials in 
Allplan by assigning individual items to components (= item 
method). 

In contrast to pure CAD item catalogs, however, CAD element 
catalogs have significant advantages: 

• You can combine several items in elements when defining 
materials using Allplan. You can then transfer these "item 
packages" in their entirety by making a single assignment in the 
CAD system (= element method). 

• The same applies for the "Room" tool in Allplan. 

• Using elements, you can create hierarchies of any structure. This 
allows you to generate well-designed CAD catalogs. 

• Element catalogs can contain several instances of an item 
although duplicate data storage is avoided. For example, the 
"Plaster" item can be assigned to both exterior and interior wall 
elements. 

The CAD catalog you set up should thus be customized to meet the 
requirements of the design tasks and define elements by combining 
items from the item catalog. 

Important! 
The item catalog (= master file) serves as the basis for the element 
catalog. Prior to creating the item catalog, spend some time thinking 
about how best to structure it and, if possible, you should not make 
changes afterwards.  

Element catalogs only contain copies of the actual items. When CAD 
data is imported into Allplan Building Costs, however, the items are 
taken form the item catalog. It is therefore important that you update 
and maintain the items in the item catalog. Any changes you make 
to items in element catalogs are not recognized. 

Furthermore, you can only copy the current prices from the item 
catalog to an element catalog when the elements in the element 
catalog you want to use have been created based on items of the 
item catalog. 
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Creating a CAD item catalog (master file) based on an element 
catalog 

Allplan Building Costs offers the option to automatically generate 
trade-specific files based on element catalogs (element masters or 
element schedules). 

If you have created a CAD element catalog based on items from 
different master catalogs, you can use this element catalog to 
generate a CAD item catalog, which is necessary for a correct import 
of quantities. 

  

 
 

Code Text for Items and Elements 

Code text is a freely definable combination of characters that needs 
to be defined for each item/element. It is essential that a unique code 
text be assigned to each item/element. You can manage code text in 
Allplan Building Costs using the Code text column. 

Whereas the item number of any item may change in each file, code 
text always stays the same. This means that code text serves as the 
unique identifier for items in master catalogs, files and element 
schedules. 

Due to its properties, code text is used as an "assignment key". In 
other words, materials, quantities and specification descriptions are 
assigned based on code text: first in Allplan Building Costs by 
defining "Item/Element -> Code text", next in Allplan by assigning 
"Material = Code text" and then again in Allplan Building Costs by 
specifying "Code text/Quantity -> Specification 
description/Quantity". 

  

Important! 
Code text of items must be entered in the item catalog. You should 
ensure that each item includes a unique code text. Unique means 
that each combination of characters exists just once. You should not 
modify code text later. 
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Note: Code text of an item can consist of a maximum of 16 
characters and that of an element of 15 characters maximum. Code 
text may include letters, numbers and "-./_". 

  

ATTENTION! 
However, it must not contain blanks! 

  

For example, you can create code text based on a number key or 
character sequence: 

Example 1: 

Code text stands for ... 

012020110 the "Vertically perforated brick 36.5" item in its 
entirety 

012020110 trade 012 "Masonry" 

012020110 the second subtitle "Exterior walls" 

012020110 the consecutive item number; increments of ten 
are useful as you can add items later without 
having to adjust numbering. 

  

Example 2: 

Code text stands for ... 

012VPB365 the "Vertically perforated brick 36.5" item 

The code text indicates the contents of the item. 

  

Example of a code text key in an item catalog: 
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CAD Attributes for Items 

Items in CAD catalogs can be associated with additional attributes 
which have already been defined in Allplan and which are necessary 
for correct quantity takeoff operations using Allplan: 

• You can use the Trade option to define regulations based on 
which openings, niches, reveals etc. are analyzed and evaluated. 
You can specify different regulations for each trade. 

The trade that is to be applied to an item for evaluation and 
analysis is matched to the trade list in Allplan by transferring the 
trade and trade number from Allplan. 

• In the element catalog, you can define formulas for all items 
combined in elements. This ensures that item quantities are 
always calculated correctly even when different regulations have 
been defined for individual items (e.g. wall area in m² and wall 
length in m). 

Important! 
To fully exploit the benefits of elements, you should always 
define formulas for items assigned to elements. If you have not 
entered formulas, the quantities of the items in question cannot 
be determined. 

When defining formulas, you can enter all the units required to 
calculate the relevant component in Allplan. These units are 
presented for selection. Customized formulas can also be defined. 

Example: 
A wall with a tiling pattern that is max. 1.50 m high. The formula 
might look like this: m*1.50 

When editing the CAD attributes, you can use an attribute definition 
as a template and simply transfer it from one item to another. 

Note: An overview of the attributes is provided in the online help for 
Allplan, in the chapter entitled "Attributes of Architectural 
Elements". 
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Dynamic Code Text for Items 

"Dynamic code text" is a combination of code text and CAD 
attributes. This means that a predefined Allplan attribute is added as 
a variable to code text of items in the element catalog (not in the 
item catalog). Only when you create quantity takeoff schedules are 
these variables replaced by the actual values defined by the 
dimensions of the Allplan components. This completes the 
generation of "dynamic code text". 

Code text created in this manner serves as an "assignment key" 
when files/element schedules are generated and/or the CAD XUpdate 
tool is executed: item quantities in quantity takeoff schedules are 
assigned to specification descriptions in the item catalog based on 
this code text. 

Important! 
The code text must be exactly the same in both the quantity takeoff 
schedule and the item catalog. Otherwise, the CAD XUpdate tool 
returns error messages, which are saved in the allright.err file. 

You can use any of the attributes defined in Allplan as variables. 
However, the following attributes are particularly important: 

• Length 

• Width 

• Height 

• Volume 

When defining the formula for "dynamic code text", be sure to note 
the following: a + character must be used to append the attribute(s) 
to the end of the basic code text of an item. These attributes are then 
replaced by the component dimensions. The basic code text and the 
variables must be separated by a hyphen; constant parts of the code 
text must be enclosed in quotation marks. 
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Below is an example to illustrate the syntax of "dynamic code text" 
in an element catalog: 

"013.060000-"+ROUND(length*100;1;5)+"-
"+ROUND(thickness*100;1;5) 

  

"013.060000-" constant part: basic code text of the item (e.g. a 
general description of reinforced concrete 
columns) plus hyphen 

+ instructs the program to add the next term 

ROUND instructs the program to round off the value 

Length / thickness variables: CAD attributes that are replaced by the 
actual component dimensions 

*100 conversion of unit to meters and centimeters 

1 number of decimal places 

5 round-off value of the last digit 

  

Example: Thickness of the component in Allplan = 0.257 
cm 

 ROUND(0.257*100;1;5) = 26 

For example, when designing a column that is 
0.365 m long and 0.405 m thick, this "dynamic 
code text" yields the following final code text in 
the quantity takeoff schedule: 

013.060000-36.5-40.5 

  

The code text must be defined in this manner in the item catalog. 
This ensures that the quantities specified in the quantity takeoff 
schedule are assigned correctly to items when files/element schedules 
are generated. 
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Creating a CAD Catalog as an Element Catalog 

The sections that follow explain how to create custom CAD catalogs 
for graphical quantity takeoff operations in Allplan Building Costs. 

As these catalogs are very complex and setting them up takes much 
time, Nemetschek’s Design2Cost initiative offers you a 
comprehensive database of predefined catalogs and files, which are 
provided in Allplan IntelligenteBauDaten (= Allplan IBD). 

For more information, please visit our website at 
http://www.design2cost.de or contact your Nemetschek sales partner. 

  

 
 

Defining Materials in Allplan 
General information 

You can assign materials to architectural components (walls, 
columns, slabs etc.) while designing using Allplan. If you want, you 
can add rooms to which you assign further material definitions 
based on finishing surfaces. 

Not only do you have the option to assign individual items to 
architectural components and rooms in a single step but you can 
also assign entire elements together with all the associated items 
(provided you have prepared the element catalogs in an appropriate 
manner). If you are using rooms, you can quickly and easily define 
finishing surfaces consisting of multiple layers by selecting entire 
elements right from the beginning. 

In addition to basic items such as "brick" and "plaster", a wall can be 
assigned more items for paint or tiles, for example. You can even 
apply bituminous coating (for sealing against dampness) to the 
"wall" element despite the fact that the quantities of bituminous 
coating are calculated based on a different regulation. To ensure that 
the quantities of the individual items are always calculated correctly 
(e.g. wall area in m² for plaster and paint; wall length in m for 
bituminous coating), you can define formulas for all items in Allplan 
Building Costs (more information is provided in the section entitled 
"CAD Attributes for Items". 
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Whenever you define materials, you access the catalogs you have 
prepared using Allplan Building Costs. 

Note: If you are working with elements, it is important that you 
specify the element catalogs whose elements you want to use when 
defining materials in Allplan (see next section entitled "Define 
Research Projects"). 

  

Research projects 

"Research projects" are projects the program scans for elements 
while creating quantity takeoff schedules. In other words, the 
material requirements of these projects are "researched". The 
sequence in which you specify element masters and element 
schedules as research projects also defines the research sequence 
(from top to bottom). 

As the items of elements found can be analyzed only, it is important 
that you only define materials based on element catalogs that are 
actually used for creating quantity takeoff schedules. 

  

Materials for architectural components 

Of course, you can select an individual item in an item catalog when 
defining materials for architectural components. But it is much easier 
and more efficient to select entire elements using element catalogs 
you have prepared for this purpose (cf. section entitled "Setup and 
Structure of CAD Catalogs"). 

  

Materials for finishing and special surfaces 

You can also create finishing surfaces of rooms and special surfaces 
that consist of one or more individual items. Here, too, it is much 
easier and more efficient to select entire elements using element 
catalogs you have prepared for this purpose (cf. section entitled 
"Setup and Structure of CAD Catalogs"). 

Important! 
When defining finishing and special surfaces, be sure to note the 
following: Floor and vertical surfaces (as "normal" finishing 
surfaces) take special surfaces into account. This means that floors or 
vertical surfaces defined as special surfaces have a higher priority 
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than ‘normal’ finishing surfaces defined when entering rooms and 
consequently, these special surfaces will intersect normal finishing 
specs at points where they meet (e.g. tiling patterns in plastered and 
painted walls). 

  

Component numbers 

You can assign component numbers to all drawing elements in 
finished drawings. This facilitates subsequent processes of 
transferring data to and analyzing and evaluating data in Allplan 
Building Costs. 

  

 
 

Quantity Takeoff Operations in Allplan 
When you have finished assigning materials from the Allplan 
Building Costs material catalogs to components, you can now create 
a quantity takeoff schedule based on the data obtained from quantity 
takeoff operations and transfer this schedule to Allplan Building 
Costs. 

Important! 
If you are working with elements, it is important that you specify the 
research projects before you create quantity takeoff schedules (cf. 
section entitled "Define Research Projects"). This ensures that all the 
data is processed correctly, which means that item quantities are 
calculated and assigned to the appropriate specification descriptions. 

  

You can define which drawing files or components are to be 
analyzed during quantity takeoff operations in two ways: 

• Selectively - by choosing specific drawing files and the objects 
they contain. 

• Globally - based on several drawing files assembled using a 
"building list". For this, the drawing files in question simply have 
to be selected in the project structure (you do not have to set 
them to active or edit mode). 
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Allplan offers an efficient approach for generating quantity 
takeoff schedules encompassing entire structures or buildings. 
You can structure a project's drawing files in a "building list" 
using the following structural levels to assist you: "Structure", 
"Building" and "Story". 

  

Further quantity takeoff principles: 

• Quantity takeoff operations work on a cross-file basis (i.e., you 
are not restricted to the information in a single drawing file): 
rooms and the corresponding walls with windows and doors do 
not have to be in the same drawing file. The system will 
nevertheless recognize door and window openings as belonging 
to the room and take these into account during calculations. 

• Neighbor relationships are taken into account: 

- Doors and windows are assigned to the corresponding room. 

- Door openings are assigned to rooms (depending on the 
direction of swing/opening). The floor covering in the door 
opening in the adjacent room is included in the calculation. 

- Slab recesses and openings are recognized as such. 

- Walls recognize each other. 

  

 

 
 

Importing Allplan Quantity Takeoff 
Schedules into Allplan Building Costs 

As the possible applications for graphical quantity takeoff operations 
are manifold, there are a lot of ways in which you can import 
quantity takeoff schedules into Allplan Building Costs. 
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Important! 
To make sure that all the data is imported correctly, you have to 
specify the item catalog you have used for defining materials. 

The section that follows shows how to import a quantity takeoff 
schedule based on a material definition using an element catalog 
(that was created based on a master file). 

The resulting quantity takeoff schedules are imported into a copy of 
the master file. This ensures that all the items used in Allplan are 
available. 

  

Creating files 

You can create files directly from quantity takeoff schedules. The 
item catalog you have used for defining materials serves as the basis 
for these files. 

Before you import the quantity takeoff schedules, you need to copy 
the item catalog (= master file) whose items you have used to set up 
the element catalog. The original master file is retained. You can 
then import the quantity takeoff schedules into this copy. 

  

Updating quantities in existing files 

When you have already created files, you can import the updated 
CAD data directly into existing files. This way, you can quickly and 
easily update quantities. 

Please note the following: 

• Modified quantity calculations are overwritten. 

• Quantity calculations that are no longer required (e.g. quantity 
calculations associated with components you have deleted in the 
meantime) are automatically removed from files. 

• Additional quantity calculations (when you have drawn more 
walls, for example) are added. 
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• Specification descriptions that are no longer used are retained as 
"items with zero quantities" in files. If necessary, you can mark 
and then delete them using the Mark zero quantity tool on the 
Calculation menu. 

• New specification descriptions are entered in the log file and can 
be added "manually" to files (cf. section entitled "Checking the 
Log File"). 

• Items and quantity calculations you have entered manually in 
files – i.e. that have not been transferred from Allplan – are 
unaffected by this operation. 

• Items you have locked are not changed. 

  

Checking the log file 

The log file shows the materials and/or quantities that could not be 
assigned correctly during the import. Check the log file entry by 
entry, make the necessary corrections and then update the quantities 
once again. 

This way, you can ensure that the file contains all the materials used 
in Allplan. 

  

 
 

Analyzing and Evaluating Quantity Takeoff 
Schedules 

Basic functions using standard tools 

You can use all the basic functions provided in Allplan Building 
Costs to analyze and evaluate imported CAD data. 

Graphical price comparison lists and reports in particular facilitate 
the procedure of analyzing and evaluating objects designed using 
Allplan at any stage. 

  

 



 

218 Graphical Quantity Takeoff Operations Using Allplan Allplan BCM   

Special functions 

Besides the standard tools, Allplan Building Costs provides special 
reports for analyzing and evaluating files and element schedules that 
have been created based on CAD data. 

When you install Allplan Building Costs, these reports are usually 
stored in the directory ...Data\Nemetschek\Allbase\ 
Daten\Berichte\Extended.V2014. If you will be using these 
reports regularly, set the default report path to this directory. 

  

 
 

Tip: You will find an overview 
of the most important infor-
mation on each report in the 
Info tab of the Print dialog 
box. 
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Printing files, cost and 
quantity calculations 

Project-specific data sheets, in particular, include large volumes of 
data of different types. To generate printouts of overviews, files, cost 
or quantity calculations etc., Allplan Building Costs only requires 
certain types of data from the respective data sheet; these should be 
clearly arranged on the printout. To accomplish this, reports (= print 
templates) are provided which serve as the basis for every printout. 

Using these reports, you can specify 

• which data of a data sheet is to be printed out, 

• which additional text (e.g. headings, list headers, footers) and 
images (e.g. logos) are to be included in printouts and 

• what layout the printout should have. 

Various predefined reports are available for each data sheet. For 
example, you can create printouts of files based on various layouts 
as well as print cost calculations with or without quantity 
calculations from within the Calculation data sheet. 

Allplan Building Costs provides such a wide choice of reports with a 
vast number of details that it is hard to remember everything. To 
make thing easier, you can look up the most important information 
on each report directly in the Info tab of the Print dialog box. 

Important! 
When you want to print a file containing formatted long text, the 
file must be printed using special reports. More information can be 
found in the online help under "Format Long Text in a Text 
Window" and "Print a File with Formatted Long Text". 

Printing is easy. All you do is: 

• Define the contents of the printout and select the data you want 
to print. For example, place the insertion marker in the data line 
where printing is to start, display the data records to be printed 
or open the data of the tenderer you want to print. 
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• Then open the Print dialog box and select the report you want to 
use for printing. In addition, you can display a thumbnail of the 
currently selected report in the Preview tab so that you can easily 
check whether you have selected a suitable report. 

• If required, you can change the layout template in the Output tab 
and set other report options. 

• Set up the printer and start printing. 

Note: You can use the report designer to modify and customize 
reports or to create new reports. How this is done is described in 
detail in the "Editing Reports (on page 267)" section. 

  

Transfer to MS Word 

You can transfer files, including cover sheet and compilation, as well 
as quantity and cost calculations directly to MS Word for further 
processing. The data is converted to a formatted table. Once the file 
has been transferred to MS Word, you can edit the table as well as 
the header and footer in the usual way there. More information can 
be found in the online help under "Transfer a File to MS Word". 

Please note the following: 

• To use this capability, MS Word Version 97 or higher must be 
installed. 

• When you transfer the file to Word, any graphics or sketches 
contained in the file will not be included. 

• For transferring data to MS Word, Allplan Building Costs uses the 
COM interface. For this reason, the transfer speed is not 
comparable to the output times you are used to; in case of 
comprehensive files, there may be delays. 

• Since Word controls page breaks independently from Allplan 
Building Costs, it is not possible to set "carried over" information 
at the proper locations. If you wish to add this information, we 
recommend to add it as a header in the Word document. 

  

Transfer to MS Excel 

You can transfer your price comparison lists to MS Excel for further 
analyses. 
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As opposed to the other reports for the Price comparison list phase, 
not all tenderers contained in the file are included in the tenderer 
comparison and marking of the MIN/MAX values; only the tenderers 
selected in the Select tenderer dialog box are taken into account. 
This also applies to preselecting data by placing the insertion marker. 
More information can be found in the online help under "Transfer a 
File to MS Excel". 

Please note the following: 

• To use this capability, MS Excel Version 97 or higher must be 
installed. 

• For transferring data to MS Excel, Allplan Building Costs uses the 
COM interface. For this reason, the transfer speed is not 
comparable to the output times you are used to; in case of 
comprehensive files, there may be delays. 

• In the current version, you can only transfer one file; a project 
with folder structure or multiple files cannot be transferred in a 
single step yet. 

  

Additional special output options 

Besides printing your projects on paper, you can also choose from a 
variety other output options. 

In addition, you can export your projects in various standard 
electronic formats for further processing with other applications or 
for electronic data exchange via email or the Internet. You can 

• print a project to a file in PDF format which can be distributed 
via email or published to the Internet (see online help under 
"Output of Files in PDF Format"). 

• print a project to a file in RTF format in order to import it in 
MS Word or another word processor for further editing (see 
online help under "Output of Files in RTF Format"). 

• print a project to a file in ASCII format which can be opened in 
another program for further processing (see online help under 
"Output of Files in ASCII Format". 

• print a project to a file in HTML or XML format which can be 
edited, displayed or published to the Internet using a web browser 
(see online help under "Output of Files in HTML Format" and 
"Output of Files in XML Format"). 
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Defining the Contents of the Printout and 
Preselecting Data 

Allplan Building Costs always prints the data of the open and active 
data sheet. In addition, printouts always include 

• the data line where the insertion marker is located and 

• all data lines that are hierarchically subordinate to this data line. 

Thus, the contents of the printout is always defined by the position 
of the insertion marker in the data sheet before you open Print  
dialog box. Allplan Building Costs initially assembles the printout 
based on the data line in which you have currently placed the 
insertion marker and all data records that are hierarchically 
subordinate to this line. For printing, it is important whether or not 
the subordinate data records are visible. Only the visible data records 
will be printed. 

If you have selected subordinate records, only the selected records 
will be printed. In this case, it does not matter whether or not these 
data records are visible. 

  

 
 

Open the "Print" Dialog Box and Select Print 
Settings 

After you have defined the contents of the printout and selected the 
data, open the Print dialog box. 

This dialog box usually displays all reports for selection that are 
available for the active data sheet. To make it more convenient for 
you to find the desired report, the reports are grouped. You can also 
create your own report groups, e.g. for frequently used reports or for 
user-defined reports. 
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In the Output tab of the Print dialog box, you can select the print 
settings to be used for the current printout. Click the "More options" 
button to display general print settings. 

  

 
 

Selecting Advanced Print Settings 
Before printing your files, you can define some advanced print 
settings using a layout template. This includes the footer text to be 
printed and the logo you want to integrate in the printout. 

You can define the following defaults in the Print tab of the Settings 
dialog box: 

• change footer text that is to be printed at the bottom of each 
page (e.g. your office contact data), 

• add your company logo, 

• create your own layout templates or   

• set the directory where the currently required reports are stored 
(this means that it is possible to change the current report path 
without exiting the Print dialog box). 

  

ATTENTION! 
These settings will be valid for all reports that come with Allplan 
Building Costs and can only be changed in the way described here. 
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Checking Printouts in the Preview 
Before you start printing, you can open the Preview dialog box and 
review the printout you prepared. The pages can be displayed in two 
different modes: whole page or zoomed in. 

Note: If you open a print job instead of a single report in the 
preview, you need to close the preview for each report included in 
the print job (example: a print job contains 4 reports -> you need to 
close the preview 4 times). 
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Backing Up Data and 
Archiving Projects 

Data backup is one of the most important topics in the IT industry. 
Even if you are working with large amounts of data without being 
confronted with any problems, it is a topic you cannot afford to 
ignore. Not only hardware failure, but also user error can cause 
valuable data to be lost irrevocably. It is therefore essential that you 
save all the data regularly, as otherwise several man hours, weeks or 
even months of work might be irretrievably lost. 

ATTENTION! 
Back up your master data, projects and other important data 
regularly! We also strongly recommend backing up all data before 
installing a program update! 

Various options are available: 

You can back up 

• all the data relevant to Allplan Building Costs 

• specific projects using the Archive Administration tool 

• particular user-specific data (e.g. macros and filter conditions) 
using the Resource Administration tool 

• various other user-specific data (e.g. addresses, images, reports 
and settings) 

  

 
 

Full Backup 
The safest method is to perform a full backup, which includes all the 
data relevant to Allplan Building Costs – ranging from projects, 
masters and element catalogs to data saved in the image and address 
databases to your own custom settings and definitions to reports you 
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have modified or created – in other words, all project-specific and 
user-specific data is backed up. 

You should always use this method to back up all the data at regular 
intervals. The other procedures described in the section entitled 
"Backing up User-Specific Data" should be used for exceptional 
cases only. 

  

 
 

Backing up and Archiving Projects Using the 
Archive Administration Tool 

In normal circumstances, you use the archive administration tool 
provided by Allplan Building Costs to save and archive projects, item 
catalogs and element catalogs. This tool is also used to export 
projects from the current data directory or to import projects into 
this directory. 

When you are archiving a project, Allplan Building Costs saves the 
project data in a directory you specify. The original project data in 
your current data directory is not affected by this operation so that 
you can continue to edit this project without any restrictions. As 
projects are archived in compressed format, they take up less space 
in the archive (only about 10% of the original space). 

In addition, Allplan Building Costs’ archive administration tool offers 
the options to archive projects with password protection and to 
check out projects. When a project is checked out, it is saved in the 
archive directory and locked. As a consequence, the project in the 
current data directory it is no longer available for further editing. 
This way, you can make sure that this project is not being edited 
while it is checked out. More detailed information is provided in the 
section entitled "Access Rights for Archiving". 

You can use any directory that is accessible and shared for 
archiving. In other words, floppy disks or, when you are working in 
a network, directories on a central computer (= network server) can 
also be defined as archives. The number of archives is only limited 
by the amount of free space on the hard disk or by the floppy disk’s 
storage capacity. 
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Important! 
You can only save and archive projects in existing directories 
(= folders). If necessary, use Windows Explorer to create a directory 
before you back up data. 

  

 
 

Backing up Data Using the Resource 
Administration Tool 

You can use the resource administration tool to export user-specific 
data from the current directory to any archive and to import it from 
any archive into the current directory. The resource administration 
tool is a useful addition to Allplan Building Costs’ archive 
administration, which allows you to back up/archive and restore 
project-specific data. 

  

Here, the term "resources" encompasses in particular 

• conditions defined for analyzing and evaluating data sheets (cf. 
Analyze Data Sheet), 

• conditions defined for modifying column contents (cf. Change 
Column Contents), 

• conditions defined for organizing, filtering and selecting data 
records (cf. Organize and Filter), 

• predefined or user-defined macros (cf. Macros) and 

• existing notes (cf. Pin Board). 

  

When you open the Resource administration dialog box by clicking 
the Administration of resources tool on the menu, you can edit all 
resource types. When you open the dialog box by clicking the 
Administration button in any of the dialog boxes listed above 
(either directly or via the Selection of libraries dialog box), only the 
resources of the current resource type are displayed. In that case, the 
display is automatically filtered based on the resource type; this filter 
cannot be modified. 
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Backing up Other User-Specific Data 
Here, the term "user-specific data" encompasses all the data that you 
can create, modify or define while you work with Allplan Building 
Costs and that is not managed by the archive administration tool. 
This data includes addresses (see ""Address Overview" Data Sheet" 
on page 51) stored in the address database and objects (see ""Image 
Overview" Data Sheet" on page 52) in the image database. 

If you have customized default settings or data sheet settings, it is 
advisable to regularly create backups of those files, as well. Which 
files need to be included in backups is described in detail later in this 
section. 

Reports modified or created using the report designer should also be 
backed up regularly; this is particularly important before you install 
a program update. 

  

 
 

Back up and Restore the Address Database 

To back up address data 

1 Exit Allplan Building Costs. 

2 Copy the ADRESS.DBF, ADRESS.FPT and ADRESS.CDX files 
in the directory ...\Allbase\Daten\Adressen to a 
backup directory or floppy disk. 

  

To restore address data 

1 Exit Allplan Building Costs. 

2 Copy the ADRESS.DBF, ADRESS.FPT and ADRESS.CDX files 
from your backup directory to the 
...\Allbase\Daten\Adressen directory. 

ATTENTION! 
This operation replaces all the addresses currently stored in the 
address database with the addresses from the backup files! 
 

Tip: You can make your data 
sheet settings or column 
definitions available on a 
different computer. All you 
need to do is copy the 
specified files to the 
corresponding directories on 
the destination computer. 

Tip: You can also transfer 
reports to a different 
computer. How this is done is 
also described in this section. 
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Back up and Restore the Image Database 

To back up objects 

1 Exit Allplan Building Costs. 

2 Copy the BILD.DBF, BILD.FPT and BILD.CDX files in the 
directory ...\Allbase\Daten\Verw to a backup directory or 
floppy disk. 

  

To restore the objects 

1 Exit Allplan Building Costs. 

2 Copy the BILD.DBF, BILD.FPT and BILD.CDX files from your 
backup directory to the ...\Allbase\Daten\Verw 
directory. 

ATTENTION! 
This operation replaces all the objects currently stored in the image 
database with the objects from the backup files! 

 
 

Export/Back up and Restore Default Settings 

To back up default settings 

1 Exit Allplan Building Costs. 

2 Copy the EDITORS.DBF, EDITORS.FPT and EDITORS.CDX 
files in the directory ...\Allbase\Daten\Verw to a backup 
directory or floppy disk. 

  

To restore the default settings 

1 Exit Allplan Building Costs. 

2 Copy the EDITORS.DBF, EDITORS.FPT and EDITORS.CDX 
files from your backup directory to the 
...\Allbase\Daten\Verw directory. 
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Export/Back up and Restore Data Sheet Settings and Column Definitions 

To export or back up settings and column definitions 

1 Click Scheme on the Extras menu. 

The Scheme dialog box appears. 

2 In the Scheme list box, select to the scheme you want to 
export/back up. 

3 Click  Export scheme. 

4 Select the target directory in the Save as dialog box. 

5 Click Save. 

  

To restore settings and column definitions from backup 
files 

1 Click Scheme on the Extras menu. 

The Scheme dialog box appears. 

2 Click  Import scheme. 

3 Specify the source directory in the Open dialog box. 

4 Select the relevant scheme and click Import. 

 
 

Export/Back up and Restore Toolbars 

To export/back up a toolbar 

1 Close all the data sheets. 

2 On the Extras menu, point to Customize and click Office. 

The Configure office toolbars dialog box appears. 

3 Click  Export toolbar. 

4 In the Save as dialog box, select the target directory and enter a 
file name, if necessary (leave the *.ART file extension 
unchanged). 

5 Click Save. 
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To restore a toolbar from backup files 

1 Close all the data sheets. 

2 On the Extras menu, point to Customize and click Office. 

The Configure office toolbars dialog box appears. 

3 Click  Import toolbar. 

4 In the Open dialog box, set the path to the folder containing the 
toolbar (e.g. <dvd>\programs\Allplan 
BCM\Service\AddOn\CadObjekt) and select the *.art file. 

5 Click Import. 

6 In the Configure office toolbars dialog box, activate the Current 
check box. 

7 Click Close. 

8 Click Yes to confirm the prompt. 

The toolbar is added to the list of available toolbars. 

 
 

Export/Back up and Restore Reports 

To export/back up a report 

1 Open or activate the data sheet with which the relevant report is 
associated. 

2 Click  Print on the File menu and select No if asked if you 
want to recalculate everything. 

The Print dialog box appears. 

3 Choose a report edition in the Report templates list box and 
select the report you want to use. 

4 Click Export on the Edit menu. 

5 Select the target directory you want to use for archiving in the 
Browse for folder dialog box. 

6 Click OK. 
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To restore a report from backup files 

1 Click  Print on the File menu. 

The Print dialog box appears. 

2 In the Report templates list box, select the report edition into 
which you want to import the reports. 

3 Click Import on the Edit menu. 

4 Select the directory containing the reports to be imported in the 
Browse for folder dialog box and click OK. 

The Import reports dialog box appears. 

5 In the Group list box, choose the report group into which you 
want to import the reports. 

6 Select the report(s) in the Import reports dialog box. 

7 Click OK. 

Note: You can also restore the original standard reports provided by 
Allplan Building Costs. How this is done is described in detail in the 
section entitled "Restore Standard Reports". 
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Managing contracts and 
payments 

You can use Allplan Construction Costto manage your incoming and 
outgoing contracts as well as the associated invoices and payments 
in conjunction with the files you created using Allplan Building 
Costs. 

  

Note: The Allplan Construction Cost package does not come with 
Allplan Building Costs. You need to purchase it separately as a 
bonus module. However, you can install and use it independently of 
Allplan Building Costs. 

  

You can use Allplan Construction Cost to do the following: 

• Enter and display data of projects, contracts, invoices and 
payments directly in data sheets or using masks 

• Create new data records for contracts, invoices and payments and 
modify existing ones 

• Print overviews, details and forms 

• Create, modify and select report templates for printout 

• Assign and list addresses 

• Create overviews of contracts 

• Manage and complete claims 

• Calculate deductions 

• Specify a payment plan 

• Document tendering agreements 
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• Assign contracts, invoices and payments to a file and copy its 
data from Allplan Building Costs  

• Display overviews of invoices (open, paid; you can also apply a 
filter using other criteria) 

• Enter amounts 

• Assign costs to cost groups in compliance with DIN 276 

• Make requests for payment 

• Calculate payments on account 

• Final payments (guarantee issued by a bank to the client, on 
behalf of the contractor; the architect gets the security deposit  =  
defects liability; including all payments on account; taking 
deductions into account) 

• Invoices of additional services rendered (included in overview of 
payments) 

• Payments retained 

• Delete requests for payment 

• Cost monitoring (compare estimated costs with the contract 
value, the payments made and the final total payment) 

• Take current costs into account (e.g. of invoices, claims, requests 
of the client) 

• And much more! 
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User interface in Allplan Construction Cost 
The application window of Allplan Construction Cost basically 
consists of three areas: 

• The menu bar (see "Menu bar in Allplan Construction Cost" on 
page 236) (below the title bar of the window) and the toolbar (see 
"Toolbar in Allplan Construction Cost" on page 236) below. 

• The structure window (see "Structure window in Allplan 
Construction Cost" on page 237) (left pane in the application 
window) displays the existing objects in a tree structure. 

• The masks (see "Masks in Allplan Construction Cost" on page 
240) (right pane in the application window) display the data 
relevant to the current object. 
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The structure window and the masks, which vary depending on the 
object type, are always open simultaneously. If necessary, you can 
also display the Contract overview and/or Invoice overview data 
sheets (cf. "General information on data sheets"). 

When you switch data objects in the structure window, the contents 
of the masks change accordingly and you can immediately edit the 
data of the next object. 

This way, you can switch between the structure window, masks and 
data sheets as you like in order to select and edit the data of a 
different object, for example. 

  

 
 

Menu bar in Allplan Construction Cost 

The menu bar in Allplan Construction Cost consists of the following 
menus: 

  

 

  

Note: In the reference section entitled "Menus and tools in Allplan 
Construction Cost" in the online help, you will find a brief 
description of all the tools on the menus. 
 

Toolbar in Allplan Construction Cost 

The toolbar in Allplan Construction Cost is below the menu bar: 

  

 
  

You can use the buttons provided in the toolbar to activate the main 
tools without having to select a menu first. 
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The buttons in the toolbar represent the following tools: 

Icon Function Use 

 New object You can use this tool to execute the New object 
command on the File menu. 

 Copy object You can use this tool to execute the Copy object 
command on the File menu. 

 Paste object You can use this tool to execute the Paste object 
command on the File menu. 

 Delete object You can use this tool to execute the Delete 
object command on the File menu. 

 Contract data sheet You can use this tool to execute the Contract 
data sheet command on the File menu. 

 Invoice data sheet You can use this tool to execute the Invoice data 
sheet command on the File menu. 

 Run script You can use this tool to execute the Run script 
command on the Tools menu. 

 Archive You can use this tool to execute the Archive 
command on the Tools menu. 

 Print You can use this tool to execute the Print 
command on the File menu. 

   

You can display and hide as well as dock and float the toolbar 
independently of the menu bar or status bar. 

  

 
 

Structure window in Allplan Construction Cost 

General information on the structure window 

The structure window (left pane in the application window) plays a 
central role in Allplan Construction Cost. In the structure window, 
you create new objects (= folder or project, contract or payment), 
select the object whose data you want to edit using the associated 
mask or data sheet and delete objects you no longer need. 
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The structure window displays all existing data objects in a clear and 
simple manner. The individual data objects are displayed in a folder 
structure, which is similar to that in Windows Explorer (= structure 
tree). 

This way, you can sort the data objects by logical groups. The 
individual data objects are combined in folders. You can also create 
a parent folder in which you then combine a number of these 
folders. All individual folders are subordinate to the Contract admin 
data master folder. 

  

Setup and structure of the data overview 

The structure window consists of two columns: the left column - 
Name - contains the structure tree with the names of the objects. The 
right column - Number - indicates the number of the individual 
objects. 

You can sort the view so that entries are displayed in ascending or 
descending order by clicking the relevant column head. An icon 
indicates which column is being sorted and whether sorting is in 
ascending or descending order. 

  

Symbols and their meaning 

The folders and/or data objects displayed in the Overview are given 
unique symbols for identification. Depending on the type of data 
object, different graphical symbols appear: 
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Symbol Meaning 

 Contract admin data master folder 

 Folder / project data object  

 Incoming contract data object 

 Outgoing contract data object 

 Invoice / payment - open data object 

 Invoice / payment - released data object 

 Invoice / payment - paid data object 

  

To display the data objects in the structure window in a simple and 
clear manner, you can hide the structural levels you do not need at 
the moment. 

Icon Meaning 

 to display the subordinate structural level 

 to hide the subordinate structural level 

  

Context-sensitive menu control 

Clicking a data object with the right mouse button in the structure 
window opens a shortcut menu with the following tools: 

Tool Use 

New to insert a new object below the selected data 
object 

Copy to copy the selected data object to the Clipboard 

Paste to insert the data object you copied to the 
Clipboard below the selected data object 

Delete to delete the selected data object 

Print to open the report manager 

Archive to archive the selected project directly (only 
available if the selected data object is a project) 

Access rights to open a project-specific dialog box for 
managing authorizations (only available if the 
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Tool Use 

selected data object is a project) 

Invoice locked to lock/unlock the selected invoice (only 
available if the selected data object is an invoice) 

Enter client in all 
subfolders 

to copy the client address of a folder to all 
subordinate folders (only available if the selected 
data object is a project) 

  

Copying and moving with drag and drop 

You can drag and drop all the data objects (except for the master 
folder)  in order to copy or move them. Press and hold down the left 
mouse button and drag the symbol (not the text!) of the relevant 
object to the desired object. 

Then release the mouse button. A dialog box opens where you can 
specify what to do or abort the operation. This ensures that you do 
not copy or move objects inadvertently. 

  

 
 

Masks in Allplan Construction Cost 

The masks (right pane in the application window) change with the 
data object you select: when you switch data objects in the structure 
window, the contents of the masks change accordingly and you can 
immediately edit the data of the next object. 

  

There are three types of masks in Allplan Construction Cost. In 
addition, the contract data mask includes five tabs and the payment 
data mask three tabs. 

• Folder and project data mask 

• Contract data mask consisting of the Contract, Claims, 
Deductions, Bonds/amounts retained and Contract details tabs 

•  Payment data mask consisting of the Invoice, Check and 
Release tabs 
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Working with data objects 
  

In Allplan Construction Cost, the term "data objects" encompasses all 
the projects (including folders), contracts and payments. 

The procedure for creating, editing and deleting data objects is 
basically the same for all data objects. That is why the essentials of 
these functions are described in a compact form. 

  

This chapter shows how to 

• Create new data objects 

• Copy existing data objects 

• Edit data objects 

• Delete data objects you no longer need 

  

 
 

Creating new data objects 

We will use a new contract as an example to show you how to create 
a new data object. The procedure described here is also used for 
creating new folders, projects or payments. 

Create a contract for each contract awarded to a contractor. The 
program automatically assigns the new contract to the project in 
which you create it. 

The new data object is automatically inserted below the selected 
level in the structure. You can then open the data object to enter all 
necessary data. 

  

Important! 
Depending on the selected level, the choice of object types you can 
create is limited to specific types. This ensures that the structure has 
a uniform appearance. 
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Selected level in the 
structure 

Possible data object 

 Contract admin data 
master folder 

Folder or project 

 Folder or Project data 
object 

Contract (incoming and outgoing) 

 
Or 

 

Incoming contract or 
Outgoing contract data 
object 

Invoice, payment on account, final payment or 
other invoice 

 
Or 

 
Or 

 

Invoice / Payment data 
object 

You cannot create a new data object below this 
data object 

  

 
 

Copying data objects 

To enter similar objects (folders and contracts only; not possible with 
individual invoices), you can save time by copying the data object 
and then modifying this copy. 

  

 
 

Editing data objects 

Each data object is modified in the appropriate mask. 

  

 
 

Deleting data objects 

If you have inserted a data object at the wrong position or if you 
need to make changes, you can quickly and easily remove the 
relevant data object from the structure window. 
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Working with Data Sheets 
Data sheets present an overview of all the data you have entered for 
projects, contracts and invoices. 

There are two types of data sheets: contract overviews and invoice 
overviews. These two data sheets work in the same way; only the 
data they access differs: the contract data sheet is based on the 
contract table and the invoice data sheet is based on the invoice 
table of the Allplan Construction Cost database. 

Data can be combined, analyzed and evaluated in data sheets. You 
can control the layout of your data sheets and narrow down the 
contents and type of the data displayed by setting filters. You can 
also create custom data sheets for contracts, invoices and project 
overviews or modify the existing data sheets. 

Note: Data sheets only display data. To edit data, use masks. 
 

Creating new data sheets 

Open the Layouts of data sheets dialog box to create new data 
sheets. 

  

 
 

Setting Up Data Sheets 

Open the Layouts of data sheets dialog box to modify existing data 
sheets. 

  

General definitions for data sheets 

Enter a name for the data sheet in the List of layouts area of the 
Layouts of data sheets dialog box (= left pane). You can use the 
name you specify here to set the data sheet's layout in the Layout 
list box later on. 

Here, you can also define how to sort and/or filter the data in the 
list. 
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Setting up data sheet columns 

You can use the functions and fields in the Edit columns area of the 
Layouts of data sheets dialog box (= right pane) to modify the 
appearance of the data sheet. For example, you can add new 
columns, rename columns and display or hide columns. 

All changes you make are applied the next time you open the data 
sheet. 

For operation columns, you need to specify a formula. You can use 
the variables in the fields of the database in conjunction with 
arithmetic operations and functions used by the FoxPro 
programming language. You can insert an unlimited number of 
operation columns. 

Please refer to the section entitled "Using Fields and Variables" in 
the "Editing Reports" chapter for a list of the available variables that 
can be used in the fields of the database. 

  

 
 

Choosing layouts for data sheets 

You can select a predefined or custom layout for each data sheet. 

Note: Please refer to the "Setting up data sheets (on page 243)" 
section to learn how to define custom layouts or modify existing 
layouts. 

  

 
 

Sorting data sheets 

You can sort the contents of data sheets by column. 
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Filtering data sheets 

You can filter the contents of data sheets based on predefined or 
custom filter conditions. 

Here, the term "filtering" means that the specific criteria you define 
for all the lines of a data sheet must be met so that the relevant line 
is displayed. 

  

  

 
 

Defining filter expressions 

There are three methods for defining filter expressions: 

• You can enter filter expressions directly in the data entry field at 
the bottom of the Data sheet filter dialog box. 

• You can use the expression editor to define filter expressions. 

• You can use filter expressions you have already defined in the 
library. 

  

The result of a filter expression must be a logical value (TRUE or 
FALSE). To achieve this, use the Boolean operators ( =, <, >, <= or 
>=) to compare two values or use a function that returns a logical 
value, e.g. EMPTY(). Please note that the two values (entire 
expressions or individual fields or variables in the database) you 
want to compare need to be of the same format (character, numeric 
or date). The format of the fields in the database and the return 
values of the functions are described in the expression editor. 

 

Simple fields or variables can be linked. 

• Numerical data: 
You can use all arithmetic operations, numerical values, 
mathematical functions (see Functions and variables list box in 
the expression editor) to create an expression. 
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• Characters: 
Text (characters) can only be added. You can use the character 
functions (see Functions and variables list box in the expression 
editor). When you enter text in expressions, please keep in mind 
that characters must be enclosed in quotation marks. See 
example: "this is text" 

• Date values: 
Date values can be added and subtracted. You can use the date 
functions (see Functions and variables list box in the expression 
editor). You cannot enter a date directly in an expression. You 
need to convert it to the date format using the CTOD function. 
Example: CTOD("20.02.2000") 

You can use the Boolean operators .AND. and .OR. to link simple 
logical expressions. You can also use parentheses. .NOT. results in a 
logical negation (i.e. the expression is true if the following value is 
not true). 

  

 
 

Creating new filters 

Predefined as well as custom filter conditions are managed in the 
library. 

You can define a new filter straightaway by entering the filter 
conditions directly. You can also use the expression editor, which 
offers you predefined database fields, functions and operators, to 
define filter expressions in a clear and simple manner. 

Note: You can access the filters created in the library right from the 
Layouts of data sheets dialog box. This way, you can define a filter 
that will then be used automatically when you open the relevant 
data sheet. 
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Managing projects 
The structure window displays all projects in a clear manner. You 
can open existing projects as well as create new projects. 

You can use the Folder and project data mask to enter details for 
each project 

Before you create a new project, select the Contract admin data 
master folder or the folder for the construction project to which you 
want to assign the new project. 

Tip: If you require several projects that follow the same or similar 
scheme, create a "sample project". You can then simply copy this 
"sample project" and modify this copy. 

  

 
 

Managing contracts 
The structure window displays all the contracts you have created for 
the individual projects in a clear manner. You can create new 
contracts as well as open and edit existing contracts. 

As you can create and manage incoming contracts in addition to 
"normal" outgoing contracts, you need to make a clear distinction 
between these two types in terms of symbols and algebraic signs. 

  

Symbols 

The following convention is used to indicate contracts in the 
structure window and in the Contract overview and Invoice 
overview data sheets: incoming contracts are displayed in blue and 
outgoing contracts are displayed in red (see also "Structure window 
in Allplan Construction Cost (on page 237)"). 

  

 



 

248 Managing contracts and payments Allplan BCM   

Algebraic signs 

In Allplan Construction Cost, outgoing contracts and incoming 
invoices are always represented a positive sign (+). 

According to this rule, incoming contracts and outgoing invoices 
would get a negative sign (-). Strictly speaking, however, incoming 
contracts and outgoing invoices generate income (i.e. capital inflow) 
while outgoing contracts and incoming invoices incur costs (i.e. 
capital outflow). 

It is therefore up to you to make a decision about the sign. You can 
define the sign setting globally for all folders (= projects) in Allplan 
Construction Cost or make this setting separately for each main 
folder (= each project). More information is provided in the section 
entitled "Making sign settings for contracts". 

The Contract overview and Invoice overview data sheets display the 
amounts for incoming and outgoing contracts and the relevant 
invoices/payments in accordance with the sign setting you have 
made. 

  

Creating and editing contract data 

Start by creating a new contract. You can then enter data for this 
new contract. 

To edit the details of a contract, use the Contract data mask, which 
consists of the Contract, Claims, Deductions, Bonds/amounts 
retained and Contract details tabs. 

  

 

 

 

Making sign settings for contracts 

Use the Sign settings (Settings dialog box, Contract admin tab) to 
decide for yourself which algebraic sign you want to apply to 
contracts. You can define the sign setting globally for all folders 
(= projects) in Allplan Construction Cost or make this setting 
separately for each main folder (= each project). 

 

Tip: For example, you can 
create general standard 
contracts in a "sample 
project". You can then use 
these contracts as a basis for 
other contracts. All you need 
to do is copy the relevant 
standard contract to the 
current project and modify 
the data in this copy. 
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Defining the sign setting globally 

The Global for all folders option applies the same setting to all 
folders (= projects) in Allplan Construction Cost. 

  

Setting the sign separately for each folder 

The In main folder option allows you to set the sign separately for 
each main folder (= each project). 

In other words, the sign is not set globally but you can set it 
separately for each main folder. In this context, the main folder is 
the folder of the highest hierarchical level; subordinate folders 
automatically get the sign setting of the main folder. 

If you decide to set the sign separately for each main folder (= each 
project), you can control this setting using the Use opposite sign 
option in the  Folder and project data mask. 

The following illustrations will make things clearer. 

  

Sign setting when the Use opposite sign option is deactivated: 
incoming contracts get a negative sign; outgoing contracts are given 
a positive sign. 
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Sign setting when the Use opposite sign option is activated: 
incoming contracts get a positive sign; outgoing contracts are given a 
negative sign. 

 
  

 
 

Entering basic contract data freely 

You can create a contract without having to assign this contract to a 
file or title of a project in Allplan Building Costs. 

Rather, you can enter the following basic contract data freely: 

• Contract number, 

• Contract name, 

• Contract date, 

• Tender value, 

• Discount (as a percentage), 

• Discount period, 

• Rebate (as a percentage), and 

• VAT. 

Please note that the data for the estimate and the budget can only be 
entered here. 
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Transferring contract data from Allplan Building Costs 

New contracts are automatically assigned to the current project. In 
addition, you can assign contracts to a file or title from Allplan 
Building Costs.   

Note: A file usually consists of exactly one contract. If a file is 
subdivided into lots, you should select a folder instead of a file when 
creating the file in Allplan Building Costs. In addition, add file lines 
to refine the structure of the subordinate lots. 

To transfer data from a file and integrate the contract in the 
hierarchical structure, you need to assign a contract to a specific file 
or title.  

The total price of the file from the "Awarding" phase is used as the 
tender value for the contract if the Use tender value option is active 
in the Assign file or title dialog box. If the total price of the file 
differs from the tender value, disable this option. 

The Use reduction/additional charge as rebate option allows you to 
use these values. The tenderer is entered as the contractor when you 
have selected the relevant option in this dialog box. In addition to 
the name, the contractor's address is also assigned to the contract. 

You can also transfer the discount specified for checking quotations. 
Furthermore, the total sum of the file can be used as the budget and 
the short text of the selected file or title as the name of the contract. 

Note: The tenderer to be awarded the contract must be created in 
Allplan Building Costs and his/her address must be entered. 

To apply a structure to the contract, you can enter a number and 
text in the data entry boxes or assign a structure from a project 
created in Allplan Building Costs. Adopting the number and 
associated text from Allplan Building Costs allows analyses in 
compliance with the cost groups of DIN 276. 

 
 

Entering addresses of clients and contractors 

You require the complete addresses and bank details of all the 
persons involved in order to manage correspondence and payments. 
You can enter the address of the client in the Folder and project data 
mask and the address of a contractor in the Contract data mask. 
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You can enter the data directly into the corresponding fields of the 
masks. But it is much easier to use the Address selection tool, which 
immediately provides all the addresses. 

Note: When you create a new outgoing contract, the address of the 
client is transferred automatically from the project data. 

 
 

Entering claims 

Claims include items that have come up after a contract has been 
awarded. If, for example, additional services are rendered for an 
existing contract or alternative (more expensive) materials are used, 
you have to document these extra costs as claims. 

You can create several claims for a contract. To enter claims for the 
current contract, use the Claims tab. 

Important: The total of a contract includes only claims that have the 
"approved" status; in other words, only approved claims will increase 
the contract value. 

 
 

Entering contractual and other deductions 

Here, you can document contractual deductions in a table. 
Deductions must be entered in the Deductions tab. 

The deductions you enter do not reduce the contract value. They are 
not directly connected with the contract services to be rendered. 
However, deductions are subtracted from the amount invoiced 
(usually from the final payment) instead of having the contractor 
pay these amounts separately. This is for practical reasons. 

You can enter deductions as a percentage or lump sum. Contractual 
deductions entered on a percentage basis can be included 
proportionally in each payment on account or they are not taken 
into account until the final payment. You can choose between these 
two options later when you edit invoices. 

  

 
 



 

Integrated solutions  Managing contracts and payments 253 
 

Entering Bonds and Amounts Retained 

You can enter bonds and amounts retained in the Bonds/amounts 
retained tab. 

Amounts retained are entered as a percentage of the contract value. 
The security deposit can be included in all payments on account i.e. 
it is to be subtracted proportionally from the invoice total and 
retained. The total amounts retained so far are credited against the 
invoice total in the final payment. In other words, they are credited 
to the invoicing party's account. You can enter an unlimited number 
of bonds for a variety of purposes. 

You can explicitly specify the following securities: 

• Security for contract performance 
This amount, which is deposited before construction begins, is to 
guarantee the faithful performance of the contract. It can be 
covered by a bank guarantee.  

• Defects liability 
An amount agreed is subtracted from the final payment and 
retained in case of warranty claims. It can also be covered by a 
bank guarantee. The defects liability amount, which is part of the 
building contract, is usually set up together with the contract and 
included in calculating the final payment. 
 
Important! In the Security deposit amounts in general and 
Security deposit amounts of project reports, a defects liability 
(indicated by S in the report) is only replaced by a bond 
(indicated by B in the report) if the defects liability is marked 
with Yes in the Bond column (Amounts retained table) and the 
relevant bond contains the words "defects liability" (please pay 
attention to the correct spelling!) in the Name column (Bonds 
table). 

• Security deposit for payments on account 
Enter the security deposit (as a percentage) that can be subtracted 
from each payment on account and retained during construction 
work; this amount can be specified in advance (usually 10%). 
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Managing invoices and payments 
The structure window displays all the invoices you have created for 
the individual contracts of a project in a clear manner. You can 
create new invoices as well as open and edit existing invoices. 

To edit the details of an invoice, use the Payment data mask, which 
consists of the Invoice, Check and Release tabs. 

  

Basically, handling invoices requires three important steps: 

• Enter data 

• Check the invoice 

• Release the invoice 

  

Payments are arranged in four groups: 

• Payments on account 

• Partial final payments 

• Final payments 

• Other invoices 

In this context, the status of an invoice should be understood as the 
progress of invoicing or payment. This way, you can specify whether 
the invoice in question is still open, released or whether the client 
has already paid it. 

You can only specify the status of an invoice using the Status list 
box in the Release tab of the Payment data mask. 

  

First you need to create a new invoice. You can then enter details for 
it. Start by selecting the contract to which you want to assign the 
new invoice. To edit an existing invoice, select it in the structure 
window. 

  

 

Tip: For example, you can 
create general standard 
invoices for standard 
contracts of a "sample 
project". You can then use 
these invoices as a basis for 
other invoices. All you need 
to do is copy the relevant 
standard invoice to the 
current contract and modify 
the data in this copy. 
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In addition, this chapter shows how to 

• Enter basic invoice data 

• Check payments on account and other payments 

• Release payments 

• Split amounts 

 
 

Entering basic invoice data 

Invoices are always assigned to a specific contract. 

When you create a new invoice for a contract, the program 
automatically transfers various pieces of data to the invoice. The 
following data is taken from the contract. However, you can change 
it, if necessary: 

• VAT 

• Discount rate 

• Bank details of contractor specified in contract 

 
 

Checking payments on account and other payments 

The Check tab lists all the amounts associated with this invoice. 

After having entered the net amount of the invoice in the Invoice 
tab, you can calculate the amount to be paid in the Check tab. All 
the deductions, rebates, amounts retained you have entered so far are 
included in calculating the amount payable. In addition, the discount 
rate specified in the contract is taken into account. 

The program calculates the gross amount of the invoice based on the 
percentage defined for VAT. The amount payable is displayed with 
and without discount (standard calculation). 

Important: 
Clicking the Update button causes the program to update the 
calculation, taking all the current data into account. 

Note: The amount payable is automatically transferred to the Release 
tab. 
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Releasing amount for payment 

You can use the Release tab to select or enter addresses, bank details 
and the amount to be paid. In addition, you can split the amount. 

When you change the status from Open to Released, the amount 
calculated is automatically used as the amount released if the latter 
is zero. Wen you change the status from Released to Paid, the 
amount released is automatically used as the amount paid if the 
latter is zero. 

Each time you change the status of an invoice, the program opens 
the Invoice data dialog box, where you can specify whether the 
amount released or paid is displayed with or without discount. 

  

 

Splitting amounts 

The client may ask you to split amounts. To do this, you can use the 
Split amount of invoice dialog box. 

  

First you need to specify which amount you want to split. You can 
split the following amounts in this dialog box: 

• Invoiced 

• Calculated 

• Released 

• Paid 

• Checked 

  

Use the table to split the amount available. In each line of the table, 
you can associate an amount split with a classification and a name. 
You can use a project to classify the amounts split or simply enter 
you own classification and name directly in the table.  

Note: You can split amounts in compliance with DIN 276. For this, 
you need to save the DIN 276-compliant classification as a project 
first. 
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Printing project, contract and invoice data 
  

Special reports have been predefined for the individual areas 
(= report templates for printouts). They provide a quick and easy way 
to print out the data of the object currently selected in the tree 
structure (contract admin data, project, contract or invoice) in 
various ways. 

In the reports, you can make different settings, including 

• which data of the object is to be printed out, 

• how the data should be arranged and which additional text (e.g. 
heading, list heads) is to be added, 

• what layout the printout should have (e.g. footer text and logo in 
header), etc. 

Various predefined reports are available for each object type. This 
way, you can print out not only the values specified in the contract, 
but also details or claims by choosing the relevant reports. 

As it is hard to remember every little detail in every report, you can 
look up the most important information on each report directly in 
the Report manager dialog box. For information on the individual 
areas in the report manager, see "Areas and reports for printing". 

The report manager helps you to select the appropriate report and set 
the print options. The Report manager dialog box (in the General 
settings area and on the Edit menu) provides various options for 
defining output and editing reports. The list box shows you which 
reports are available for the current area or object. Select a report 
first and check or modify its settings. You can then start printing. 

Note: You can use the report designer to modify and customize 
reports or to create new reports. How this is done is described in 
detail in the "Editing reports" section. 
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Defining general print settings 

You can set general print options in the General settings area of the 
Report manager dialog box. 

To define the general print settings 

1 Open the Report manager dialog box. 

2 In First page, enter a number for the first page to be printed. 

3 In Date, enter the date to be used in the printout. 

4 With the Settings dialog box check box, you can choose whether 
you want to display the Windows Print dialog box prior to 
printing (so that you can make printer settings, for example). 

5 In the Layout list box, you can select the report layout (logo for 
header, text for footer) you want to use for the current printout 
(see also "Selecting a layout template"). 

 

Areas for printing 

Note: Information on the reports that are available in the individual 
areas is provided in the overview of predefined reports. 

  

"Contract admin data" area 

The program selects this area when you open the report manager for 
printing project-independent analyses (the  Contract admin data 
entry is selected in the structure window). 

  

"Folders and projects" area 

The program selects this area when you open the report manager for 
printing a project (a  Folder / project data object is selected in the 
structure window). 

The standard table for printing consists of one line containing the 
data of the current project. 
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"Incoming contracts" area 

The program selects this area when you open the report manager for 
printing an incoming contract (an  Incoming contract data object 
is selected in the structure window). 

The standard table for printing consists of a list containing all the 
data of the contract table. In addition, the data of the associated 
project is available. 

Report templates that only require contract data must place this data 
in the report header, page header or group header of a predefined 
data group (e.g. use the grouping nesting order: 1). Deductions, 
claims or bonds are output in the detail section or the group 
header/footer of a variable data group (e.g. use the grouping nesting 
order: AD_IDN). 

  

"Outgoing invoices" area 

The program selects this area when you open the report manager for 
printing an outgoing invoice or an incoming payment (an  
Invoice / payment data object is selected in the structure window). 

The standard table for printing consists of a list of the calculation 
rule of the current invoice (is equivalent to the contents of the table 
in the Check tab) containing the data of the current invoice and the 
associated contract. In addition, the data of the associated project is 
available. 

  

"Outgoing contracts" area 

The program selects this area when you open the report manager for 
printing an outgoing contract (an  Outgoing contract data object 
is selected in the structure window). 

The standard table for printing consists of a list containing all the 
data of the contract table. In addition, the data of the associated 
project is available. 

Report templates that only require contract data must place this data 
in the report header, page header or group header of a predefined 
data group (e.g. use the grouping nesting order: 1). Deductions, 
claims or bonds are output in the detail section or the group 
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header/footer of a variable data group (e.g. use the grouping nesting 
order: AD_IDN). 

  

"Incoming invoices" area 

The program selects this area when you open the report manager for 
printing an incoming invoice or an outgoing payment (an  
Invoice / payment data object is selected in the structure window). 

The standard table for printing consists of a list of the calculation 
rule of the current invoice (is equivalent to the contents of the table 
in the Check tab of the Payment data mask) containing the data of 
the current invoice and the associated contract. In addition, the data 
of the associated project is available. 

  

"Lists: contracts" area 

The program selects this area when you open the report manager 
from the  Contract overview data sheet. 

All the fields of the contract table and the associated data of the 
project table are available, regardless of the data sheet setting. The 
manner in which the data is displayed depends on the current filter 
and sorting. 

  

"Lists: invoices" area 

The program selects this area when you open the report manager 
from the  Invoice overview data sheet. 

All the fields of the invoice table and the associated data of the 
project table and contract table are available, regardless of the data 
sheet setting. The manner in which the data is displayed depends on 
the current filter and sorting. 

  

"Budget administration" area 

The program selects this area when you open the report manager 
from the Budget administration dialog box. 
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Overview of predefined reports 

The section that follows outlines the reports available in the 
individual areas. 

Tip: You can look up the most important information on each report 
directly in the Report manager dialog box. Simply select the report, 
click Edit and then click Information. 

Reports for the "contract admin data" area: 
• Overview 

• Open invoices in general 

• Securities in general 

Reports for the "folders / projects" area: 
• Bonds + securities 

• Claims for projects 

• Open invoices in project 

• Project addresses 

• Project data 

• Securities of project 

Reports for the "incoming contracts" area: 
• Building contract 

• Details of contract 

• Claims for contract 

• Values specified in contract 

Reports for the "outgoing invoices" area: 
• Cover sheet of outgoing invoice 

• Invoice 

• Invoice amounts split 

• Payment release 

• Payment overview 
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Reports for the "outgoing contracts" area: 
• Building contract 

• Details of contract 

• Claims for contract 

• Values specified in contract 

Reports for the "incoming invoices" area: 
• Cover sheet 

• Invoice amounts split 

• Payment release 

• Payment overview 

Reports for the "lists: contracts" area: 
• List of contracts 

• List of contracts including companies 

• Cost overview, hierarchy 

• Cost overview, folders with DIN-compliant cost groups 

• Cost overview, folders 

Reports for the "lists: invoices" area: 
• Itemized invoice 

• List of invoices with DIN-compliant cost groups 

• List of invoices for project 

• List of invoices, A4 landscape 

• List of invoices 

• Overview of deductions 

• Payments in period 

Reports for the "budget administration" area: 
• Cost 

• Cost forecast 

• Estimate and budget 
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Archiving and Backing up Data 
You can archive or back up projects created in Allplan Construction 
Cost at any time. Be sure to always archive or back up a project 
when it is complete. You can also store your settings, custom reports 
or scripts in the archive. 

This means that the projects and other data are saved in the path you 
have selected for the archive and can still be managed. If necessary, 
you can retrieve projects you have already archived and edit them. 

You can use the Archive administration dialog box to manage 
archived data. The Allplan Construction Cost data and Archived 
data list boxes display the projects and library data in the current 
data folder and in the archive folder, respectively. 

You can quickly and easily archive projects using the shortcut menu. 
All other data must be archived using the archive administration. 

  

 
 

More Allplan Construction Cost tools 
 

Authorizations 

Allplan Construction Cost provides special tools for managing 
authorizations, allowing you to control user access to projects, 
records and other data. This way, you can prevent unauthorized 
access and thus protect data from inadvertent changes. 

  

General or user-specific rights 

You can define and assign authorizations for individual users or user 
groups. This way, you can define who is authorized to edit or view 
specific projects by assigning read approval, read/write approval or 
no approval to every individual user. 
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Project-specific rights 

To assign a specific right to all users, just click the relevant button 
under Set permissions for all users to. 

To define a right for an individual user only, click the relevant entry 
in the Permission column. This opens a shortcut menu where you 
can select an access right. 

Write access includes read access. In other words, selecting write 
access automatically activates read access. When you deactivate read 
access, write access is also deactivated. 

  

 
 

User-definable default settings 

In Allplan Construction Cost, you can define various defaults that 
are saved permanently. 

  

You can define default settings in the Settings dialog box: 

• In the Default settings tab: VAT rate, currency, data folder. 

• The Data sheet tab lets you set the contents and appearance of 
the Contract overview and Invoice overview data sheets. 

• In addition, you can make default settings for calculating and 
checking data in the Invoices and contracts tab. 

• The "contract admin" feature, which allows you to manage 
incoming contracts in addition to outgoing contracts, can be 
activated and deactivated in the Contract admin tab. You can 
also define the sign setting for the "contract admin" feature. 

• In the Contract defaults tab, you can define the defaults for 
creating new contracts. 

• The options in the Custom text fields tab let you name the 
custom text and note fields for contracts and invoices. This way, 
you can create your own text fields. 

  

 
 

Tip: Project-specific rights are 
managed in almost exactly 
the same way as in Allplan 
Building Costs.   
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Creating and executing scripts 

A script includes one or more lines of program code which are used 
to execute custom designed program functions. Scripts you define 
must comply with the language conventions of the Visual FoxPro 
programming language. 

Detailed information on this topic is provided in specialist literature. 

Note: The descriptions of the fields in the database and functions 
and variables are also useful when it comes to creating scripts. 

  

 
 

Exporting data in Excel format 

Besides contract data (from the Contract overview data sheet) and 
invoice data (from the Invoice overview data sheet), you can also 
export budget data of a project from the Budget administration 
dialog box in Excel format. 
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Editing Reports 
The report designer provides a convenient way of editing reports. 

This chapter provides detailed information on the following topics: 

• The report designer in general and how to open this tool 

• Creating and modifying reports 

• Customizing reports 

• Adding fields and defining variables 

• Defining conditions for printing objects 

• Defining specific controls for reports 

• Exporting/backing up and restoring reports 

  

 
 

What is the Report Designer? 
Reports are used to specify what is to be printed out and how: 
Reports define the design, contents and graphical appearance of 
printouts as well as the objects, text and fonts in printouts. 

In other words, the report designer is a comfortable tool you can use 
to define the form and contents of reports and consequently of 
printouts. You can modify existing reports or create new reports. 

  

The sections that follow provide detailed information on 

• the layout window of the report designer, 

• the tools in the report designer and 

• the toolbars in the report designer. 
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Layout Window of the Report Designer 

When you open the report designer, the program automatically 
displays the layout window (Allplan Construction Cost on the left, 
Allplan Building Costs on the right) and the Report Designer and 
Report Controls toolbars (to show the other two toolbars, click the 

 Layout and  Color Palette icons on the Report Designer 
toolbar). 

 

 

 

 

 

 

 
  

To edit the printout templates, you can use the File, Edit, Format and 
Report menus and the toolbars (cf. sections entitled "Tools in the report 
designer" and "Toolbars in the report designer"). 

You can use the layout window to insert objects (text, fields, lines, 
rectangles, images etc.) in reports or edit existing objects. The file 
name of the report is displayed in the title bar of the layout window. 
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The layout window itself shows the individual sections of a report 
and the objects in these sections. You can quickly and easily define 
the size of sections - all you need to do is position the cursor on the 
bar with the section name displayed at the bottom of each section so 
that the cursor becomes a double-headed arrow. Now press and hold 
the left mouse button and drag to change the size. 

Note: The field names are displayed in the layout window of the 
report designer. The print preview and the final printout include the 
actual data from the data sheet. 

Reports consist of individual sections, which are separated by bars. 
All these sections together define the printable area of the paper.  

Each section, which is delimited by a bottom bar displaying the 
name of the section, can include objects. The sections are described 
in the table below. 

Section Meaning 

Page header The page header appears at the top of every 
page. Besides predefined information (e.g. 
heading and list heads), it also includes variable 
data (e.g. number of pages and date). 

Detail The detail section contains the fields that are 
associated with the data in the data sheets. This 
section is printed out for every data record. 

Page footer The page footer appears at the bottom of every 
page. In addition to text, the footer can also 
include variable data (e.g. number of pages and 
date). 

Group header/footer Group header and group footer are only 
available when data has been grouped by 
common characteristics and contain information 
that is only relevant to the data group in 
question. The group footer may include a sub-
total, for example. 

Optional Bands The report title and report summary are defined 
separately and appear at the beginning and/or 
end of a printout (e.g. cover sheet and/or final 
note) or on separate pages (optional). 
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Tools in the Report Designer 

The tools needed for editing layout templates are provided on the 
File, Format and Report menus and on the standard Windows Edit 
menu (not described here). 

 
 

Tools on the "File" Menu (report designer) 

You can use the tools on the File menu to save modified or new 
reports (Allplan Building Costs only), discard your most recent 
changes and define the page layout. 

  

Tool Use 

Save (Allplan Building 
Costs only) 

You can use this tool to save the changes you 
made to a report. 

Save As HTML (Allplan 
Building Costs only) 

You can use this tool to save reports in HTML 
format. 

Revert You can use this tool to discard the changes 
you have made to a report. You can go back 
(undo) as many steps as you want, as far back 
as the last time the report was saved. 

Page Setup You can use this tool to define the page layout 
of a report. 

Print Preview (Allplan 
Construction Cost only) 

You can use this tool to display the print 
preview. 

Print You can use this tool to print out reports for 
checking purposes. 

Exit (Allplan 
Construction Cost only) 

You can use this tool to close the report 
designer. 

 
 

Tools on the "Format" Menu 

The Format menu includes tools you can use to edit objects in 
reports. 

These tools can only be applied when at least one object is selected. 
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Tool Use 

Align You can use this tool to align selected objects. 
Choose one of the options provided on the 
submenu. 

Size You can use this tool to modify the size of 
selected objects. Choose one of the options 
provided on the submenu. 

Horizontal Spacing You can use this tool to modify the horizontal 
spacing of selected objects. 

Vertical Spacing You can use this tool to modify the vertical 
spacing of selected objects. 

Bring to Front You can use this tool to move the selected 
objects to the front. 

Send to Back You can use this tool to move the selected 
objects to the back. 

Group You can use this tool to group selected objects. 

Ungroup You can use this tool to explode the selected 
object group into its constituent objects. 

Snap to Grid You can use this tool to place objects so that 
they are aligned with the grid for snapping 
points (option enabled). Alternatively, you can 
place them freely (option disabled). 

Set Grid Scale  You can use this tool to set parameters for the 
point snap grid. 

Font You can use this tool to define the font or font 
size for selected text objects. 

Foreground Color You can use this tool to define the pen color for 
selected text or drawing objects. 

Background Color You can use this tool to define the background 
color or fill color for selected drawing objects. 

Text Alignment You can use this tool to specify whether the selec-
ted text objects are left-aligned, right-aligned or 
centered or define the spacing between lines. 

Fill You can use this tool to apply hatching styles 
or fills to rectangles and rectangles with 
rounded corners. 

Pen You can use this tool to define the linetype and 
line width for selected lines, rectangles and 
rectangles with rounded corners. 

Backstyle You can use this tool to specify whether 
selected objects are fully opaque or transparent. 
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Tools on the "Report" Menu 

The Report menu contains tools for creating new objects or reports. 

  

Tool Use 

Quick Report You can use this tool to insert all necessary fields 
in a new report. This tool is only available when 
the detail section is empty. 

Run Report You can use this tool to print out the report as 
currently set for checking purposes. You do not 
need to save it. 

Print Preview You can use this tool to show the report in print 
preview 

Load Data Environment You can use this tool to define the data 
environment; however, this is not necessary for 
Allplan Building Costs and Allplan Construction 
Cost. 

Private Data Session You can use this tool to activate database 
functionality that is not supported by Allplan 
Construction Cost. This option should always be 
disabled. 

Printer Environment You can use this tool to activate database 
functionality that is not supported by Allplan 
Construction Cost. This option should always be 
disabled. 

Optional Bands You can use this tool to insert the "report title" 
and/or "report summary" sections. 

Data Grouping You can use this tool to group selected objects. 

Variables You can use this tool to define variables for 
reports. 

Default Font You can use this tool to make default settings for 
the font and font size, which are to be used for 
new text objects. 

Edit Bands You can use this tool to select individual sections 
whose parameters you want to edit. 

Insert Control You can use this tool to insert control elements. 

Properties You can use this tool to set the paper size, page 
layout and default font. 
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Toolbars in the Report Designer 

The report designer features four toolbars for quick access to 
frequently used tools: the Report Designer, Report Controls, Color 
Palette and Layout toolbars. 

They provide easy-to-use tools for editing reports. 

  

 
 

Buttons in the "Report Designer" Toolbar 

When you click one of the buttons, the program selects the relevant 
tool or displays an additional toolbar. 

 

Icon Function Use 

 Data Grouping You can use this tool to group selected objects. 

 Data environment You can use this tool to define the data 
environment, which is not necessary for Allplan 
Building Costs. 

 Page setup You can use this tool to set the paper size, page 
layout and default font. 

 Report controls You can use this tool to show and hide the 
Report Controls toolbar (see "Buttons in the 
"Report Controls" Toolbar" on page 273). 

 Color palette You can use this tool to show and hide the Color 
Palette toolbar (see "Buttons in the "Color 
Palette" Toolbar" on page 274). 

 Layout You can use this tool to show and hide the 
Layout toolbar (see "Buttons in the "Layout" 
Toolbar" on page 275). 
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Buttons in the "Report Controls" Toolbar 

 

When you activate a tool on the Report Controls toolbar by clicking 
a button, the program executes the relevant function and then 
automatically displays the  marker again. 

Note: However, you can also "fix" tools: double-click to select a tool 
or select a tool and then click  Repeat control element. 

Icon Function Use 

 Marker You can use this tool to select objects. 

 Text tool You can use this tool to enter or modify text (see 
"Inserting Text Objects" on page 282). 

 Field tool  You can use this tool to insert fields. 

 Line tool  You can use this tool to insert horizontal or 
vertical lines. 

 Tool for rectangles  You can use this tool to insert rectangles. 

 Tool for rectangles 
with rounded corners  

You can use this tool to insert rectangles with 
rounded corners. 

 Tool for OLE objects You can use this tool to insert OLE objects 
(images and sketches) (see "Insert Images and 
Sketches" on page 283). 

 Repeat control element You can use this tool to fix the active tool and 
insert several objects of the same type. 

 
 

Buttons in the "Color Palette" Toolbar 
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Icon Function Use 

 Foreground color You can use this tool to define the foreground 
color for objects. 

 Background color You can use this tool to define the background 
color or fill color for objects. 

 Other colors You can use this tool to open a dialog box in 
which more colors are presented for selection. 

   

 
 

Buttons in the "Layout" Toolbar 

 

Icon Function Use 

 Align left sides You can use this tool to align the selected 
objects left. 

 Align right sides You can use this tool to align the selected 
objects right. 

 Align top edges You can use this tool to align the selected 
objects so that their top edges are flush. 

 Align bottom edges You can use this tool to align the selected 
objects so that their bottom edges are flush. 

 Align vertical centers You can use this tool to align the selected 
objects so that their vertical axes are centered. 

 Align horizontal 
centers 

You can use this tool to align the selected 
objects so that their horizontal axes are centered. 

 Same width You can use this tool to assign the same width to 
the selected objects. 

 Same height You can use this tool to assign the same height 
to the selected objects. 

 Same size You can use this tool to assign the same size to 
the selected objects. 
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Icon Function Use 

 Center horizontally You can use this tool to horizontally center the 
selected object. When you select several objects, 
they are centered as a group. 

 Center vertically You can use this tool to vertically center the 
selected object. When you select several objects, 
they are centered as a group. 

 Bring to front You can use this tool to move the selected 
objects to the front. 

 Send to back You can use this tool to move the selected 
objects to the back. 

 

 
 

Creating and Modifying Reports 
The form and contents of printouts can be modified in different 
ways: 

• You can copy an existing report and then modify this copy. The 
original report is not affected by this operation. 

Important! 
This procedure must be used for all original Allplan BCM reports 
because these reports cannot be modified! 

• You can modify an existing report directly. 

Important! 
This approach is only available with your own reports and copies 
of the original reports! 

• You can create a new report. 

Copying a report 

If an existing report is more or less sufficient for the task at hand 
and you only need to make minor changes, you can simply copy the 
relevant report and modify the copy. 

Important! 
This procedure must be used for all standard reports provided by 
Allplan Building Costs in order to keep the originals. 
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Modifying an existing report 

To modify an existing report, open the relevant report in the report 
designer, make changes and save the modified report. 

Note: To change the original Allplan BCM reports, you need to copy 
them first and then modify the copies. 

Creating a new report 

To create custom reports, it is best to start from scratch. 

In other words, create a new report and adapt it to your needs and 
requirements. 

 

 
 

Customizing Reports 
The report designer offers various options for defining the graphical 
appearance of printouts. In particular, you can 

• Define the page layout 

• Add a report title and report summary 

• Specify the height of the individual sections 

• Select, group and position objects and change their size 

• Enter and format text (e.g. headings or list heads) 

• Enhance the visual appearance by adding graphical elements (e.g. 
colored lines and rectangles) or images (e.g. logos) 

  

The quickest way to design a report is to insert all text lines, images, 
lines and rectangles, select all the objects to be edited in the same 
way (e.g. select all the text lines to give them a uniform appearance 
by assigning the same font and size) and make changes. 

Note: You can check the graphical appearance of printouts on 
screen. Click the right mouse button and select Preview on the 
shortcut menu. This preview shows all the data records of the data 
sheet, regardless of the insertion marker’s position in the data sheet 
and the selected data records. 
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Object Types of Reports 

Reports can include different types of objects, which are described in 
the table below. 

Object type Function 

Text object Text that is not included in data sheets is 
inserted as text objects in reports (see "Inserting 
Text Objects (on page 282)"). 

Field object Field objects are associated with the columns of 
the data sheet to which the report is assigned (cf. 
"Using Fields and Variables"). 

Drawing object Linear and rectangular objects can be used to 
enhance the graphical appearance of reports (cf. 
"Adding Graphical Elements"). 

OLE object Objects from other Windows applications can be 
integrated as files or links in reports (cf. 
"Inserting Images and Sketches (see "Insert 
Images and Sketches" on page 283)"). 

You can define conditions for every individual object or for entire 
groups of objects, which are taken into account when printing. 

 
 

Define the Page Layout for Reports 

You can define the page setup of reports. In other words, you can 
specify how sections and objects are arranged in printouts. 

  

To define the page layout 

 The layout window of the report designer is open. 

1 Click Page setup on the File menu. 

The Report Properties dialog box appears. 

2 Select the Page Layout tab and make the necessary settings. 

Note: You can change the unit of measurement in the Ruler & 
Grid tab (e.g. from "cm" to "pixels"). 

3 Click OK. 
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Add or Remove a Report Title and Report Summary 

Report titles and summaries are independent sections that are 
defined separately. The objects in these two sections always print out 
just once: The report title appears at the beginning of a printout and 
the report summary at its end. 

This way, you can add a cover sheet and/or final note to a file. It is 
even possible to display the title and summary on separate pages. 

  

To add a report title or summary 

 The layout window of the report designer is open. 

1 Click Optional Bands on the Report menu. 

The Report Properties dialog box appears. 

2 Select the Optional Bands tab and activate the Report has title 
band option and/or the Report has summary band option. 

3 Choose the other options, as required. 

4 Click OK. 

  

To remove a report title or summary 

 The layout window of the report designer is open. 

1 Click Optional Bands on the Report menu. 

The Report Properties dialog box appears. 

2 Select the Optional Bands tab and deactivate the Report has title 
band option and/or the Report has summary band option. 

3 Click OK. 
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Specify the Height of Sections in Reports 

You can enter any height for the individual sections. However, check 
that the final printout (= all sections) does not exceed the printable 
area of the paper. 

You can specify a minimum height or set a fixed value for the 
height. When you enter a minimum height for a section, please make 
sure that all objects actually fit in the relevant section. 

  

To specify the height for a section 

 The layout window of the report designer is open. 

• Drag the bar that delimits the section to the required height. 

Or: 

1 Double-click the bar delimiting the relevant section. 

The ... Band Properties dialog box appears. 

2 Select the General tab and enter the height. 

Note: You can change the unit of measurement in the Ruler & 
Grid tab (e.g. from "cm" to "pixels"). 

3 Activate the Constant band height option if you do not want the 
section to be resized automatically (e.g. when adding data or 
deleting empty lines). This is necessary e.g. when printing reports 
on labels. 

4 Define an expression for the section, if required, by clicking  
next to On entry or On exit under Run expression. 

Detailed information is provided in the section entitled "Define 
Expressions". 

5 Click OK. 
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Selecting Objects in Reports 

Use the  Marker on the Report Controls toolbar (see "Buttons in 
the "Report Controls" Toolbar" on page 273) to select objects (see 
"Object Types of Reports"). 

The selected objects (any combination possible) can be addressed as 
a single entity for easy manipulation. You can use the Cut, Copy, Paste 
and Delete tools as you would in any other Windows application. 

Selected objects can be grouped, moved and superimposed. In addition, 
you can change the size of objects (not available with text objects). 
Rulers and grids assist you in the process of positioning objects. 

  

 

Grouping Objects 

You can combine several objects (see "Object Types of Reports") in a 
group that can be selected, cut, copied, deleted, pasted and moved as 
a single entity. For example, text and lines of a header can be 
combined in a group and placed as a whole. 

Object groups facilitate the process of positioning objects. As 
opposed to data groups (consisting of fields and variables), however, 
object groups have no effects on printouts.  

  

 

Positioning and Resizing Objects 

Rulers and grids provide additional support as you position objects 
(see "Object Types of Reports") or change their size. The spacing 
between the lines of the ruler and a unit of measurement can be set 
in the Ruler & Grid tab of the Report Properties dialog box. 

You can activate or deactivate the grid using the Snap to Grid tool 
on the Format menu. 

You can define the size of field objects, drawing objects and OLE 
objects as you need. The size of text objects, on the other hand, is 
determined automatically and depends on the text length, font and 
font size. 
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Inserting Text Objects 

Use the  text tool in the Report Controls toolbar (see "Buttons in 
the "Report Controls" Toolbar" on page 273) to create fixed text and 
labels. You can set the  Text tool to active with  Repeat control 
element to create a number of text objects in succession. 

New text objects are always inserted using the formatting (font and 
font size) you have defined in the layout settings as the default font 
for the report (see "Defining the Page Layout for Reports (see "Define 
the Page Layout for Reports" on page 278)"); you can change these 
defaults at any time. 

You can of course also modify the formatting of existing text objects 
any time you like. In addition, you can apply the same font to all the 
objects in a report in a single step; this also includes all text objects 
in the report (see "Designing Typography and Typesetting (on page 
282)"). 

  

 
 

Designing Typography and Typesetting 

The report designer provides many features with which you can 
freely design the typography and typesetting of text objects and 
fields containing text and numbers, as far as supported by your 
operating system. 

Each object you newly add to a report is automatically formatted 
according to the font and font size you have defined as the default 
font in the layout settings for the report (see "Defining the Page 
Layout for Reports (see "Define the Page Layout for Reports" on page 
278)"). You can modify this formatting any time later using one of 
the methods described below. 

You can also freely place objects and choose if you want a fixed 
offset to the top or bottom of the section (see "Positioning and 
Resizing Objects"). The "Fix relative to top of band" setting is the 
default. 
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Adding Graphical Elements 

You can enhance printouts by adding lines and color areas. The 
report designer provides a number of options. In particular, you can 

• Insert vertical and horizontal lines 

• Add rectangles, rectangles with rounded corners, circles and 
ellipses as frames or color areas 

• Apply color areas or hatching styles to objects (e.g. text) 

Note: On black/white printers, these areas will appear as gray tones. 

  

 
 

Insert Images and Sketches 

You can either insert images and sketches directly in your report 
(e.g. add your company logo to the page header) or load them into 
the printout from fields in the relevant data sheet columns (e.g. 
implementation sketches for items). 

  

 
 

Using Fields and Variables 
"Fields" are used to integrate the data in the columns of the data 
sheets in printouts. When printing, Allplan BCM processes all the 
data records one after the other. The data in the fields is checked and 
the results are listed in the printout. 

Fields can even be calculated or include variables. "Variables" are 
used to save values or calculation results. Besides predefined 
variables, you can define further variables for each report. Functions 
are used to link fields and variables. 

You can also group this data. This way, you can print out each 
group (title with items) on a new page, for example. 
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Field types and variable types 

Field/variable types describe the type of data to be output. The type 
is given in the list boxes in the Output window. 

ID of type Data type 

C Alpha-numeric (field length limited to 254 
characters) 

D Date 

F Floating point number 

G Object 

L Logical 

M Alpha-numeric (memo fields of unlimited length) 

N Numeric 

 

Fields in data sheets 

A field is available for each column in the data sheets. In addition, 
there are some fields that are used to classify data more precisely. 
You will find a list of the most important fields and their properties 
in the online help under "Fields in Data Sheets". Please note that 
fields Allplan BCM uses only internally are not listed here. 

 

Defining variables 

Variables are used to save values or calculation results. Variables can 
be defined as fields in reports or as parts of expressions. They are 
available in the Variables list box in the Expression Builder dialog 
box. However, they can only be used for the report for which they 
have been defined. The reports that come with Allplan BCM also 
include variables, the page number, for example.  

Variables can also be integrated in calculations. The program starts 
with the initial value and the result is saved in the variable. 
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Predefined Allplan BCM variables 

You can use the variables listed below in expressions for executing 
reports and in initialization/finalization procedures. 

Name of 
variable 

Data type Use 

_ZV_SEITE Numeric Page number at which to start printing. 

This variable contains the value of the First page 
data entry box of the Report manager dialog 
box. 

_ZV_LOGO Numeric 1 = the Print logo option is enabled. 

0 = the Print logo option is disabled. 

_ZLGO.BR_LOGO Object Image object of logo. 

_ZV_FUSS1 

_ZV_FUSS2 

Character Variables for the text that appears in the footer. 
You can enter this text when you click the More 
options button in the report manager. 

_ZV_DATE Date Date specified in printouts. 

This variable contains the value of the Date data 
entry box of the Report manager dialog box. 

   

The most important functions 

Functions are used to link fields and variables. The table below only 
lists the functions that are used in reports. 

Note: More functions available in Allplan Construction Cost are 
described under "The most important functions" in the online help 
for Allplan Construction Cost. 

Function Meaning 

evaluate(var) Ensures that a report can be used for all data 
sheets. The value in the open data sheet is 
always used. 

Character functions  

"Text" Compares character by character. 

ALLTRIM(expC) Removes blanks from character strings. 
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Function Meaning 

Logical functions  

= Boolean operator: "equal" 

NOT or ! Logical negation (the expression is true if the 
following value is not true). 

AND Boolean operator: "and" (the expression is true if 
both values are true). 

OR Boolean operator: "or" (the expression is true if 
one of the two values is true). 

EMPTY(exp) Checks whether fields or variables are empty. 

IIF(,,) Function with syntax: "if condition, then....; else 
.....". If the condition is true, this function yields 
the "then" value. If the condition is not true, this 
function yields the "else" value. 

Date functions  

DATE() Returns the current system date. 

  

Inserting fields 

You can use the  Field tool to insert a single field in a report 
where you require. 

As an alternative, you can click the Quick Report tool to open the 
Quick Report dialog box. Here you can use tables to select several 
(or all) fields that exist for a data sheet. The selected fields are 
automatically placed in the detail section. 

Note: The Quick Report tool is only available when the default detail 
section in the report is empty and no further detail sections have 
been added. 

 

Defining expressions 

An expression consists of data sheet fields and/or variables that can 
be linked using various functions. The expression defined is applied 
to each data record you have selected. 
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You can specify expressions to 

• Define fields 

• Define conditions which are taken into account when objects are 
printed 

• Group data 

• Define variables (assigning initial values and values to store) 

Expressions are usually defined using the Expression Builder dialog 
box, which contains four list boxes you can use to select functions 
from various groups. The Expression for Field on Report field 
displays the selected functions, fields and variables. The 
expression could also be entered directly in this field; however, 
this should only be done by database experts. 

The Variables list box shows all the variables (including name and 
type) that have been defined for the current data sheet. For more 
information, see the "Defining variables" section above. 

Formatting fields 

The format defines how a value is displayed in printouts. Formatting 
typical of field data specifies that uppercase letters are used for all 
alphabetical characters, for example.  

Grouping data 

Grouping data means that data records are grouped based on a 
common feature. For example, you can print out each group on a 
new page and assign headers and footers to each group. Groups are 
changed when the value of the grouping condition changes. Groups 
can also be nested. 

Inserting images from fields 

Sketches you have added to projects (Image column) can be 
integrated in reports using a table field. 
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Defining Conditions for Printing Objects 
You can define conditions which are taken into account when 
objects are printed out. Conditions can be specified for each object. 
For example, you can define that short text is only printed for item 
lines.  

  

 
 

Specific Controls for Reports 
Reports can be controlled using a specific template. 

The initialization procedure for reports consists of two parts: 

• Part 1: Mask control 

• Part 2: Report control 

Note: When using print jobs, a few special notes need to be 
observed. 

  

 
 

Specific Mask Control 

The mask control is used to create dialog elements in the bottom half 
of the Output tab in the Print dialog box (Allplan Building Costs) or 
in the bottom right half of the Report manager dialog box (Allplan 
Construction Cost). The mask control is defined in the Initialization 
procedure dialog box (Allplan Building Costs) or Initialization/fina-
lization procedure dialog box (Allplan Construction Cost) and 
indicated in the following way: 

#MASK 
..... 
..... 
..... 
#ENDMASK 
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You can define up to six mask elements in this section. If more than 
six elements are specified, they are ignored. The elements created are 
immediately displayed in the Output tab of the Print dialog box 
(Allplan Building Costs) or in the Report manager dialog box 
(Allplan Construction Cost). 

The most important functions for creating and controlling mask 
elements are described in the online help under "The most important 
functions". 

 
 

Specific Report Control 

The report control corresponds to the print feed feature known from 
versions earlier than V6.0. The report control is indicated in the print 
feed in the following way: 

#PROG 
..... 
..... 
..... 
#ENDPROG 

You can use the report control to make the proper configuration 
settings, check filter conditions etc. In addition, you can determine 
the specific settings made in the mask control, which can also be 
determined directly in the report, however. Reports created in 
previous versions of course can also be used without the specially 
indicated sections. 

The most important functions for controlling reports are described in 
the online help under "The most important functions". 

Important! 
The elements created are only effective for as long as the report is 
selected within the Print dialog box (Allplan Building Costs) or 
Report manager dialog box (Allplan Construction Cost). When you 
switch to another report, the specific elements change accordingly. 
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Special Notes on Print Jobs 

In print jobs, feeds can be defined in two different ways: 

• Using the feeds of the individual reports 

• Using the feed of the print job 

  

Using the feeds of the individual reports 

The sections from #PROG to #ENDPROG in the individual reports are 
executed. 

If you want to use mask options, a #MASK  ....  #ENDMASK section 
must be added to the print job. In this section, you define the options 
for all subsequent reports. When creating a new print job, this 
section is created automatically based on all mask control sections of 
the individual print jobs. In most cases, however, you will need to 
edit this mask section manually. 

Example: 

The print job includes the following section: 

#MASK 
_PRMSK_CHECK("chk1","Print prices",0) 
_PRMSK_CHECK("chk2","Printout based on StLB",1) 
#ENDMASK 

For all reports controlled by the print job, this means that the 
variable – in this example, the one controlling the printout of prices 
– must be named "chk1" in every report. This requirement must 
always be met; otherwise, contradictions might occur. To inform the 
user, the element created is displayed as inactive in the mask. 

Example: 

Report 1 includes a variable "chk1", which controls the printout of 
prices. Report 2 also contains a variable named "chk1". This variable, 
however, controls color printouts. If the relevant element created in 
the mask control of the print job is assigned the name "chk1", this 
element controls both the printout of prices and color printout. 
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Using the feed of the print job 

The print feed is defined in the same way as for an individual report. 
Controls specified in the individual reports are suppressed. 

 

 
 

Backing up and Restoring Reports 
The quick reports provided by Allplan BCM are usually installed 
along with the program files when you install Allplan BCM. You can 
re-import them anytime without having to run setup again. 

Reports you have newly created or modified can be backed up 
separately and restored when needed. 
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